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Chapter 1. Release notes for HCL OneTest™ Server

This document includes information about What's new, installation and upgrade instructions, known issues, and

contact information of HCL Customer Support.

Contents

» Product description on page 9

« What's new on page 9
 Deprecated capabilities on page 11
* Removed capabilities on page 11

« Installing and upgrading on page 11
* Known issues on page 12

¢ Contacting HCL support on page 12

Product description

You can find the description of HCL OneTest™ Server.

HCL OneTest™ Server is a server that includes capabilities such as project and role-based security, Docker-based
distribution and installation, and running of test cases. For more information about the server, see HCL OneTest

Server overview on page 19.

What's new

You can find information about the features introduced in this release of HCL OneTest™ Server.

The following sections list the new features, enhancements or other changes made in this release.

« Support to install HCL OneTest™ Server on OpenShift is removed

OpenShift is no longer supported as a platform on which you can install HCL OneTest™ Server 10.2.2.
« Authoring tests on HCL OneTest™ Server

You can now use the test authoring capability of HCL OneTest Server that utilizes a containerized version of

the OneTest Studio desktop authoring products to author tests and virtual services.

You can also modify test assets or virtual service resources that you create by using the containerized
products or the test assets or resources in the project repositories that you created in the desktop products
and committed to the repositories.

See Test authoring on page 121.

« Support to add multiple repositories simultaneously
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Previously, you were able to add individual Git repositories one at a time to your project on HCL OneTest™

Server.
Now, you can add multiple repositories simultaneously that are contained in the same repository domain.

See Adding repositories to a server project on page 661.

Support to configure and run individual test assets

Previously,you were able to configure and run Suites, Compound Tests, or Schedules on HCL OneTest™ Server.
Now, you can configure and run individual test assets such as an API test, a Functional test, or Performance
test.

See Test run configurations on page 308.

Support to run instances of virtual service resources on a remote Kubernetes cluster

You can now configure and run instances of virtual service resources on a remote Kubernetes cluster. You can
select the remote Kubernetes cluster as the location to run the virtual service resources after you set up and

add the remote cluster to your project.

See Configuring a run of a virtual service on page 451.

Support to run test assets on remote agents or from a remote Kubernetes cluster

You can now select remote agents or a remote Kubernetes cluster as a location to run the test assets. You
can select the remote agent as the location to run the test asset after you set up and add the remote agent or
the Kubernetes cluster to your project.

Enhanced Jenkins plugins to run tests from a Jenkins pipeline project

The HCL OneTest™ Server Jenkins plugins are enhanced so that you can now run tests as a job in a Jenkins

Pipeline project.

.

Configuring additional Jira fields

Jira server administrator can now configure additional fields as Required fields in the project on the Jira server
to be displayed in the Raise defect in Jira window while creating a defect from HCL OneTest™ Server.

See Creating Jira defects on page 557.

Collecting and viewing resource monitoring usage data
You can create queries to retrieve monitoring usage data that is collected for a time period during a test run.

See Collecting and viewing resource monitoring usage data on page 547, Configuring a test on page 548,
Viewing resource monitoring usage data on page 549, and Creating queries for resource monitoring usage

data on page 551.

- Viewing test logs
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When a test run is complete, a test log report is generated for the tests which are configured to collect test
logs data. The test log contains details about the events in the tests and their properties. See Test log viewer

on page 502.

* Querying test log data
You can create queries to view test log data for all the test results in a project or for one particular result.
See Test log queries on page 504 and Configuring and running log queries on page 506.

- Viewing results data in Grafana

By using HCL OneTest™ Server and Grafana, you can retrieve and explore test log data that is generated in

OneTest Server.

See Test results data in Grafana on page 497, Installing and configuring HCL OneTest Server Results Data

on page 498, and Viewing test results data in Grafana on page 499.

« Viewing test results in Surefire format reports

After you execute JMeter, JUnit, API, and Functional tests with advanced settings in HCL OneTest™ Server, you

can view the test results in a Surefire format report by using dedicated URLs.

See Viewing Surefire format reports on page 500.

Deprecated capabilities

The following capabilities are deprecated. HCL will no longer invest in enhancing these capabilities and is planning
to remove them in a future release. If you have any concerns, contact either an HCL representative or your HCL Client

Support team for this program:
» No capabilities were deprecated in this release.

Removed capabilities

The following capabilities that were announced in previous releases as deprecated are removed in this release:

» No capabilities were removed in this release.

Installing and upgrading

You can find information about the installation and upgrade instructions for HCL OneTest™ Server.

Installing HCL OneTest™ Server

For instructions about installing the software, see Installation of the server software on page 36.
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Upgrading of HCL OneTest™ Server

For instructions about upgrading the software, see Server software upgrade methods on page 61.

Known issues

You can find information about the known issues identified in this release of HCL OneTest™ Server.

Table 1. Release documents - Fix list and known

issues

Product | Download document | Knowledge Base

HCL Release document | Knowledge articles
OneTest’

Server

The knowledge base is continually updated as problems are discovered and resolved. By searching the knowledge

base, you can quickly find workarounds or solutions to problems.

Contacting HCL support

You can find information about Contacting HCL support.

« For technical assistance, contact HCL Customer Support.

« Before you contact HCL support, you must gather the background information that you might need to describe
your problem. When you describe a problem to the HCL support specialist, be as specific as possible and
include all relevant background information so that the specialist can help you solve the problem efficiently.
To save time, know the answers to these questions:

o What software versions were you running when the problem occurred?
> Do you have logs, traces, or messages that are related to the problem?
> Can you reproduce the problem? If so, what steps do you take to reproduce it?

o |s there a workaround for the problem? If so, be prepared to describe the workaround.

12
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Chapter 2. System Requirements

This document includes information about hardware and software requirements for HCL OneTest™ Server.
Contents

« Hardware on page 14
 Operating systems on page 14
o Operating systems on page 15
» Host prerequisites on page 15
o Licensing on page 16
o Web browsers on page 16
» Supported software on page 16
o Development tools on page 17
o Integrations on page 17
o Runtime environment on page 17

« Disclaimers on page 13

Disclaimers
This report is subject to the Terms of Use and the following disclaimers:

The information contained in this report is provided for informational purposes only. While efforts were made to
verify the completeness and accuracy of the information contained in this publication, it is provided AS IS without
warranty of any kind, express or implied, including but not limited to the implied warranties of merchantability, non-
infringement, and fitness for a particular purpose. In addition, this information is based on HCLs current product
plans and strategy, which are subject to change by HCL without notice. HCL shall not be responsible for any direct,
indirect, incidental, consequential, special or other damages arising out of the use of, or otherwise related to, this
report or any other materials. Nothing contained in this publication is intended to, nor shall have the effect of, creating
any warranties or representations from HCL or its suppliers or licensors, or altering the terms and conditions of the

applicable license agreement governing the use of HCL software.

References in this report to HCL products, programs, or services do not imply that they will be available in all
countries in which HCL operates. Product release dates and/or capabilities referenced in this presentation may
change at any time at HCL's sole discretion based on market opportunities or other factors, and are not intended to
be a commitment to future product or feature availability in any way. Discrepancies found between reports and other
HCL documentation sources may or may not be attributed to different publish and refresh cycles for this tool and
other sources. Nothing contained in this report is intended to, nor shall have the effect of, stating or implying that any
activities undertaken by you will result in any specific sales, revenue growth, savings or other results. You assume
sole responsibility for any results you obtain or decisions you make as a result of this report.

Notwithstanding the Terms of Use users of this site are permitted to copy and save the reports generated from this
tool for such users own internal business purpose. No other use shall be permitted.

13
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Hardware

You can find information about the hardware requirements for HCL OneTest™ Server.

Hardware Requirement Notes

Disk space 256 GB Additional resources are required by the cluster for the execution of
test assets.
Disk space requirements can grow in line with quantity of test assets
and results stored.

Memory 32GB Additional resources are required by the cluster for the execution of
test assets.
An additional 1 GB of memory is required by the cluster for each test
authoring or editing session.

Processor 8 CPUs Additional resources are required by the cluster for the execution of
test assets.
Additional 3 CPUs are required by the cluster for each test authoring
or editing session.

Network Gigabit (1000) Ether-

net

Other hardware Operating system support is specified by the supported platform
for Kubernetes. Refer to their associated documentation for a list of
supported operating systems.

Related information

System Requirements on page 13

Operating systems

You can find details about the supported operating systems.

Contents

» Operating systems on page 15
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Bit version support
Different parts of a product might run on the same operating system but support different application bitness.

For example, one part of the product might run only in 32-bit mode, whereas another might support 64-bit tolerate

mode.
Bitness Description
64-Tolerate The product or part of the product runs as a 32-bit application in the 64-bit platforms listed
as supported.
64-Exploit The product or part of the product runs as a 64-bit application in the 64-bit platforms listed
as supported.

Operating systems

Operating system HCL OneTest™
P gsy Hardware Bitness Notes
Server

Running K3s v1.22.3
Ubuntu Server 18.04 |x86-64 64-Exploit v
LTS
Ubuntu Server 20.04 |x86-64 64-Exploit v Running K3s v1.22.3
LTS

Related information

System Requirements on page 13

Host prerequisites

You can find the prerequisites that support the operating capabilities for HCL OneTest™ Server.
Contents

« Licensing on page 16

« Web browsers on page 16
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Licensing

License Server Version HCL OneTest™ Server
FlexNet Operations LLS 2017.02 v

2021.05 v

Web browsers

Browser Version HCL OneTest™ Server
Apple Safari 13 or later v
Google Chrome 78 or later v 4
Microsoft Edge 80 or later v
Microsoft Edge Chromium 86 or later v
Mozilla Firefox (including ESR ver- 68 or later 4

sions)

Related information

System Requirements on page 13

Supported software

You can find details about the additional software that are supported.

Contents

» Development tools on page 17

* Integrations on page 17

* Runtime environment on page 17
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Supported software Version HCL OneTest™ Server
Git 2.19.0 v
2.21.0 v
2.22.0 v
Integrations
Supported software Version HCL OneTest™ Server
Azure (AKS) Kubernetes 1.22.4 v
Azure Plugins Cloud version, latest v
HCL® Launch 7.1 " 4
IBM® Engineering Test Management
7.0.2 v
Jenkins
2.x v
Jira 8.x o

Runtime environment

Supported software Version HCL OneTest™ Server Notes

Helm CLI 3.6.2 v Required locally for Helm.
3.6.3
3.7.1

17
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Supported software

Version

HCL OneTest™ Server

Notes

Jaeger Operator

v

Required if tests contribute
trace information. The ver-
sion depends on the target
platform.

Related information

System Requirements on page 13
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This guide provides an overview of HCL OneTest™ Server. You can find the task flows to get you started with HCL

OneTest™ Server. This guide is intended for new users.

Before you can perform the various tasks described in the Getting Started Guide and the other guides, you must install

HCL OneTest™ Server. See Installation of the server software on page 36.

HCL OneTest™ Server overview

HCL OneTest™ Server brings together test data, test environments, and test runs and reports into a single, web-based

browser for testers and non-testers.
HCL OneTest™ Server provides the following capabilities:

Web-based continuous testing platform

HCL OneTest™ Server is a web-based continuous testing platform built on modern, cloud native
technologies that enables test teams to run a breadth of tests that includes API, functional, and
performance tests and to benefit from a holistic view of test progress. HCL OneTest™ Server is built on
Docker for easy deployment. You can scale your testing on the cloud or remote on premise systems

with native Docker, Kubernetes, and IBM Red Hat OpenShift support.
Role-based access and security

Security is a key concern for HCL clients and therefore, HCL OneTest™ Server brings a comprehensive,
role-based access control scheme to the server with project owners assigning specific member's
key permissions (by using roles), for example managing test data or working with secrets such as

passwords.
Running of tests from the server by using Docker containers

Server-based running of tests is the starting point for HCL OneTest™ Server. For members of a project
with the appropriate role, HCL OneTest™ Server enables direct running of tests from the browser by

using transient Docker containers.
Connected agents for existing performance agents

Agent owners can connect existing performance agents to the server and add them to a project for
running schedules and Accelerated Functional Testing (AFT) Suites on the current infrastructure.

Project overview statistics

The Overview page for HCL OneTest™ Server offers you a quick, simple view on the state of testing for

your projects.
Project home page

The home page lists your projects and other projects, which makes it easy to manage different projects

within an organization.

19



20

HCL OneTest™ Server

Reporting and the Resource Monitoring Service

HCL OneTest™ Server provides the home for capabilities that previously were hosted on HCL® Quality

Server. Reporting and the Resource Monitoring Service are in HCL OneTest™ Server and provide a more

direct relationship with their related projects. These capabilities also benefit from the project level, role-

based access controls. You can view unified test results to help you make informed business decisions.

Test data authoring

Beyond the concept of a project held in a Git repository for a simple location of tests and related

assets, you can do full concurrent editing of test data sets directly from HCL OneTest™ Server. This true

multiuser capability enables team members to collaborate more easily as well as try out data changes

without impacting the rest of the team. When satisfied with the results, team members can push their

changes. You can also fabricate sample data to perform tests by using the data generator supported in

HCL OneTest™ Server.

Integration with DevOps tools

You can integrate HCL OneTest™ Server with various popular DevOps tools like Jenkins, UrbanCode™

Deploy, or HCL® Launch and Microsoft Azure DevOps to get more value from your DevOps pipelines.

You can use UrbanCode™ Deploy, or HCL® Launch to define a deployment process that automatically

triggers test cases and have those test insights available directly within UrbanCode Velocity. With

the Microsoft Azure DevOps integration, you can also define a DevOps pipeline that includes direct

execution of tests by using the HCL OneTest™ Server scalable infrastructure. HCL OneTest™ Server

also integrates with Jira for defect tracking and GitHub for software source management and version

control.

Supported versions of assets and resources

You can find information about the versions of assets, resources, agents and Dockers that are supported in HCL

OneTest™ Server. You can also find information about the versions of the desktop clients that are supported.

The following table lists the versions of assets or resources created in the desktop clients along with the agents,

Dockers, or proxies that are supported in HCL OneTest™ Server:

Resource

Supported

Not supported

Assets or resources created in HCL
OneTest™ Ul

Assets or resources created in HCL
OneTest™ Ul which are of versions
earlier or the same as HCL OneTest™
Server.

Assets or resources created in any
later version of HCL OneTest™ Ul
that is later than the version of HCL
OneTest™ Server.

Assets or resources created in HCL
OneTest™ API

Assets or resources created in HCL
OneTest™ API which are of versions
earlier or the same as HCL OneTest™

Server

Assets or resources created in any
later version of HCL OneTest™ API
that is later than the version of HCL
OneTest™ Server.
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Resource

Supported

Not supported

Assets or resources created in HCL
OneTest™ Performance

Assets or resources created in HCL
OneTest™ Performance which are of
versions earlier or the same as HCL

OneTest™ Server

Assets or resources created in any
later version of HCL OneTest™ Per-
formance that is later than the ver-
sion of HCL OneTest™ Server.

HCL OneTest™ Performance Agents

HCL OneTest™ PerformanceAgents
which is the same version as HCL

OneTest™ Server

Before you install the agents that are
of the current version, see Manage-

ment of agents on page 268.

Dockers on a remote host computer

Image of HCL OneTest™ Server
which is the same version as HCL
OneTest™ Server that you want to use
to run tests, must be installed on the

Docker on a remote host computer.

Before you set up Dockers remotely,
see Management of Docker hosts on

page 277.

HTTP proxies

Installation of the proxy component
from HCL® Quality Server which is
the same version as HCL OneTest™

Server.

Before you use HTTP proxies,
see Setting up the HTTP proxy on
page 445.

If there is a mismatch in the versions of the assets, resources, agents, or images used in Dockers with the version of

HCL OneTest™ Server that you are using, any of the following events can occur:

» Warnings or Errors are displayed when you add a repository to a project in your team space.

- Warnings or Errors are displayed when you open a project that you migrated from a previous version of HCL

OneTest™ Server.

» Warnings or Errors are displayed when you add or manually refresh a repository to which you added assets

or resources that were created on a desktop client with a version previous to or later than the version of HCL

OneTest™ Server that you want to use.

« Test runs that you start or schedule on an agent or Docker fail to run.

« You cannot view the proxies that are registered with HCL OneTest™ Server on the Agents and Intercepts page.

Suites and tests that are supported on HCL OneTest™ Server

You can find information about the types of Test Suites and tests that you can configure for a run in a project on HCL

OneTest™ Server.

The following table lists the Test Suites and test types that are supported and those tests that are not supported to

run on HCL OneTest™ Server:
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Supported Suites

Supported tests

Unsupported tests

« Accelerated Functional Testing (AFT)
Suites
« Compound Tests that contain any of the
following types of tests:
> Web Ul tests
o HTML tests
> Mobile tests

« Functional Web Ul tests

« Functional Windows
tests

« Functional Mobile tests

« Traditional HTML tests
« Traditional non-HTML
tests

- API Suites that include the following Test
Suites:

o Test Suites that contain sce-
narios with references to local
stubs.

o Test Suites that contain stubs
that virtualize services run in any
Kubernetes cluster or in the Ku-
bernetes cluster that hosts HCL
OneTest™ Server.

« Stubs

APl tests

Suites or tests with subscribe
actions that operate in the

watch mode.

« Compound Tests that contain perfor-
mance tests

 Rate Schedules

* VU Schedules

Performance tests

» A single test script of
any test extension.

* Tests that belong to 32-
bit test extensions and
SOA Quality included
in VU Schedule, Rate
Schedule, and Com-
pound Test.

« Citrix, SAP, or Siebel as
an individual test or as
part of a Compound
Test.

Postman resources

JMeter tests

22
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Note: You must create compound tests for the same type of tests. For example, you can create a compound

test that has different mobile tests that use different mobile testing platforms.

® Restriction: You cannot merge folders that contain different test projects in the same project directory. For
example, you cannot create a project directory that contains a Performance test project and an API Suite
project. You must create separate project directories for each test type. For example, you must create the
Performance test in the project directory as/ MyPer f Pr oj ect/ and the API Suite in the project directory as
! MyAPI Pr oj ect, before you commit the projects to the remote repository.

Related information

Tests configurations and test runs

HCL OneTest Data overview

HCL® OneTest™ Data is an automated and customizable tool to generate the test data. HCL® OneTest™ Data is one
of the components of HCL OneTest™ Server and can be accessed as Data Fabrication in the HCL OneTest™ Server
GUL.

You can generate the test data in various file formats such as Excel files, Native file, Comma-Separated Values (CSV),
JavaScript Object Notation (JSON), and Extensible Markup Language (XML).

The test data is the core component of any application testing. Creating test data manually is very time-consuming.
With HCL® OneTest™ Data generator, you can generate huge volumes of intelligent data to perform application
testing without the risk of data leaks or privacy issues. The generated test data can drive the testing of any

application by using HCL OneTest suite.

HCL® OneTest™ Data provides the following capabilities:

 Generates real-time data automatically.
« Provides powerful built-in API to match the data with the generated datatype.
« Supports flexibility to model the data.

« Supports both single and multi-tenancy.
HCL® OneTest™ Data provides the following benefits:

« Protects data privacy.
- Improves the efficiency and accuracy of predefined data and real-time data generation.

- Avoids extraction of real and potentially sensitive information from production system.

You can find more information about the tasks that you must perform to generate the test data by using HCL®
OneTest™ Data.
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Data design environment overview

The data design environment is a graphical interface to design all its components and data generation rules to
generate test data on user demand. To design the components for data generation, you must log in to HCL OneTest™
Server, and then create a project.

You use various components to structure data in HCL® OneTest™ Data. The components of data design environment

are:

« Files
« Connections

» Schemas

The definitions of data stored in the schemas are used to define a map. The map specifies the transformation logic
in the form of rules. The map identifies the data definition of a schema, validates the type properties of data by using

rules, and compiles the rules to generate the real-time test data.

You can refer to workspace management to manage workspace in HCL® OneTest™ Data.

Related information

Test assets and a server project on page 657

Task flows: HCL OneTest Data

You can use the task flow diagram to get started with HCL® OneTest™ Data. After you select your project in HCL
OneTest™ Server and navigate to the Data Fabrication page, you can complete the tasks in sequence to generate the

test data. You can click the links to get more information about the tasks.

Generating the test data by using HCL OneTest Data

You can use the task flow diagram to help you to generate the test data.
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Click a box for more information.
Shift-click to open a new browser.

Generation of test data

.

.

Import JSON or XSD
from the local file system
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v
Modify a schema /////'

Test data generation
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. Generation of test data on page 23

. Import JSON or XSD from the local file system on page 148
. Generate a schema by using Connections on page 150
. Import data from the local file system on page 152

. Create a schema on page 151

. Modify a schema on page 156

. Design a schema on page 156

. Define types on page 157

. Set type properties on page 158

. Use sample files on page 165

. Add regular expressions on page 163
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Generating schema by using Connections

You can use the task flow diagram to generate a schema by using Connections in the Data Fabrication page.
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Click a box for more information.
Shift-click fo open a new browser.
Generating schema by using Connections

Create a sample schema

Establish a connection between HCL OneTest Data
and external resource

Generate a schema in HCL OneTest Data

Generate the test data

[ ] Test Manager or Tester
L

1. Create a sample schema on page 178
2. Establish a connection between HCL OneTest Data and external resource on page 150
3. Generate a schema in HCL OneTest Data on page 181

4. Generate the test data on page 183
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Integrating HCL OneTest Data with other applications

You can use the task flow to integrate HCL® OneTest™ Data with other applications such as Jenkins and UrbanCode™
Deploy.
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Click a box for more information.
Shift-click to open a new browser.

Integration with other applications

v

l

Generate the test data by using Jenkins

l l

Generate the test d

—

Generate the test data in files Generate the test data in database Generate the test data in files
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. Integration with other applications on page 620

. Generating the test data by using Jenkins on page 621

. Generating the test data by using UrbanCode Deploy on page 627
. Generating the test data by using Jenkins on page 621

. Generating the test data by using Jenkins on page 621

. Generating the test data by using UrbanCode Deploy on page 627
. Generating the test data by using UrbanCode Deploy on page 627
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Project management

You can create a project to manage the data design environment that is used to generate the test data. If the data
design environment that you created is no longer required, then you can archive or delete the project. If you do want to

use an archived project, you can unarchive it.

While you manage your project, the following components of HCL® OneTest™ Data are impacted:

* Projects

» Schemas

» Jobs

« Data files

« APl history

» Map files

* Files

» Connections
« Actions

If you want to modify the name of your HCL® OneTest™ Data project, then you can rename the project in HCL

OneTest™ Server.

Note: When you delete any archived project, then that project is deleted based on the configured job settings.

Related information

Configuring job settings on page 226

Workspace management

You can view and manage all the data design components such as files, connections, or schema of your project on
the Workspace page.

Quick Links is a list of links that enables you to access the frequently used features of HCL® OneTest™ Data. You can
export or import the project by using the list of links in Quick Links. You can also export or import a selective list of

components.

Importing a project or components

When you have a project or any component of a project into your local file system and you want to reuse it for another

project, you can import those artifacts from the local file system.

Before you begin

- You must have a project or any component of a project in your local file system.

« The project or component that you want to import must be in a zip format.
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1. From the list of links in Quick Links, click Import into workspace.
Result
The Import dialog box appears.

2. Select a file you want to import into your workspace and click Import.

Results
The selected file is imported successfully into the workspace.

Note: If the project file you selected to import already exists in the workspace, the import process fails.

Exporting a project or components

When you want to reuse your existing project for another project, you can export either the selected components or an

entire project to your local file system.

Before you begin

You must have a project.

1. To export the entire project, click Export current workspace from the list of links in Quick Links.
Result
The project with all its artifacts is exported to your local file system.
2. To export the selective components from a project, click Selective export of current workspace.
Result
The Selective Export dialog box appears.
3. Select schemas, files, or connections from the drop-down list. You can select multiple components to export.
4. Click OK to export.

Results

The selected file is exported successfully from the workspace.

Task flow: Test runs and results in HCL OneTest™ Server

You can use the task flow diagram to get started with HCL OneTest™ Server. After you install the software, you can

complete the tasks in sequence to run test assets in HCL OneTest™ Server and view and analyze the test results.

You can click the links to get more information about the tasks. The diagram also provides the tasks to be performed

by personas. HCL OneTest™ Server supports user roles.
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Task flow: HCL OneTest™ Server access from desktop clients

You can use the task flow diagram to help you access the server from the different desktop clients to retrieve secrets,
publish reports, or enable resource monitoring agents. You can perform these tasks after you install and set up the

server.
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Related information

Managing access to server projects on page 667

Accessibility features

Accessibility features help users who have physical disabilities, such as visual and, hearing impairment, or limited

mobility, to use the software products successfully.

Accessibility compliance

The product documentation is published by using Oxygen XML WebHelp Responsive. To understand the accessibility
compliance status for Oxygen XML WebHelp Responsive, refer to WebHelp Responsive VPAT Accessibility

Conformance Report.

Accessing Ul elements

HCL OneTest™ Server supports navigation in the Ul by using different methods such as a mouse, keyboard, or

touchpad.

You can use the keyboard keys such as Tab, arrow keys such as UP, DOWN, LEFT, and RIGHT to navigate to the
different pages in the Navigation pane or to the different action labels in the right pane on the UL.
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This guide describes how to install the HCL OneTest™ Server software.

After you install the software, you can perform administration tasks such as license configuration, user management,
security, memory and disk usage management, back up and restore user data, and other tasks that a server

administrator can perform. This guide is intended for administrators.

As a Server Administrator, you can assign the role of a Server Administrator to any user. For information about how to

change the role, see Default user administration on page 79.

n Remember: When your role is changed from a user to a Server Administrator, you must log out and log in

again so that HCL OneTest™ Server can apply the change in your role.

Installation of the server software

To get started working with HCL OneTest™ Server, you must first install the server software.

You can install HCL OneTest™ Server on the following platforms:

« Ubuntu Server (by using k3s)

+ Azure Kubernetes Service (AKS)

Installation task flows
Ubuntu server

You must perform the following tasks to install HCL OneTest™ Server:

1. Set up an Ubuntu Server.
2. Install the OpenSSH server and the Helm software.
3. Set up the Kubernetes environment (k3s) by using the provided script.

4. Install HCL OneTest™ Server.

Azure Kubernetes Service

You must perform the following tasks to install HCL OneTest™ Server:

1. Create an Azure subscription and set up the AKS cluster.
2. Install the Helm software.

3. Install the kubectl and Azure command-line interface (CLI) software.
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4. Install NGINX Ingress Controller.

5. Install HCL OneTest™ Server.

To learn more about the installation of the server software on platforms such as Ubuntu and AKS, refer to the

following topics:

Installation of the server software on Ubuntu

You can find information about the tasks that you can perform to install HCL OneTest™ Server software on the Ubuntu

platform.
Prerequisites for installing the server software on Ubuntu
You must complete certain tasks before you install HCL OneTest™ Server on the Ubuntu platform.

The following sections describe each prerequisite in detail:

« Internet access on page 37

« Ubuntu Server on page 37

« Backup of user data on page 38

« Mandatory software on page 38

« k3s environment on page 38

« Service virtualization through Istio on page 38

« Collection of usage metrics on page 39

Internet access
You must have access to the internet to install HCL OneTest™ Server.

Ubuntu Server

You must install supported version of Ubuntu Server and have a working Domain Name Server (DNS) that resolves the

host name into a machine-readable IP address.

For more information about specific versions of software requirements, see System Requirements on page 13.

Note: Depending on your testing workload, HCL OneTest™ Server might require more resources. You must

use the entire disk space and set up Logical Volume Manager (LVM) by using the ext 4 file system. If your
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organization requires application data to be stored in a separate partition, then you can create a mount point

at/var/lib/rancher/ k3s/ storage/ with at least 128 GB capacity.

Backup of user data

If you want to upgrade the product from a previous version, then you must perform one of the following tasks based
on the existing version of the server software:

 Back up the data from V10.0.2, Fix Pack 1 or earlier. See Backing up the user data from a previous release.

« Back up the data from V10.1.0 or later. See Backing up the server data on Ubuntu on page 67.

Note: You must select the existing version of HCL OneTest™ Server from the drop-down list to view the
procedure for backing up and restoring the user data for your version because the instructions differ

for different versions.

Mandatory software

You must install the following mandatory software:

« Helm. For more information, refer to the Helm documentation. For more information about specific versions

of software requirements, see System Requirements on page 13.
Note: The Helm command must be in one of the directories in your PATH environment variable.
» OpenSSH Server. For more information, refer to the Installation section in the OpenSSH Server documentation.

Note: If you use ssh to log in to the computer, then you can skip this step because OpenSSH is already
installed on your computer.

k3s environment

You must set up the Kubernetes environment (k3s) along with other configurations such as firewall, Jaeger, and

Prometheus server. See Setting up a Kubernetes environment (k3s) on Ubuntu on page 39.

Service virtualization through Istio
Disclaimer: This release contains access to the Istio virtualized services feature in HCL OneTest™ Server as

a Tech Preview. The Tech Preview is intended for you to view the capabilities of virtualized services offered
by HCL OneTest™ Server, and to provide your feedback to the product team. You are permitted to use the
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information only for evaluation purposes and not for use in a production environment. HCL provides the

information without obligation of support and "as is" without warranty of any kind.

The default configuration does not enable service virtualization through Istio. To use the service virtualization
feature, you must configure it appropriately. You can virtualize the bookinfo sample application. You must install
this application in the Booki nf o namespace. For more information about the bookinfo application, refer to the Istio

documentation.

For more information about how to enable service virtualization through Istio, see Setting up a Kubernetes

environment (k3s) on Ubuntu on page 39.

Collection of usage metrics

If you want HCL OneTest™ Server to display the usage statistics of the virtual service instances, you must install the

Prometheus server at the time of server installation.

Setting up a Kubernetes environment (k3s) on Ubuntu

You must set up a Kubernetes environment (k3s) so that you can install the server software on an Ubuntu server. You

can use the script that is provided with HCL OneTest™ Server to set up a Kubernetes environment (k3s).
Before you begin

You must have completed the following tasks:

« Installed the following software:
o OpenSSH server
o Helm

« Ensured that your computer has a Domain Name Server (DNS) resolvable host name to resolve the host name
into a machine-readable IP address.

About this task

As part of the Kubernetes environment (k3s) set up, you can install the following software:

- Jaeger: By using this software, you can trace test logs and Jaeger-based reports when you run tests.

- Prometheus server: By using this software, you can monitor your system resources by using metrics data that

are collected by a Prometheus server.

1. Log in to the Ubuntu server using an SSH session.
2. Add the software registry to Helm by running the following command:

helm repo add hclsoftware https://hclcr.io/chartrepo/ot

3. Run the following command to get the latest updates from the repository:
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helm repo update
4. Run the following commands to fetch the scripts that are used to install Kubernetes:

helm pull --untar hclsoftware/hcl-onetest-base --version 7.1022.0
chmod +x hcl-onetest-base/*.sh

5. Perform one of the steps described in the following table to install the k3s Kubernetes environment based on

your requirement:

Step description

Step no

To install the Kubernetes environment (k3s)

Perform 5.a on

page 40

To install the Kubernetes environment (k3s) by overriding the default name

Perform 5.b on
page 40

To install the Kubernetes environment (k3s) and enable the service virtualization through

Istio, a Tech Preview feature

Perform 5.c on
page 41

To install the Kubernetes environment (k3s) by overriding the default name and enable

the service virtualization through Istio, a Tech Preview feature

Perform 5.d on

page 41

a. Run the following commands to install the Kubernetes with a default domain name that is either based

on IP address or fully qualified hostname:

Ubuntu version Commands to be run

18.04 $ cd hcl-onetest-base

$ sudo ./ubuntu-init.sh

20.04 $ cd hcl-onetest-base

$ sudo HOME=$HOME ./ubuntu-init.sh

b. Run the following commands to install the Kubernetes environment (k3s) by overriding the default

name:

Ubuntu version Commands to be run

18.04 $ cd hcl-onetest-base

$ sudo INGRESS_DOMAIN={onetest.}myorg.com ./ubuntu-init.sh
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Ubuntu version

Commands to be run

20.04

$ cd hcl-onetest-base

$ sudo INGRESS_DOMAIN={onetest.}myorg.com HOME=SHOME ./ubun-

tu-init.sh

¢. Run the following command to install the Kubernetes environment (k3s) and to enable the service

virtualization through Istio, a Tech Preview feature:

Ubuntu version

Commands to be run

18.04 $ cd hcl-onetest-base
$ sudo ./ubuntu-init.sh -demo
20.04 $ cd hcl-onetest-base

$ sudo HOME=$HOME ./ubuntu-init.sh -demo

d. Run the following command to install the Kubernetes environment (k3s) by overriding the default

name and to enable the service virtualization through Istio, a Tech Preview feature:

Ubuntu version

Commands to be run

18.04 $ cd hcl-onetest-base
$ sudo INGRESS_DOMAIN={onetest.}myorg.com ./ubuntu-init.sh --demo
20.04 $ cd hcl-onetest-base

$ sudo INGRESS_DOMAIN={onetest.}myorg.com HOME=SHOME ./ubun-

tu-init.sh -demo

where:

- {onetest.} is a sub-domain name that you specified for the server. For example, t est env.

Note: The sub-domain must consist of lowercase alphanumeric characters, ““(hyphen) or

“"(period). Also, the value must start and end with an alphanumeric character.

o myorg.com is the domain name of your organization. For example, hcl . com

You can access the product through a web browser by using any of the following methods:
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> Fully Qualified Hostname: When the server is configured, you can use host nane -f command to
get the fully qualified host name defined in the DNS to access HCL OneTest™ Server. For example,
{onetest}. myorg.com

o |P address: You can use the IP address to access HCL OneTest™ Server when you cannot create a
specific DNS record for the server. For example, i p- addr ess. ni p. i o.

Result

On completion of the ubuntu-init.sh script, a namespace with the name t est - syst emis created to install the

server software and the output displays the following information on the command-line interface:

o The INGRESS_DOMAIN that is in use. This is the URL from where you can access HCL OneTest™
Server. You must use this value for the global.hclOneTestingressDomain parameter in step 2 on

page 44 in the server installation topic.
> The DNS information that the Kubernetes cluster uses to resolve names.
- Certificate Authority (CA) that you must import into the browser to prevent certificate errors.

You can run the following command to get the certificate from the system:

kubectl get secret ingress -n test-system -o jsonpath={.data.ca\\.crt} | base64 -d
o Instructions to confirm whether the Kubernetes environment has started.

You can refer to the Results section for more details on how to verify that the Kubernetes environment
has started.
6. Perform one of the following options to configure a firewall:

Choose from:

> Run the following script to configure the firewall that allows traffic on cni0 and port 443:

Ubuntu version Command to be run
18.04 $ sudo ./ubuntu-firewall.sh
20.04 $ sudo HOME=$HOME ./ubuntu-firewall.sh

Note: You must consult your network administrator before you run this script, and confirm
whether the firewall is compatible with your corporate policy.

> Update the firewall that allows traffic on cni0 and port 443, if your Ubuntu server is already configured

with the firewall.

7. Optional: Run the following command to enable the Jaeger traces for performance and Web Ul tests:
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./service.sh expose jaeger

Note: If you do not enable Jaeger, HCL OneTest™ Server produces text output in a microservice log file
instead of the Jaeger traces when you run performance and Web Ul test assets.

Important: The Jaeger traces are not protected, thus, any information logged into the Jaeger server

might be accessible by anyone who has or discovers the <server-url>/jaeger URL.

8. Optional: Run the following command to enable the Prometheus server to monitor your system resources by

using metrics data:

./service.sh expose prometheus

! Important: The Prometheus metrics are not protected, thus, any information logged into the

Prometheus server might be accessible by anyone who has or discovers the <server-url>/prometheus
URL.

Results
You have set up the Kubernetes environment on Ubuntu.

What to do next

- You must log in to the server host system again after the installation process is completed so that changes to

the group membership are applied.

Note: You can run the kubect| get pods - Acommand to verify that the Kubernetes environment is

working. After a while, the status of the pods display a Runni ng or Conpl et e state.

* You can install the server software. See Installing the server software on Ubuntu by using k3s on page 43.

Related information

Jaeger Operator
Prometheus server

Troubleshooting on page 1069

Installing the server software on Ubuntu by using k3s

You can install HCL OneTest™ Server on the Ubuntu server that has a Kubernetes environment to run functional,
integration, and performance tests. HCL OneTest™ Server combines test data, test environments, and test runs and

reports into a single, web-based browser for testers and non-testers.
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Before you begin

You must have performed the following tasks:

- Completed the tasks provided in the Prerequisites section. See Prerequisites for installing the server software

on Ubuntu on page 37.

« Set up the Kubernetes environment (k3s). See Setting up a Kubernetes environment (k3s) on Ubuntu on

page 39.
- Logged in to the server host system again after you completed the k3s environment setup.

 Copied the INGRESS_DOMAIN value that is displayed on completion of the ubunt u-i ni t. sh script.

About this task

HCL OneTest™ Server 10.2.2 provides you with the test authoring capability, which utilizes a containerized version of
the HCL OneTest™ Studio desktop authoring tools.

Note: By design, the test authoring feature provides you with the capability to author tests that include writing
code, executing code, and accessing the shell. The container in Kubernetes that is used by the test authoring
or editing feature does not run as root and the container is not privileged. Hence, it results in providing some
protection to the host and other workloads that run on the same node.

You must not install the test authoring feature in the following scenarios:

« If you administer a network policy for your server installation.

« If you do not intend to use the test authoring feature.

The default status of the test authoring feature is disabled when you install HCL OneTest™ Server on Ubuntu (by using
k3s). If you want to use the test authoring feature in k3s, you must turn on the installing of the test authoring feature

by adding the following helm parameter as part of step 2.d on page 45:

--set global.hclOneTestAuthorEnabled=true

1. Log in to the Ubuntu server using an SSH session.

2. Perform the following steps to install the server software:

a. Run the following command to get the latest updates from the repository:

helm repo update

b. Run the following command to retrieve the charts required to install the server software:

helm pull --untar hclsoftware/hcl-onetest-server --version 7.1022.0

c¢. Run the following command to provide the execution permission for the scripts that are available in
the fi | es directory:
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chmod +x hcl-onetest-server/files/x.sh

d. Perform one of the steps described in the following table to install the server software based on your

requirement:

Task description Step number
Perform 2.d.i
To install the server software
on page 45
Perform 2.d.ii
To install the server software and enable the service virtualization through Istio, a
on page 45
Tech Preview feature .
and 2.d.ivon
page 46
Perform 2.d.iii
To install the server software, enable the service virtualization through Istio, a Tech on page 46
Preview feature, and to use another instance of the Jaeger Ul :
and 2.d.ivon
page 46

Perform 2.d.v
To install the server software and to use another instance of the Jaeger Ul

on page 46
Note: You must perform this step only if you want to use another instance
of Jaeger than the one you installed during the setting up of the Kubernetes

k3s environment.

i. Run the following command to install the server software:

helm install {my-ots} ./hcl-onetest-server -n test-system \

-f hcl-onetest-server/values-k3s.yaml \

--set global.hclOneTestIngressDomain={my-ingress-dns-name} \

--set global.hclFlexnetURL=https://hclsoftware.compliance.flexnetoperations.com \
--set global.hclFlexnetID={cloud-license-server-id} \

--set global.hclOneTestPasswordAutoGenSeed={password-seed}

ii. Run the following command to install the server software and to enable Istio service

virtualization, a Tech Preview feature:

helm 1dinstall {my-ots} ./hcl-onetest-server -n test-system \

-f hcl-onetest-server/values-k3s.yaml \

--set global.hclOneTestIngressDomain={my-ingress-dns-name} \

--set global.hclFlexnetURL=https://hclsoftware.compliance.flexnetoperations.com \
--set global.hclFlexnetID={cloud-license-server-id} \

--set global.hclOneTestPasswordAutoGenSeed={password-seed} \

-f hcl-onetest-server/values-k3s-demo.yaml
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iii. Run the following command to install the server software, to enable Istio service virtualization,
a Tech Preview feature, and to use another instance of Jaeger than the one you installed during
the setting up of the Kubernetes k3s environment:

helm install {my-ots} ./hcl-onetest-server -n test-system \

-f hcl-onetest-server/values-k3s.yaml \

--set global.hclOneTestIngressDomain={my-ingress-dns-name} \

--set global.hclFlexnetURL=https://hclsoftware.compliance.flexnetoperations.com \
--set global.hclFlexnetID={cloud-license-server-id} \

--set global.hclOneTestPasswordAutoGenSeed={password-seed} \

-f hcl-onetest-server/values-k3s-demo.yaml \

--set global.jaegerDashboard.externalURL={my-jaeger-dashboard-url} \

--set global.jaegerAgent.internalHostName=1localhost

iv. Run the following command to enable service virtualization through Istio, a Tech Preview

feature in the specific namespace:

kubectl create rolebinding istio-virtualization-enabled -n
bookinfo --clusterrole={my-ots}-execution-istio-test-system
--serviceaccount=test-system:{my-ots}-execution

Where, {my-ots} is the name of the release that is provided during the installation of the server
software.

Note: When you uninstall the chart, the manually created role bindings are not deleted
from the namespace. You can run the following command to delete the role bindings:

kubectl delete rolebinding istio-virtualization-enabled -n bookinfo

v. Run the following command to install the server software and to use another instance of

Jaeger than the one you installed during the setting up of the Kubernetes k3s environment:

helm 1dinstall {my-ots} ./hcl-onetest-server -n test-system \

-f hcl-onetest-server/values-k3s.yaml \

--set global.hclOneTestIngressDomain={my-ingress-dns-name} \

--set global.hclFlexnetURL=https://hclsoftware.compliance.flexnetoperations.com \
--set global.hclFlexnetID={cloud-license-server-id} \

--set global.hclOneTestPasswordAutoGenSeed={password-seed} \

--set global.jaegerDashboard.externalURL={my-jaeger-dashboard-url} \

--set global.jaegerAgent.internalHostName=1localhost

You must substitute the value of the following variables with the actual value in the command:
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= {ny-ot s} with the release name of your choice.

Note: The release name must consist of alphanumeric characters that are in lowercase
or “” (hyphen). The release name must also start with an alphabetic character and end

with an alphanumeric character. For example, my-org or abc-123.

= {ny-i ngress-dns- name} with the INGRESS_DOMAIN value that is displayed on completion of the

ubunt u-i ni t. sh script.

= Optional: {cl oud- I i cense-server-id} with the ID of the License Server for the initial team

space, if you want to set the license for the first time.

! Important: When you want to upgrade the product from the previous version, you must
configure the value of License Server ID from the Team Space License Configuration

page when the installation of the server is complete.

= { passwor d- seed} with a value of your choice.

Important: This password seed is used to create several default passwords for the
server. You must store the password seed securely. When you install the server
software by using the backup of the user data, you can reuse the password seed. You
can use this seed to restore the backed-up files either on the current or later versions

of the server software.

= {ny-j aeger - dashboar d- ur I } with the URL of the Jaeger server.

3. Optional: Run the following command to remove a job that is used to initialize the PostgresQL database

during the installation of the server software:
kubectl delete job {my-ots}-postgresql-init -n test-system

4. Optional: Perform the following steps to migrate data into HCL OneTest™ Server, if you upgraded the server
software from the previous version (10.1.0, 10.1.1, or 10.1.2):

a. Run the following script from the hcl - onet est - server/ fi | es directory to create a directory that
contains metadata related to the Persistent Volume Claims and their Persistent Volumes:

m grate.sh create-pvcs -n test-system {ny-ots}

b. Run the following script from the hcl - onet est - base directory to back up the data:

sudo backup.sh create-pvc-links -v ~/mgration-pvc-1links

c. Run the following command to stop the cluster and HCL OneTest™ Server:
k3s-killall.sh

d. Run the following script from the hcl - onet est - base directory to restore the backed-up data:
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sudo backup.sh restore -v ~/migration-pvc-links --release <backup-rel ease>: <target-rel ease>

<backup-fil e- name>

Note: You must replace the following variables with the actual value:

= <backup-r el ease> with the Helm release name of the server where the backup data is

stored.

= <target - r el ease> with the Helm release name of the server where you want to restore
the data.

= <backup-fi | e- name> with the name of the backed-up file that you saved.

e. Run the following command to restart Kubernetes and to start HCL OneTest™ Server:

sudo systencttl start k3s

f. Run the following script from the hcl - onet est - server/ fi | es directory to merge the data into the
server:

m grate.sh nmerge-dbs -n test-system {ny-ots}

g. Run the following command to remove the resources that were created during the migration process:

m grate.sh del ete-tenp-resources -n test-system {ny-ots}

5. Optional: Perform the following steps to restore the backed-up user data from previous version (10.1.3 or

later) to the latest version:

a. Run the following script from the hcl - onet est - base directory to create a directory that contains
metadata related to the Persistent Volume Claims and their Persistent Volumes:

sudo backup.sh create-pvc-1inks
b. Stop the Kubernetes cluster by running the k3s-ki I I al I . sh command.

c. Restore the backed-up user data by running the following commands:

sudo ./backup.sh restore [options] <backup-file-name>

Note: You must replace <backup-fi | e- name> with the name of the backed-up file that you
saved.

You can use the following parameters along with the restore command:

= -namespace or -n: Use this parameter to restore a specific namespace from the backup file.
If you do not mention the namespace, then volumes from all the namespaces in the backup
file are restored. You can map one namespace to another namespace by using colon (;). The

syntax is:

--namespace <name of the namespace> [ : <target-namespace>]
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—release or -r: Use this parameter if the Helm release name of the server to which the backup
is being restored is different than the Helm release name of the server where the backup was
taken. The syntax is:

--release <backup-release>:<target-release>

—-volumes or -v: Use this parameter to specify the directory path of the Volumes. The syntax is:

--volumes <path-of-the-directory>

-k or --confirm: Use this parameter to skip the confirmation step.

d. Restart the Kubernetes cluster by running the systenct! start k3s command to start HCL OneTest™

Server.

e. Run the following script from the hcl - onet est - server/ fi | es directory to create all the missing
databases:

m grate.sh create-nssing-dbs {ny-ots}

Note: You can expect that the output of the command to contain a number of errors pertaining

to objects that already exist. They do not indicate a problem with the execution of the script.

6. Run the following script from the hcl - onet est - server/ fi | es directory to verify and test the installed

server software:

$ helm test {my-ots} -n test-system

where {ny- ot s} is the name of the release that was provided during the installation of the server software.

Results
On completion of the installation of server software, the output displays the following information on the command-

line interface:

« Instructions to access Keycloak to manage and authenticate users.

The user name can be keycloak and the password can be retrieved by running the following command:

kubectl get secret -n namespace onetest-keycloak-postgresql -o jsonpath="{.data.password}" | base64
--decode; echo

where:
> onetest is a sub-domain name that you selected for the server.
> namespace is the name of the namespace that you created.

» The URL to access the HCL OneTest™ Server Ul.

What to do next
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You can perform the following tasks:

« Configure licenses for team spaces. See Configuring licenses for team spaces on page 115.

- Configure the server software. See Configuration of the server software on page 78.

Related information

Helm documentation

Troubleshooting on page 1069

Installation of the server software on Azure Kubernetes Service

You can find information about the tasks that you can perform to install HCL OneTest™ Server on the Azure

Kubernetes Service (AKS) platform.

Prerequisites for installing the server software on Azure Kubernetes Service

You must complete certain tasks before you install HCL OneTest™ Server on the Azure Kubernetes Service (AKS)

platform.

The following sections describe each prerequisite in detail:

« Internet access on page 50

« Azure subscription on page 50

« Azure Kubernetes Service on page 50
» Mandatory software on page 51

« Azure resource provider on page 51

Internet access

You must have access to the internet to install HCL OneTest™ Server.

Azure subscription

You must have an active Azure subscription along with an Owner, or Contributor, and User-Access Administrator role
on the Azure subscription. You can create a subscription from Microsoft Azure if you do not have a valid subscription.

Azure Kubernetes Service

You must ensure that you select the size of the virtual machine as Standard_D8ds_v4 while setting up the AKS cluster,

if you plan to disable the test authoring feature.
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The default status of the test authoring feature is enabled when you install HCL OneTest™ Server on AKS. If you plan
to use the test authoring feature, then you must set up the AKS cluster with Kubernetes and ensure that you confirm
the maximum number of nodes that are available in your quota of Azure subscription to configure the size of the node
pool while setting up the AKS cluster.

For more information about Azure Kubernetes Service and deployment options, refer to Azure Kubernetes Service
documentation.

Note: For more information about specific versions of software requirements, see System Requirements on
page 13.
Mandatory software

You must install the following mandatory software:

» Git Bash 2.31.1. For more information, refer to the Git documentation.

« Helm. For more information, refer to the Helm documentation. For more information about specific versions

of software requirements, see System Requirements on page 13.
Note: The Helm command must be in one of the directories in your PATH environment variable.
» Azure command-line interface (CLI) 2.25. For more information, refer to the Azure CLI documentation.

Note: You can run the az versi on command to find the version and dependent libraries that are
installed.

» kubectl tool 1.21. For more information, refer to the Kubernetes documentation.
« NGINX Ingress Controller. See Installing NGINX Ingress Controller.

« Optional: Jaeger operator to trace test logs and Jaeger-based reports when you run tests. For more
information, refer to Jaeger documentation.

Azure resource provider

Register an Azure resource provider so that the AKS cluster can provision to use Persistent Volumes with Azure Files
for the ReadWriteOnceMany (RWX) storage class. You can run the following command to enable the storage for the
RWX storage class:

az provider register -n Microsoft.Storage

For more information about Azure resource providers and types, refer to Azure Kubernetes Service documentation.
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Related information

NGINX Ingress Controller

Cluster autoscaler on Azure Kubernetes Service

You can enable the cluster autoscaler feature on Azure Kubernetes Service (AKS) to manage the cost of the cluster

effectively.

You can use the cluster autoscaler with multiple node pools that are enabled. Depending on your AKS setup, when the
nodes are not in use, the nodes of the AKS cluster are automatically shut down to minimize the runtime costs of the

AKS cluster without risking the performance of HCL OneTest™ Server.

When you create an AKS cluster, that contains a single node pool as the default node pool. You can use the az aks
node pool command to add a node pool to your existing AKS cluster. You can then use the az aks update command
to enable and configure the cluster autoscaler on the node pool for the existing AKS cluster.

You can use the following commands to add a node pool and enable the cluster autoscaler on the node pool for the
existing AKS cluster:

az aks nodepool add -g <resource_group> -n wrko \
--cluster-name <aks_cluster_name> \
--kubernetes-version <k8s_version> \
--node-vm-size Standard_D2ds_v4 \
--enable-cluster-autoscaler \
--node-count 1 --min-count 1 --max-count 2 \
--labels execution=allow editor=allow \
--node-taints reserved=reserved:NoSchedule

az aks update \
-g <resource_group> -n <aks_cluster_name> \
--cluster-autoscaler-profile scale-down-unneeded-time=1m scale-down-delay-after-add=1m

Note: You must replace <r esour ce_gr oup>, <k8s_ver si on>, and <aks_cl ust er _nanme> with the name of the

resource group, the version number of Kubernetes, and the name of the AKS cluster in the command.
The preceding commands has one node that runs all the time to reduce the launch time of test editors. You can
minimize the compute costs by changing -node-count to 0. The maximum size of the node pool is set to 2. Therefore,

due to the resources that are requested by the test editor, you can run only two test editors concurrently.

Note: You must confirm the maximum number of nodes that are available in your quota of Azure subscription

to configure the size of the node pool.

After you run the commands, you have completed the following actions:
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» Added a user node pool called w ko
« Enabled the cluster autoscaler feature

« Updated the default values of scale-down-unneeded-time and scale-down-delay-after-add in the cluster-wide
autoscaler profile to 1m

You can add the following command in Step 8.a on page 59 or 8.b on page 59 when you install the server

software to run test assets and to open the test editor on the created node pool:

-f hcl-onetest-server/values-dedicated-nodes.yaml

After you install the server software by enabling the cluster autoscaler feature on your AKS cluster, a new container is
used only to run test assets and to open the test editor. You can run the kubectl get pods command to view the status
of the pod, which is displayed as pendi ng.

You can describe the pod by running the kubectl describe pod <pod_name> -n <namespace> command to view a

scale event in the following circumstances:

» When you run test assets from HCL OneTest™ Server.
» When you open the test editor from HCL OneTest™ Server.

When the test asset run or editing of test assets is complete, the pod shuts down automatically. Thus, you can reduce
the cost of the cluster when the node is not in use. You can then run the kubectl get nodes command to verify the

number of nodes that are currently in the Ready state.

Related information

Automatically scale a cluster to meet application demands on Azure Kubernetes Service (AKS)

Create and manage multiple node pools for a cluster in Azure Kubernetes Service (AKS)

Installing Emissary-ingress

You must install Emissary-ingress to terminate Transport Layer Security (TLS) and route traffic to HCL OneTest™
Server. You can install Emissary-ingress by pulling the images from Azure Container Registry (ACR) when you do not

want to pull the images from the public registries.
Before you begin

You must have completed the following tasks:

« Set up the Azure Kubernetes Service (AKS) cluster with Kubernetes. For more information, refer to Azure

Kubernetes Service documentation.

« Installed the following software:
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o Git Bash 2.31.1. For more information, refer to the Git documentation.

> Helm. For more information, refer to the Helm documentation. For more information about specific

versions of software requirements, see System Requirements on page 13.

Note: The Helm command must be in one of the directories in your PATH environment

variable.

o kubectl tool 1.21. For more information, refer to the Kubernetes documentation.

o Azure command-line interface (Azure CLI) 2.34.1. For more information, refer to the Azure CLI
documentation.

Note: You can run the az version command to find the version and dependent libraries that are

installed.
» Logged in to the AKS cluster.
Note: You can run the az login command to log in to AKS interactively.
 Subscribed to active Azure subscription.

Note: You can run the az account set --subscription {subscription_name} command to set your active

subscription.
« Configured the location of your AKS cluster.

Note: You can run the az configure —defaults location={location_name} command to set the location
of your AKS cluster.

0 Tip: You can run the following command to get the list of all the available locations:

az account list-locations --query "[].{DisplayName:displayName, Name:name}" -o table

About this task

The following table lists the variables that you must replace with the actual value in the command.

Variables Description

{resource_group}
The name of the resource group that you created during the creation of the AKS

cluster.
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Variables Description

{azure_cluster}
The name of the Azure cluster that you created during the creation of the AKS

cluster.

{azure_container_registry}
The name of the ACR that you created during the AKS setup.

{ip_address}
The internal IP address to use with the Emissary-ingress.

Note: You must ensure that the IP address is not in use within your virtual

network.

1. Run the following command to configure kubectl to connect to the AKS cluster:

az aks get-credentials -g {resource_group} -n {azure_cluster}

Note: You can verify the connection to the AKS cluster by running the kubectl get nodes command

that displays a list of the cluster nodes.

2. Add the Emissary-ingress repository to Helm by running the following command:
helm repo add datawire https://app.getambassador.io --force-update

3. Run the following command to know the latest version of the Emissary-ingress chart that matches the

keyword emissary-ingress:
helm search repo emissary-ingress
4. Run the following command to list the images and move into ACR:

for image in $(helm template emissary-ingress --namespace emissary datawire/emissary-ingress \
--set adminService.create=false \
--set agent.enabled=false \
--set replicaCount=1 \
--set test.enabled=false \
--set image.repository=gcr.io/datawire/emissary \
--version "7.3.2" \
| sed -r -n 's/ *ximage: *x([A"]x)/\1/p' | uniq)
do
echo "az acr import -n {azure_container_registry} \\"
echo " --source ${image/:x?@/@} \\"
tag=${image/@x/}
echo " --image S${tag#x/}"
done
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n Remember: emissary-ingress is the name of the namespace. If you created a namespace by using a
different value, then you must use that value in place of the emissary-ingress in all the instances in

this procedure.

Result
The terminal displays a block of commands.

5. Run the commands that are displayed on the terminal after you perform Step 4 on page 55 to import an
image to ACR.

6. Run the following commands to install the Emissary-ingress by referencing the images from ACR:

curl -s https://app.getambassador.io/yaml/emissary/2.2.2/emissary-crds.yaml \
| sed -r -e "s/replicas: 3/replicas: 1/" \
| sed -r -e "st#docker.io/emissaryingress#{azure_container_registry}.azurecr.io/datawire#" \
| kubectl apply -f -

helm install emissary-ingress datawire/emissary-ingress \
-n emissary \
--create-namespace \
--set adminService.create=false \
--set agent.enabled=false \
--set replicaCount=1 \
--set test.enabled=false \
--set 1image.repository="{azure_container_registry}.azurecr.io/datawire/emissary" \
--set service.annotations."service\.beta\.kubernetes\.io/azure-load-balancer-internal"=true \
--set service.loadBalancerIP={ip_address} \
--version "7.3.2" && \

kubectl rollout status -n emissary deployment/emissary-ingress -w

7. Run the following command to verify that external-IP is assigned to Emissary-ingress:

kubectl get svc -n emissary -w emissary-ingress

Note: The status of EXTERNAL-IP is displayed as Pendi ng for a few minutes. If the status does not
change to {i p_addr ess}, then that indicates you have a permission issue.

You can run the following command to investigate the issue:

kubectl describe svc -n emissary emissary-ingres

Results
You have installed Emissary-ingress.

What to do next

You can install the server software. See Installing the server software on Azure Kubernetes Service on page 57.



Chapter 4. Administrator Guide

Related information

Create an ingress controller to an internal virtual network in Azure Kubernetes Service (AKS)
Create an ingress controller to an internal virtual network in Azure Kubernetes Service (AKS)

Emissary-ingress documentation

Installing the server software on Azure Kubernetes Service

You can install HCL OneTest™ Server on Azure Kubernetes Service (AKS) that has a Kubernetes environment to run
functional, integration, and performance tests. HCL OneTest™ Server combines all the capabilities into a single web-
based browser for testers and non-testers. The capabilities include test runs, test data, test environment, or test

reports.
Before you begin

You must have performed the following tasks:

« Completed the tasks provided in the Prerequisites section. See Prerequisites for installing the server software

on Azure Kubernetes Service on page 50.

- Optional: Enabled the autoscaler feature if you want a new container to be used only to run test assets and to
open the test editor. See Cluster autoscaler on Azure Kubernetes Service on page 52.

» Logged in to the AKS cluster. You can run the az 1 ogi n command to log in to AKS interactively.

« Subscribed to active Azure subscription. You can run the az account set --subscription

{subscri pti on_name} command to set your active subscription.

- Configured the location of your AKS cluster. You can run the az configure --defaults

I ocati on={I ocation_nanme} command to set the location of your AKS cluster.

0 Tip: You can run the following command to get the list of all the available locations:

az account list-locations --query "[].{DisplayName:displayName, Name:name}" -o table

About this task

You must replace the following variables with the actual value in this procedure:

« {resour ce_group} with the name of the resource group that you created during the creation of the AKS cluster.

« {azure_cl ust er} with the name of the Azure cluster that you created during the creation of the AKS cluster.
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* {azure_cont ai ner _r egi st ry} with the name of the Azure Container Registry (ACR) that you created during the
AKS setup.

* {ny-i ngress- dns- name} with the INGRESS_DOMAIN value that you provided during the installation of NGINX
Ingress Controller.

HCL OneTest™ Server 10.2.2 provides you with the test authoring capability, which utilizes a containerized version of
the HCL OneTest™ Studio desktop authoring tools.

Note: By design, the test authoring feature provides you with the capability to author tests that include writing
code, executing code, and accessing the shell. The container in Kubernetes that is used by the test authoring
or editing feature does not run as root and the container is not privileged. Hence, it results in providing some

protection to the host and other workloads that run on the same node.

You must not install the test authoring feature in the following scenarios:

- If you administer a network policy for your server installation.

- If you do not intend to use the test authoring feature.

The default status of the test authoring feature is enabled when you install HCL OneTest™ Server on AKS. If you want
to disable the test authoring feature in AKS, you must turn off the installing of the test authoring feature by adding the

following helm parameter as part of step 8 on page 59:

--set global.hclOneTestAuthorEnabled=false

1. Add the software registry to Helm by running the following command:
helm repo add hclsoftware https://hclcr.io/chartrepo/ot
2. Run the following command to get the latest updates from the repository:
helm repo update
3. Run the following commands to fetch the scripts that are used to install HCL OneTest™ Server:

helm pull --untar hclsoftware/hcl-onetest-server --version 7.1022.0
chmod +x hcl-onetest-server/files/x.sh

4. Run the following command to configure kubectl to connect to the AKS cluster:

az aks get-credentials -g {resource_group} -n {azure_cluster}

Note: You can verify the connection to the AKS cluster by running the kubectl get nodes command

that displays a list of the cluster nodes.

5. Run the following script from the hcl - onet est - server/fi | es directory to pull the images of HCL
OneTest™ Server from the Harbor repository to ACR:

bash hcl-onetest-server/files/move-images.sh {azure_container_registry}.azurecr.io/hcl-onetest
hclcr.io/ot/hcl-onetest
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o Tip: You can verify that multiple manifests are associated with the image in the ACR by running the

following commands:

az acr repository list -n {azure_container_registry} -otsv

az acr repository show-manifests -n {azure_container_registry} --repository \

$(az acr repository list -n {azure_container_registry} -otsv --query [0])

6. Create a namespace in which you want to install the server software by running the following command:

kubectl create namespace test-system

n Remember: t est - syst emis the name of the namespace. If you created a namespace by using a

different value, then you must use that value in place of the t est - syst emin all the instances in this

procedure.

7. Run the following script from the hcl - onet est - server/ fi | es directory to enable Certificate Authority

(CA) as trusted certificates and to create an ingress Secret:

hcl-onetest-server/files/certificate.sh -n test-system -s dingress {my-ingress-dns-name}

8. Perform one of the steps described in the following table to install the server software based on your

requirement:

Task description Step number

To install the server software

Perform 8.a on

page 59

To install the server software and enable Jaeger for performance and Web Ul tests logs

Perform 8.b on

page 59

Note: The following command installs the server software by referencing the images from ACR.

Thereby, HCL OneTest™ Server can provide better performance.

a. Run the following command to install the server software:

helm install {my-ots} ./hcl-onetest-server -n test-system \
-f hcl-onetest-server/values-k8s.yaml \

--set
--set
--set
--set
--set
--set

global.
global.
global.
global.
global.
global.

persistence.rwxStorageClass=azurefile \
hclOneTestIngressDomain={my-ingress-dns-name} \
hclFlexnetURL=https://hclsoftware.compliance.flexnetoperations.com \
hclFlexnetID={cloud-license-server-id} \
hclOneTestRegistry=<azure_container_registry>.azurecr.io/hcl-onetest \
hclOneTestPasswordAutoGenSeed={password-seed}

b. Run the following command to install the server software and to enable Jaeger for performance and
Web Ul tests logs:

helm 1dinstall {my-ots} ./hcl-onetest-server -n test-system \

-f hcl-onetest-server/values-k8s.yaml \
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--set global.persistence.rwxStorageClass=azurefile \

--set global.hclOneTestIngressDomain={my-ingress-dns—-name} \

--set global.hclFlexnetURL=https://hclsoftware.compliance.flexnetoperations.com \
--set global.hclFlexnetID={cloud-license-server-id} \

--set global.hclOneTestRegistry=<azure_container_registry>.azurecr.io/hcl-onetest \
--set global.hclOneTestPasswordAutoGenSeed={password-seed} \

--set-string execution.annotations.sidecar\\.jaegertracing\\.io/inject=true \

--set global.jaegerAgent.internalHostName=1localhost \

--set global.jaegerDashboard.externalURL={my-jaeger-dashboard-url}

You must substitute the value of the following variables with the actual value in the command:

° {ny-ot s} with the release name of your choice.

Note: The release name must consist of alphanumeric characters that are in lowercase or
““” (hyphen). The release name must also start with an alphabetic character and end with an

alphanumeric character. For example, my-org or abc-123.

o {ny-i ngress-dns- nane} with the INGRESS_DOMAIN value that you provided during the installation of
NGINX Ingress Controller.

o Optional: {cl oud- 1 i cense- server-id} with the ID of the License Server for the initial team space, if you

want to set the license for the first time.

! Important: When you want to upgrade the product from the previous version, you must
configure the value of License Server ID from the Team Space License Configuration page

when the installation of the server is complete.
o { passwor d- seed} with a value of your choice.

! Important: This password seed is used to create several default passwords for the server.
You must store the password seed securely. When you install the server software by using the
backup of the user data, you can reuse the password seed. You can use this seed to restore

the backed-up files either on the current or later versions of the server software.

o {ny-j aeger - dashboar d- ur I } with the URL of the Jaeger server.

9. Run the following script from the hcl - onet est - server/ fi | es directory to verify and test the installed

server software:

$ helm test {my-ots} -n test-system

where {ny- ot s} is the name of the release that was provided during the installation of the server software.

Results

You have installed the server software. The terminal displays the following information:
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» The URL to access Keycloak to manage and authenticate users.

The user name can be keycloak and the password can be retrieved by running the following command:

kubectl get secret -n test-system {my-ots}-keycloak-postgresql -o jsonpath="{.data.password}" |
base64 --decode; echo

where:
> {ny-ots} is the name of the release that was provided during the installation of the server software.

> t est - syst emis the name of the namespace that you created during the installation of the server

software.

» The URL to access the HCL OneTest™ Server Ul.

What to do next

You can perform the following tasks:

« Configure licenses for team spaces. See Configuring licenses for team spaces on page 115.

- Configure the server software. See Configuration of the server software on page 78.

Related information

Helm documentation

Azure Kubernetes Service documentation

Server software upgrade methods

When you want to use the enhanced functionalities of HCL OneTest™ Server, you must upgrade the product to the

latest version of the server software.

You can upgrade the server software by using the Upgrade (by new install) method. In this method, you must upgrade
the server software by uninstalling the existing version of the product, and then install the latest version of the
product.

To learn more about server software upgrade methods on platforms such as Ubuntu and Azure Kubernetes Service
(AKS), refer to the following topics:

Server software upgrade on Ubuntu

When you want to use the latest version of the server software on Ubuntu, you must upgrade HCL OneTest™ Server
from the previous version of the software.
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! Important: On the Ubuntu platform, the in-place upgrade method is not available. You must use the upgrade

(by new install) method to upgrade the server software.

Before you upgrade the server software, you must ensure that you have completed the following tasks:
« Installed Helm. For more information, refer to the Helm documentation.
« Completed all test executions that are running on the existing version of HCL OneTest™ Server.
- Stopped all stub executions that are running on the existing version of HCL OneTest™ Server.
« Canceled any scheduled test runs that have a future date or time.
- Informed users that HCL OneTest™ Server is offline temporarily during the upgrade process.

Note: For more information about specific versions of software requirements, see System Requirements on

page 13.
In upgrade (by new install) method, depending on the existing version of the software, you can upgrade the server
software by using any of the following options.

To upgrade HCL OneTest™ Server (10.1.0 or later) to latest version, you must perform these tasks in sequence as

listed in the following table:

Tasks Task description More information

1 Back up the user data from the previous version of HCL
« For 10.1.0 or 10.1.1, refer to

Backing up user data.

OneTest™ Server.

« For 10.1.2 or later, refer to Back-

ing up user data.

2 Uninstall the previous version of HCL OneTest™ Server. Uninstalling the server software from

Ubuntu on page 76

3 Install the latest version of the server software and then mi- | Installing the server software on Ubuntu

grate the data as part of the installation process. by using k3s on page 43

If your existing version of server software is 10.0.2, Fix Pack 1, or earlier, then you cannot directly upgrade to the latest
version of the server software due to the steps involved in the migration process. Therefore, you must perform the

tasks in sequence as listed in the following table:
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Tasks Task description More information
1 Upgrade HCL OneTest™ Server 10.1.2. Installation of the server software on
Ubuntu
2 Back up the user data from HCL OneTest™ Server 10.1.2. Backing up user data-10.1.2
3 Uninstall HCL OneTest™ Server 10.1.2. Uninstalling the server software
4 Install the latest version of the server software and then mi- | Installing the server software on Ubuntu
grate the data as part of the installation process. by using k3s on page 43

Upgrading the server software on Azure Kubernetes Service

When you want to use the latest version of the server software on Azure Kubernetes Service (AKS), you must upgrade

HCL OneTest™ Server from the previous version of the software.
Before you begin

You must have completed the following tasks:

« Completed the tasks provided in the Prerequisites section. See Prerequisites for installing the server software

on Azure Kubernetes Service on page 50.
« Informed users that HCL OneTest™ Server is offline temporarily during the upgrade process.
- Completed all test executions that are running on the existing version of HCL OneTest™ Server.
- Stopped all stub executions that are running on the existing version of HCL OneTest™ Server.
 Canceled any scheduled test runs that have a future date or time.
- Logged in to the AKS cluster. You can run the az | ogi n command to log in to AKS interactively.

« Subscribed to active Azure subscription. You can run the az account set --subscription

{subscri pti on_name} command to set your active subscription.

Optional. You can back up the user data from the previous version of the product. If the upgrade fails, then you can
use that backup file to restore it on latest version of the server software. See Backing up the server data on Azure

Kubernetes Service on page 74.

Note: For more information about specific versions of software requirements, see System Requirements on

page 13.

About this task
When you want to install the latest version of the server software in the same location that contained the 10.2.0 or

later, then you can upgrade HCL OneTest™ Server by using the hel m upgr ade command.
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! Important: On AKS, you can use in-place upgrade method to upgrade to the latest version of the server

software.

You must replace the following variables with the actual value in this procedure:

- {resour ce_group} With the name of the resource group that you created during the creation of the AKS cluster.
* {azure_cl ust er} with the name of the Azure cluster that you created during the creation of the AKS cluster.

* {azure_cont ai ner_r egi st ry} with the name of the Azure Container Registry (ACR) that you created during the
AKS setup.

e {ny-i ngress-dns- name} with the INGRESS_DOMAIN value that you provided during the installation of NGINX

Ingress Controller.

n Remember: t est - syst emis the name of the namespace that is created during the installation of the server
software. If you have created a namespace by using a different value, then you must use that value in place of
the t est - syst emin all the instances in this procedure.

1. Add the software registry to Helm by running the following command:
helm repo add hclsoftware https://hclcr.io/chartrepo/ot
2. Run the following command to get the latest updates from the repository:
helm repo update
3. Run the following commands to fetch the scripts that are used to install HCL OneTest™ Server:

helm pull --untar hclsoftware/hcl-onetest-server --version 7.1022.0
chmod +x hcl-onetest-server/files/x.sh

4. Run the following command to configure kubectl to connect to the AKS cluster:

az aks get-credentials -g {resource_group} -n {azure_cluster}

Note: You can verify the connection to the AKS cluster by running the kubectl get nodes command
that displays a list of the cluster nodes.

5. Run the following script from the hcl - onet est - server/ fi | es directory to pull the images of HCL

OneTest™ Server from the Harbor repository to ACR:

bash hcl-onetest-server/files/move-images.sh {azure_container_registry}.azurecr.io/hcl-onetest
hclcr.io/ot/hcl-onetest

0 Tip: You can verify that multiple manifests are associated with the image in the ACR by running the

following commands:
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o az acr repository list -n {azure_container_registry} -otsv
az acr repository show-manifests -n {azure_container_registry} --repository \
$(az acr repository list -n {azure_container_registry} -otsv --query [0])

6. Run the helm list -A command to list all releases that are deployed across all namespaces.
7. Perform one of the steps described in the following table to upgrade the server software based on your

requirement:

Step description Step no

Perform 7.a on

T deth ft
O upgrade the server sortware page 65

Perform 7.b on
To upgrade the server software and enable Jaeger for performance and Web Ul tests logs

page 65

0 Tip: You can run the following command to know the value of the variables that you used during the

installation of the previous version of the server software:
helm get values {release_name} -n {namespace}

For example, if your name of the release is ny- ot s and name of the namespace is t est syst em then you

must run the command as follows:

helm get values my-ots -n testsystem

Note: The following command upgrades the server software by referencing the images from ACR.
Therefore, HCL OneTest™ Server can provide better performance.

a. Run the following command to upgrade the server software:

helm upgrade {my-ots} ./hcl-onetest-server -n test-system \

-f hcl-onetest-server/values-k8s.yaml \

--set global.persistence.rwxStorageClass=azurefile \

--set global.hclOneTestIngressDomain={my-ingress-dns-name} \

--set global.hclOneTestRegistry={azure_container_registry}.azurecr.io/hcl-onetest \
--set global.hclOneTestPasswordAutoGenSeed={password-seed}

b. Run the following command to upgrade the server software and to enable Jaeger for performance and
Web Ul tests logs:

helm upgrade {my-ots} ./hcl-onetest-server -n test-system \

-f hcl-onetest-server/values-k8s.yaml \

--set global.persistence.rwxStorageClass=azurefile \

--set global.hclOneTestIngressDomain={my-ingress-dns-name} \

--set global.hclOneTestRegistry={azure_container_registry}.azurecr.io/hcl-onetest \
--set global.hclOneTestPasswordAutoGenSeed={password-seed} \

--set-string execution.annotations.sidecar\\.jaegertracing\\.io/inject=true \

--set global.jaegerAgent.internalHostName=1localhost \

--set global.jaegerDashboard.externalURL={my-jaeger-dashboard-url}
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You must substitute the value of the following variables with the actual value in the command:

° {ny-ot s} with the release name that you used during the installation of the previous version of the

server software.

o { passwor d- seed} With a value of your choice.

! Important: This password seed is used to create several default passwords for the server.
You must store the password seed securely. When you install the server software by using the
backup of the user data, you can reuse the password seed. You can use this seed to restore

the backed-up files either on the current or later versions of the server software.

o {ny-j aeger - dashboar d- ur | } with the URL of the Jaeger server.

8. Run the following script from the hcl - onet est - server/ fi | es directory to verify and test the installed
server software:

$ helm test {my-ots} -n test-system

where {ny- ot s} is the name of the release that was provided during the installation of the server software.

Results

On the successful upgrade of HCL OneTest™ Server, the output displays the following information:

- Keycloak URL to manage and authenticate users.

» A URL to access the HCL OneTest™ Server Ul.

What to do next

You can perform the following tasks:

« Configure licenses for team spaces. See Configuring licenses for team spaces on page 115.

- Configure the server software. See Configuration of the server software on page 78.

Backup and restoration of the server data

You must back up all your server data before you uninstall the current version of the server software or upgrade to the

latest version of the server software. You must back up the server data to avoid data loss or inaccessibility of data.

A backup is the process of creating a copy of the data on your system and storing it elsewhere, generally on

secondary storage. You can then use that copy to recover if your original data is lost or becomes inaccessible.

A restore is a process of copying the backed-up data from the secondary storage and restoring it to the original

location. You can restore the backed-up data when your original data is lost or becomes inaccessible.
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You must back up and restore the data when you perform the following tasks:

» Move the existing environment to a new system.
- Change the name of the release or namespace that you used during the installation of the server software.
« Minimize the downtime of HCL OneTest™ Server during disaster recovery.

« Upgrade to the latest version of the server software.

To learn more about backup and restoration of the server data on platforms such as Ubuntu and Azure Kubernetes
Service (AKS), refer to the following topics:

« Backup and restoration of the server data on Ubuntu on page 67
« Backup and restoration of the server data on Azure Kubernetes Service on page 71

Backup and restoration of the server data on Ubuntu

To secure the data of HCL OneTest™ Server that is installed on the Ubuntu server, you can back up the data. At any

point in time, after you install HCL OneTest™ Server, you can restore the backed-up data.

Backing up the server data on Ubuntu

When you want to upgrade to a new version of the server software or to move your existing environments to new
systems, you must back up the server data.

Before you begin

You must have completed the following tasks:

- Been assigned the same role that was required to install and uninstall the server software.
 Been granted with the sudo access.
« Installed the server software and all of the HCL OneTest™ Server pods are in Runni ng state.

« Communicated to the users that HCL OneTest™ Server might be unavailable for some time until the process is
complete.

1. Log in to the Ubuntu server and open a terminal.

2. Add the software registry to Helm by running the following command:
helm repo add hclsoftware https://hclcr.io/chartrepo/ot

3. Run the following command to extract the base:
helm pull --untar hclsoftware/hcl-onetest-base --version 7.1022.0

4. Change to the hcl - onet est - base directory.
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This directory contains the backup. sh script which is required to complete the backup operation.

5. Create a directory that contains metadata related to the Persistent Volume Claims and their Persistent
Volumes by running the following command:

sudo ./backup.sh create-pvc-links
You can use the following optional parameter along with the create-pvc-links command:
—-volumes or -v: Use this parameter to specify the directory path of the Volumes.

For example, backup. sh create-pvc-1inks -v hcl -onet est - base/ ny- pvc- | i nks creates a directory called ny-

pvc- | i nks that stores the metadata required for backup.

n Remember:

o If you did not provide the volume parameter, by default, the command creates a sub-directory

in the same directory where you have the backup script.

> You must ensure that the directory you create must be empty or not exist to avoid script

failure.

o If you specify a directory by using the -v parameter, then you must use the same parameter

value when you restore the data.

6. Run the following command to stop the cluster and HCL OneTest™ Server:
k3s-killall.sh
7. Run the following command to create a backup of the existing user data:
sudo ./backup.sh create [options] <backup-file-name>
After you run this command, a backup of the local Persistent Volumes is created. The backup is created as tar

archives that is compressed by using gzip (.tar.gz). The create command archives the Persistent Volumes into
the <backup-file-name>.

You can use the following parameters along with the create command:

> —namespace or -n: Use this parameter to back up the Persistent Volumes in the specified namespace.
If you do not mention the namespace, then all the Volumes from all the namespaces are included in
the backup. The syntax is:

-namespace <name of the namespace>

> —-volumes or -v: Use this parameter to specify the directory path of the Volumes. The syntax is:

-volumes <path-of-the-directory>

n Remember:
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n = If you did not provide the volume parameter, by default, the command creates a sub-

directory in the same directory where you have the backup script.

= If you specify a directory by using the -v parameter, then you must use the same

parameter value when you restore the data.

For example,

sudo ./backup.sh create --namespace test-system my-backup.tar.gz

This command creates a backup file named my-backup.tar.gz that contains all of the Persistent Volumes
associated with pods available in the test-system namespace.

8. Run the following command to restart the cluster and HCL OneTest™ Server:

sudo systemctl start k3s
Results
You have backed up the data of HCL OneTest™ Server.

Restoring the server data on Ubuntu

You can restore the data that is backed up in HCL OneTest™ Server at any point in time after you install latest version

of server software.
Before you begin

You must have completed the following tasks:

- Been assigned the same role that was required to install and uninstall the server software.
 Been granted with the sudo access.

« Communicated to the users that HCL OneTest™ Server might be unavailable for some time until the process is

complete.

« Backed up the data from HCL OneTest™ Server.

About this task

The following procedure is for the restoration of the server data from the current release. If you are upgrading
the server software, then you can restore the server data from the earlier version to the latest version during the

installation of the server software. For more information, see the Related information section.

1. Log in to the Ubuntu server and open a terminal.

2. Add the software registry to Helm by running the following command:
helm repo add hclsoftware https://hclcr.io/chartrepo/ot

3. Run the following command to extract the base:

69



70

HCL OneTest™ Server

helm pull --untar hclsoftware/hcl-onetest-base --version 7.1022.0

4. Change to the hcl - onet est - base directory.
This directory contains the backup. sh script which is required to complete the restore operation.

5. Create a directory that contains metadata related to the Persistent Volume Claims and their Persistent
Volumes by running the following command if you have not done before:

sudo ./backup.sh create-pvc-links
You can use the following optional parameter along with the create-pvc-links command:
—-volumes or -v: Use this parameter to specify the directory path of the Volumes.

For example, backup. sh create-pvc-1inks -v hcl -onet est - base/ ny- pvc- | i nks creates a directory called ny-

pve-1i nks that stores the metadata required to restore your user data.

n Remember:

o If you did not provide the volume parameter, by default, the command creates a sub-directory

in the same directory where you have the backup script.

> You must ensure that the directory you create must be empty or not exist to avoid script

failure.

6. Run the following command to stop the cluster and HCL OneTest™ Server:
k3s-killall.sh

7. Run the following command to restore the backed-up user data:

sudo ./backup.sh restore [options] <backup-file-name>
The restore command overwrites the existing Persistent Volumes with data from the <backup-file-name>.

You can use the following parameters along with the restore command:

o

-namespace or -n: Use this parameter to restore a specific namespace from the backup file. If you do
not mention the namespace, then volumes from all the namespaces in the backup file are restored.

You can map one namespace to another namespace by using colon (:). The syntax is:

--namespace <name of the namespace> [ :<target-namespace>]

o

—-release or -r: Use this parameter if the Helm release name of the server to which the backup is being
restored is different than the Helm release name of the server where the backup was taken. The syntax
is:

--release <backup-release>:<target-release>

o

—-volumes or -v: Use this parameter to specify the directory path of the Volumes. The syntax is:
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--vo'lumes <path-of-the-directory>
o -k or --confirm: Use this parameter to skip the confirmation step.

For example,

sudo ./backup.sh restore --namespace test-system:new-test-system -r rel-1l:rel-2 -k

my-backup.tar.gz

This command restores the volumes that are backed up from the rel-7 release in the test-system namespace
to the rel-2 release in the new-test-system namespace and skips the confirmation step.
8. Run the following command to restart the cluster and HCL OneTest™ Server:

sudo systemctl start k3s

Note:

> The cluster and HCL OneTest™ Server might take some time to restart and until that time, you

cannot access the HCL OneTest™ Server URL.

> You can run the kubect! get pods - Acommand to verify that the Kubernetes environment is

working. After a while, the status of the pods must be Runni ng state.

Results

You have restored the data of HCL OneTest™ Server.

Related information

Server software upgrade on Ubuntu on page 61

Backup and restoration of the server data on Azure Kubernetes Service

To secure the data in HCL OneTest™ Server that is installed on Azure Kubernetes Service (AKS), you can back up the

data. At any point in time, after you install HCL OneTest™ Server, you can restore the backed-up data.

! Attention: The instructions provided are an example of how an AKS cluster can be configured to use Velero
for backing up and restoring the HCL OneTest™ Server data. The procedures to backup and restore the server

data might be not valid in all the scenarios.
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] You must refer to the Velero and Azure Kubernetes Service documentation to identify how you can configure

Velero in your AKS cluster based on your existing AKS setup to backup and restore the HCL OneTest™ Server

data.

» Velero Documentation

* AKS Documentation

Preparing the Azure Kubernetes Service cluster to back up the server data

When you want to back up the server data, you must prepare your Azure Kubernetes Service (AKS) cluster to store the

backed-up data.
Before you begin

You must have completed the following tasks:

- Created an Azure subscription along with an Owner or Contributor and User-Access Administrator role on the

Azure subscription.

You can create a subscription from Microsoft Azure if you do not have a valid subscription.

« Downloaded the Velero 1.5.3 plugin for Microsoft Azure from the Velero repository.

@ CAUTION: The instructions provided in this procedure are an example of how an AKS cluster can be
configured to use Velero 1.5.3 Microsoft Azure plugin for backing up and restoring the HCL OneTest™
Server data. The procedures to backup and restore the server data might be not valid in all the

scenarios.

« Copied the Velero executable file into one of the directories in the PATH environment variable.

« Installed Azure Command-Line Interface (CLI). For more information, refer to the Azure CLI documentation.

About this task

Velero is one of the tools that is available to back up and restore the server data. You must prepare your AKS cluster
where you installed HCL OneTest™ Server before you back up the data by using Velero.

1. Run the following command to log in to AKS interactively:
az login

Result
The command-line interface opens a browser and displays the Log-in page of AKS.
2. Sign in with your AKS account credentials.

3. Run the following command to set your active subscription:

az account set --subscription <subscription_name>
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You must replace <subscri pti on_name> with the name of your active Azure subscription.

4. Run the following command to set the location of your AKS cluster:

az configure --defaults location=<location_name>

For example, az configure --defaults location=eastus2

0 Tip: You can run the following command to get the list of all the available locations:

az account list-locations --query "[].{DisplayName:displayName, Name:name}" -o table

5. Run the following commands to create a storage account within the AKS cluster for the Velero to store the
backup files:

AZURE_BACKUP_SUBSCRIPTION_NAME=<subscription_name>

AZURE_BACKUP_SUBSCRIPTION_ID=$(az account list
—--query="[?name=="'$AZURE_BACKUP_SUBSCRIPTION_NAME'].id | [0]" -o tsv)

AZURE_BACKUP_RESOURCE_GROUP=Velero_Backups

az group create -n $SAZURE_BACKUP_RESOURCE_GROUP --location <location_name>

AZURE_STORAGE_ACCOUNT_ID="veleroS$(date -u +%s)"
az storage account create \

--name $AZURE_STORAGE_ACCOUNT_ID \
--resource-group $AZURE_BACKUP_RESOURCE_GROUP \
--sku Standard_GRS \

--encryption-services blob \

--https-only true \

--kind BlobStorage \

--access-tier Hot

Note: You must replace <subscri ption_nane>and <l ocat i on_name> with the name of your active Azure

subscription and location of the AKS cluster.

6. Run the following command to create a container within the storage account to store the backup files:

AZURE_BLOB_CONTAINER=velero
az storage container create -n $SAZURE_BLOB_CONTAINER --public-access off --account-name
SAZURE_STORAGE_ACCOUNT_ID

7. Run the following commands to obtain a key of Azure storage account and to create a file that contains all the

relevant environment variables:

AZURE_STORAGE_ACCOUNT_ACCESS_KEY=$(az storage account keys list \
--account—-name S$AZURE_STORAGE_ACCOUNT_ID \
--query "[?keyName == 'keyl'].value" -o tsv)

cat << EOF > ./credentials-velero
AZURE_STORAGE_ACCOUNT_ACCESS_KEY=${AZURE_STORAGE_ACCOUNT_ACCESS_KEY}
AZURE_CLOUD_NAME=AzurePublicCloud

EOF
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Note: There are several ways Velero can authenticate to Azure. This procedure is based on using a
storage account access key. The available values for AZURE_cLouD_NAME in the Storage account access
key method are Azur ePubl i cCl oud, AzureUSGover nnent G oud, Azur eChi nad oud, and
Azur eGer manC oud.

8. Run the following command to install Velero with the restic option by using the Azure storage account key:

velero install \

--provider azure \

--plugins velero/velero-plugin-for-microsoft-azure:v1i.1.0 \

--bucket $AZURE_BLOB_CONTAINER \

--secret-file ./credentials-velero \

--backup-location-config
resourceGroup=$AZURE_BACKUP_RESOURCE_GROUP,storageAccount=$AZURE_STORAGE_ACCOUNT_ID,storageAccou

ntKeyEnvVar=AZURE_STORAGE_ACCOUNT_ACCESS_KEY,subscriptionId=$AZURE_BACKUP_SUBSCRIPTION_ID \

--use-volume-snapshots=false \

--use-restic

Results
You have prepared your cluster to back up the server data.

What to do next
You can back up the server data. See Backing up the server data on Azure Kubernetes Service on page 74

Related information

Velero Documentation
Velero plugin for Microsoft Azure documentation

AKS Documentation

Backing up the server data on Azure Kubernetes Service

You might want to back up the server data to protect against data corruption or malicious attacks. You might also
want to back up the server data when you want to upgrade to a new version of the server software.

Before you begin

You must have completed the following tasks:

« Been assigned the same role that was required to install and uninstall the server software.

« Installed the server software and all of the HCL OneTest™ Server pods are in Runni ng State.
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« Communicated to the users that HCL OneTest™ Server might be unavailable for some time until the process is

complete.

« Prepared your cluster to store the backed-up data by using Velero. See Preparing the Azure Kubernetes

Service cluster to back up the server data on page 72.

About this task
If you plan to back up the data immediately after you prepared your Azure Kubernetes Service (AKS) cluster, then you

must go to Step 3 on page 75 to start the backup process.

1. Run the following command to log in to AKS interactively:
az login

Result
The command-line interface opens a browser and displays the Log-in page of AKS.
2. Sign in with your AKS account credentials.
3. Run the following command to start the backup process of the HCL OneTest™ Server data:

velero backup create <backup_file_name> --include-namespaces=test-system
--default-volumes-to-restic

Note: You must replace <backup_fi | e_name> with the name that you want to provide for the backup file.

0 Tip: You can run the velero backup describe <backup_file_name> —-details command to verify the

progress of the backup operation.
Results
You have backed up the data of HCL OneTest™ Server on AKS.
What to do next

You can restore the server data. See Restoring the server data on Azure Kubernetes Service on page 75.

Related information

Velero Documentation

Restoring the server data on Azure Kubernetes Service

You can restore the server data that is backed up in HCL OneTest™ Server when required.
Before you begin

You must have completed the following tasks:
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- Been assigned the same role that was required to install and uninstall the server software.

« Communicated to the users that HCL OneTest™ Server might be unavailable for some time until the process is

complete.

» Backed up the data from HCL OneTest™ Server.

About this task
If you plan to restore the server data immediately after you backed up the data from HCL OneTest™ Server that you
installed on Azure Kubernetes Service (AKS), then you must go to Step 3 on page 76 to start the restoration

process.

1. Run the following command to log in to AKS interactively:
az login

Result
The command-line interface opens a browser and displays the Log-in page of AKS.
2. Sign in with your AKS account credentials.

3. Run the following command to start the restore process of the HCL OneTest™ Server data:

velero restore create --from-backup=<backup_file_name> --restore-volumes

0 Tip: You can run the velero restore describe <backup_file_name> -details command to verify the

progress of the restore operation.

Note: You must replace <backup_fi | e_name> with the name that you provided during the backing up of
the server data.

Results
You have restored the data of HCL OneTest™ Server on AKS.

Related information

Velero Documentation

Uninstallation of the server software

When you no longer require HCL OneTest™ Server, you can uninstall the server software. You can uninstall the server
software depending on the platform on which you installed the server software.

Uninstalling the server software from Ubuntu

When you want to install a new version of server software or you want to reinstall the server software when an
ongoing installation fails, you can uninstall the server software and its components from the Ubuntu platform.
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Before you begin

You must have completed the following tasks:

« Installed HCL OneTest™ Server software.

« Closed HCL OneTest™ Server, any open web browsers, and all other applications that are enabled by HCL

OneTest™ Server.

« Optional: Backed-up data from the previous version of the product.

1. Log in to the Ubuntu server using an SSH session.
2. Run the following command to stop the workload that is running:

kubectl delete all,cm,secret -lexecution-marker -n test-system
3. Run the following command to uninstall the server software:
helm uninstall {my-ots} -n test-system
The PersistentVolumeClaims and PersistentVolumes that were created during the installation are not deleted

automatically. If you reinstall the server software, the user data is reused unless you specifically delete those

volumes.
4. Run the following commands to delete the entire Kubernetes environment, including all user data:

#Run the following command if you are on Ubuntu 18.04
cd hcl-onetest-base
sudo ./ubuntu-wipe.sh --confirm

#Run the following command if you are on Ubuntu 20.04
cd hcl-onetest-base

sudo HOME=$SHOME ./ubuntu-wipe.sh --confirm

After you run this command, the system returns to the same state as if ubunt u-i ni t . sh was never run.

! Important: If you want to migrate data from a previous version to the latest version of the product,

then you must ensure to back up the data before you run this command.

Results
You have uninstalled the server software from the Ubuntu platform.

Uninstalling the server software from Azure Kubernetes Service

When you want to install a new version of server software or you want to reinstall the server software when an
ongoing installation fails, you can uninstall the server software and its components from the Azure Kubernetes
Service (AKS) cluster.

Before you begin
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You must have completed the following tasks:

« Installed HCL OneTest™ Server software.

* Closed HCL OneTest™ Server, any open web browsers, and all other applications that are enabled by HCL

OneTest™ Server.

« Optional: Backed-up data from the previous version of the product.

1. Run the following command to log in to AKS interactively:
az login

Result
The command-line interface opens a browser and displays the Log-in page of AKS.
2. Sign in with your AKS account credentials.

3. Run the following command to uninstall the server software:

helm uninstall {my-ots} -n test-system

The PersistentVolumeClaims and PersistentVolumes that were created during the installation are not deleted
automatically. If you reinstall the server software, the user data is reused unless you specifically delete those

volumes.

4. Run the following command to delete the resource group from the AKS cluster:

az group delete -g <resource_group>

You must replace <r esour ce_gr oup> with the name of the resource group that you created during the creation
of the AKS cluster.

Results

You have uninstalled the server software from the AKS cluster.

Configuration of the server software

You can find information about the tasks that you must perform after you installed the server software to configure
HCL OneTest™ Server.

The following table describes the tasks that you can perform as an administrator after you installed the server

software:

Require- Tasks More information

ment

User administration on page 79
Required | Review the default user management to know how

the server software manages the users and their

authentication.
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Require- Tasks More information
ment
Certificate authority: Importing and extending lists
Required | Import Certificate Authority (CA) into a browser
on page 91
to prevent certificate errors when you access the
HCL OneTest™ Server Ul.
Copying third-party application Jars to Kubernetes
Optional Copy the third-party application Jars to Kuber-
p py party app on page 94
netes to run API Suites that uses a transport.
Changing the password seed on page 97
Optional Change the password seed to provide enhanced
security to HCL OneTest™ Server.
Disabling server extensions and features on
Optional Disable the server extensions that are enabled
page 100
during the installation of the server software if you
do not want the server extensions to run on the
cluster to save server resources.

User administration

After you install HCL OneTest™ Server, you must consider how the software manages users and authentication.

You can review the default user management provided by the server and decide what additional controls you might

want to add. If you manage users and authentication through an existing LDAP/AD server, you can review how to use

that server to manage HCL OneTest™ Server users.

Default user administration

You installed HCL OneTest™ Server and you want to know about how the software manages user access.

HCL OneTest™ Server uses Keycloak V12.0.4 (https://www.keycloak.org/) to manage and authenticate users.

If you manage and authenticate users by using an LDAP and Active Directory server, you can configure Keycloak to

connect to that server. For more information, see LDAP user administration on page 81.

Keycloak uses the concept of a realm to manage and authenticate users. When you install the server software, a

realm called testserver is created for you in Keycloak. All server users belong to this realm and when they log in to the

server, they log into that realm.

As an administrator, it is important to consider the following points about the server administration:

79


https://www.keycloak.org/

80

HCL OneTest™ Server

- By default, there is no administrator for HCL OneTest™ Server.

Such an administrator is required for accessing additional functions, which includes claiming ownership of
server projects and unarchiving them. But you can assign administrative privileges to any user. You must do
this by adding the admin role to the user in Keycloak.

 You must sign up a user that you want to be the administrator. You must go to the Login page at https: //

<ful I y-qual i fi ed- dns- name>: 443 and sign up.
Note: Do not use that admin user to perform non-administration tasks. Instead, sign up another user.

- After you sign up the user that you want to be the administrator for HCL OneTest™ Server, you must log in to
the Keycloak Admin Console at htt ps: //<ful | y-qual i fi ed- dns- nane>: 443/ aut h/ adni n/ to make that user the

server administrator.

The default user name for the Keycloak administrator is keycl oak. The password is randomly generated when
the software is installed. You can see the password by using the following kubectl command:

kubectl get secret -n test-system {ny-ots}-keycloak-postgresql -o jsonpath="{.data.password}" |
base64 --decode; echo

Note: You must substitute { ny- ot s} with the release name of your choice.

After you log in to the Keycloak Admin Console, from the Users page, you can search and select the user that
you want to make an administrator. From the Groups tab, you can join the user to the Admins group.

For more information about assigning user roles, see Groups in the Keycloak documentation.

Now that you are the server administrator, it is important to consider the following points about the default user

management and authentication:

« Minimum password length defaults to 8 characters

« Email verification of new users is turned off

- The Forgot Password feature is turned on by default but no instructions are sent to the user to reset their
password

« Forgotten user passwords are changed by you if you do not enable Keycloak to send instructions to reset a

password
You can review the following sections about changing the default authentication controls.

Email settings

By default, the testserver realm sets the Forgot Password switch on. However, as an administrator, you must enable
Keycloak to send an email to the user with instructions to reset their password. If you want to verify an email, you
must also enable Keycloak to send an email to the user to verify their email address.
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You must provide SMTP server settings for Keycloak to send an email. After you log in to the Keycloak Admin

Console, see Email Settings in the Keycloak documentation.
Then, to set up the email verification, see Forgot Password in the Keycloak documentation.

Password policy

By default, the testserver realm has a password policy where the minimum length of a password is 8. As an

administrator, you can update password policies in Keycloak.

After you log in to the Keycloak Admin Console, see Password Policies in the Keycloak documentation.

User password

If you did not enable Keycloak to send instructions to a user about how to reset a password, you must use the
Keycloak Admin Console to change their password for them.

After you log in to the Keycloak Admin Console, see User Credentials in the Keycloak documentation.
User deletion

When a user is inactive or no longer needs to access the server, you can delete that user.

After you log in to the Keycloak Admin Console, see Deleting Users in the Keycloak documentation.

LDAP user administration

After you installed HCL OneTest™ Server, you can use a Lightweight Directory Access Protocol and Active Directory
HTTP server to manage users and authentication. Some of the following best practices, can help you to use an LDAP/

AD server to manage user access to HCL OneTest™ Server.

HCL OneTest™ Server uses Keycloak V12.0.4 (https://www.keycloak.org/) to manage and authenticate users.

Existing user databases hold user credentials. Keycloak federates these existing external user databases through the
concept of storage providers. By default, Keycloak supports an LDAP and Active Directory storage provider. By adding

a storage provider, you can map LDAP user attributes into Keycloak. You can also configure more mappings.

Before you configure Keycloak to use an existing LDAP/AD provider, you might consider the following best practices:

+ Set up your LDAP/AD provider as a read-only repository so that HCL OneTest™ Server cannot change it.
» Add and remove users in LDAP/AD and not the Keycloak local user database.
« Import and synchronize your LDAP/AD users to your Keycloak local database.
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- Map a login style name, for example, user 1@er ver . com by using the User Pri nci pal Nane attribute in LDAP/
AD to a user nane in Keycloak. If you want the full name of the user as your login style, use the cn attribute in
LDAP/AD.

Note: The LDAP/AD user name attribute must match the LDAP/AD provider user name attribute
(Username LDAP attribute) in Keycloak for the LDAP/AD provider to connect with Keycloak.

The following sections use these best practices to guide you to set up Keycloak to connect to your LDAP/AD HTTP

server.
LDAP provider selection in Keycloak
You can use the Keycloak Admin Console to add an LDAP/AD provider.

You can log in to the Keycloak Admin Console at htt ps: // <ful | y-qual i fi ed- dns- nams/ aut h/ adni n. The default user
name for the Keycloak administrator is keycl oak. The password is randomly generated when you installed the HCL

OneTest™ Server software. You can see the password by using the following kubectl command:

kubectl get secret -n test-system {ny-ots}-keycloak-postgresql -o jsonpath="{.data.password}" | base64
--decode; echo

Note: You must substitute { ny- ot s} with the release name of your choice.

After you log in, you can go to the User Federation page to add your provider.
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MAKEYCLO

Testserver User Federation

Realm Settings

Clients

Client Scopes

Roles User Federation

Identity Providers Keycloak can federate external user databases. Out of the box we have

support for LDAP and Active Directory.
User Federation
To get started select a provider from the dropdown below:

Add provider...
kerberos
Idap k

Authentication

Groups

Users

You want to select the provider named Idap from the list. From the Add user federation provider page, you can use a
form to complete your LDAP/AD connection parameters.

Required settings for a successful connection to your LDAP/AD provider

The form includes many fields and several fields include default values. Tables describe the important fields that you

must complete to ensure a successful HTTP connection to your LDAP/AD provider.
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Required Settings

Enabled &

Console Display

Test Server LDAP/AD Provider

Name @
Priority € 0
Import Users & m
Edit Mode @ READ_OMNLY v
Sync OFF
Registrations @&
* Vendor © Active Directory i
Field Description

Console Display Name

You want to make your console name recognizable, for example, Test Server LDAP/AD

Provider. This name is shown in the Keycloak Admin Console.

Priority The priority must be set to 0 so that when a user logs in to HCL OneTest™ Server, Key-
cloak looks up the user first in the list of users managed in the LDAP/AD user database.
If the user is not found in your LDAP/AD user database, Keycloak then looks up the user
in the local Keycloak user database.

Import Users You want to leave import users ON so that users in your LDAP/AD user database are syn-

chronized (imported) automatically into the Keycloak local user database. The import us-

es the settings that you are defining now.

After the initial import, when you add a user to your LDAP/AD user database and that
user logs in to HCL OneTest™ Server, the LDAP/AD provider imports the LDAP/AD user
into the Keycloak user database and authenticates the user against the LDAP/AD pass-

word.

Similarly, after the initial import, when you remove a user from your LDAP/AD user data-

base that user cannot log in to HCL OneTest™ Server.
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Field Description
Note: For consistent user management, continue to manage users in your LDAP/
AD user database.

Edit Mode Make sure that edit mode is set to READ_ONLY.
This setting means that your LDAP/AD user database is read-only. No user data defined
through the mapping of attributes in Keycloak such as the user nane is written back from
the Keycloak user database to your LDAP/AD user database.
This read-only setting also means that a new user cannot sign up from HCL OneTest™
Server as no user data can be written to your LDAP/AD user database.

Vendor You want to select Active Directory from the list of vendors. Many fields complete with
default values based on this selection.

* Username userPrincipalName

LDAP attribute ©

* RDN LDAP
attribute ©

* UUID LDAP
attribute &

* User Object
Classes @

* Connection URL

* Users DN @

Custom User
LDAP Filter &

Search Scope @
* Bind Type @
*Bind DN @

* Bind Credential

cn
objectGUID

User

|dap://10. A2

cn=Users,dc=0neTest,dc=COM

(memberOf=cn=Testers,dc=0neTest,dc=COM)

One Level v

simple v

ServerAdmin

@ Test authentication
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Field

Description

Username LDAP attribute

You can use the default value cn for the user nane, which is a first name, last name, or you

can use user Pri nci pal Nane, which is username@domain.

You might want a login that matches your company style. For example, you might prefer
joetester@mycompany.com instead of Joe Tester.

If you do make this change the user nane that you specify now must match the user nane

in the Mapper. Keycloak makes this change for you.

User Object Classes

Because LDAP user records are found based on a user object class, you must set the

User Object Classes to User .

Connection URL

So that Keycloak can connect to your LDAP/AD user database, you must enter your
LDAP/AD URL, for example, | dap: / / <host nane>. <domai n>

Make sure that you test the connection and confirm that the connection is successful.

Users DN

You must provide the directory where the LDAP users are listed, for example, cn=User -
s, dc=OneTest , dc=COM

Custom User LDAP Filter

You can filter your LDAP/AD users to import a subset of all your LDAP users.

For example, you can set up a RTAS user group for your LDAP/AD user database such
that only those users are imported to Keycloak.

(memberOf=cn=Testers,dc=OneTest,dc=COM)

Bind DN

Bind Credential

You must also provide the LDAP/AD user database administrator user ID for BIND DN
and password for the BIND Credential. These credentials are used by Keycloak to ac-
cess the LDAP/AD user database.

Make sure that you test the authentication and confirm that the authentication is suc-
cessful.

You can save the settings, which create your LDAP/AD provider.

Mappers

Keycloak uses mappers to map the user attributes defined in the Keycloak user model such as username and email

to the corresponding user attributes in the LDAP/AD user database. By default, when you saved your settings and

created your LDAP/AD provider, the following mappers were created.
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Test Server LDAP/AD Provider &

Settings Mappers

Search.. Q

Name Type

email user-attribute-ldap-mapper
creation date user-attribute-ldap-mapper

MSAD account controls msad-user-account-control-mapper
username user-attribute-ldap-mapper

last name user-attribute-ldap-mapper

modify date user-attribute-ldap-mapper

full name full-name-ldap-mapper

The username attribute that you specified in the Username LDAP attribute must match the username t attribute
defined in the Keycloak mapper for the LDAP/AD user database to connect with Keycloak.

Because you changed the Username LDAP attribute from the default value cn to user Pri nci pal Nare, Keycloak made

the same change in the mapper called username to match.
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Username &

D
e5c30485- 08624430 81dc-eb12383d2de3

Mame * &

Username

Mapper Type @

user-attribute-ldap-mapper

User Model Attribute &

username

LDAP Attribute @

userPrincipalName

Read Only &

o [l

Always Read Value From LDAP @

OFF

Is Mandatory In LDAP &

o [l

Is Binary Attribute @
|\| OFF

Save || Cancel

User synchronization

You must import all users from your LDAP/AD user database by using the option to Synchronize all users. Users are
imported based on your saved settings when you set up your LDAP/AD provider.

CEVRIR LTI Synchronize changed users | Synchronize all users

A successful import is followed by a success message with the number of users imported.
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You can view all the LDAP/AD database users that were imported and authenticated from the Users page in the

Keycloak Admin Console.

@AKEYCLC
Users
Lookup Permissions
Realm Settings
5 Q

Clients
Client Scopes D Username Email

2cfffo... build.ver... build....
Roles

36c7d... rituseri...
Identity Providers Qaf67.. I

User Federation

Authentication

Groups

Users

View all users

Last

Name
verific..
Useri...

LastM...

First

MName

build

RITUs...
RITUs...

& Keycloak ~

Unlock users || Add user

Actions

Edit | Impersonate
Edit | Impersonate
Edit | Impersonate

Delete
Delete

Delete

Users are listed with ID, Username, Email, Last Name, and First Name. The ID is generated by Keycloak. The value of

the other attributes is fetched from the LDAP/AD user database by using mappers.

! Important: If you get a message of a failed import for an LDAP/AD user, then the failed import might be due

to any one of the following reasons:

« The User logon name field under the Account tab of that LDAP/AD user is blank.
» The value of the Custom User LDAP Filter field to import only a subset of all LDAP users does not

match with the LDAP set of users.

You can check the log file of the Keycloak pod to understand the reason for the failed import.

You can perform the following steps to view the log file of the Keycloak pod:

1. Run the following command to view the list of all pods:

kubect| get pods -n test-system

2. Identify the Keycloak pod ssocl oak- 0.

3. Run the following command to view the log of the Keycloak pod:
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kubect!| 1ogs {ny-ots}-ssocloak-0 -n test-system

Note: Where, {my-ots} is the name of the release that is provided during the installation of the

server software.

The log file of the Keycloak pod is displayed.

A sample of a log file is as follows:

12:49:00,535 ERROR [org.keycloak.storage.ldap.LDAPStorageProviderFactory] (default task-40)
Failed during import user from LDAP: org.keycloak.models.ModelException: User returned from LDAP
has null username!

Check configuration of your LDAP mappings.

Mapped username LDAP attribute: userPrincipalName, user DN:
CN=DefaultAccount,CN=Users,DC=ONETEST,DC=COM,

attributes from LDAP: {whenChanged=[20190527143130.0Z], whenCreated=[20190527143130.0Z],
cn=[DefaultAccount],

userAccountControl=[66082], pwdLastSet=[0]}

Managing account settings

You might want to change your password or other settings for your account.
About this task

As an account owner, you can view your account settings, which include your user name, email, and first and last
name. You can also change all of these settings except the user name. Changing your password is also possible from

your account settings.

Note: Account settings cannot be changed if HCL OneTest™ Server was configured to use an LDAP/AD

provider. For more information about server security, see the related links.

- Edit your account details by following these steps:

o
1. Click the User icon ' from the menu bar, and select Account Settings.
The Edit account page is displayed.

2. Edit your user details and save the changes. You can also reset your changes. If you cancel your

changes, you return to the Home page.

- Change your password by following these steps:

oy
1. Click the User icon '/ from the menu bar, and select Account Settings.

The Edit account page is displayed.
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2. Click Change password.
The Change password page is displayed.
3. Type your current password followed by your new password

4. Confirm the new password by typing it again and save the changes. You can also reset your changes.
If you cancel your changes, you return to the Home page.

Related information

Default user administration on page 79

Certificate authority: Importing and extending lists

When you want browsers and other applications to access HCL OneTest™ Server, you must enable browsers to trust
the certificate authority (CA) of HCL OneTest™ Server. For some applications that integrate with HCL OneTest™
Server, you must also extend the CA lists that are trusted by the applications.

You can find the following tasks to import the certificate authority in the browser that you want to use:

« Importing Certificate Authority into the Google Chrome browser on page 91
« Importing Certificate Authority into the Microsoft Edge browser on page 92

« Importing Certificate Authority into the Mozilla Firefox browser on page 93
You can find the following tasks when you want to extend the CA lists:

 Extending the trusted CA list on Linux on page 93
« Extending the trusted CA list on Windows systems on page 94

Importing Certificate Authority into the Google Chrome browser

You must import certificate authority into the Google Chrome browser to prevent certificate errors when accessing
the HCL OneTest™ Server Ul.

Before you begin

You must have completed the following tasks:

« Saved a certificate authority (CA) during the installation of HCL OneTest™ Server.

You can run the following command to get the certificate from the system:

kubectl get secret ingress -n test-system -o jsonpath={.data.ca\\.crt} | base64 -d
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n Remember: test-system is the name of the namespace. If you created a namespace by using a

different value, then you must use that value in place of the test-system.

« Installed the browser that you want to use to access HCL OneTest™ Server.

. Open a Google Chrome browser.

. Navigate to Customize and control Google Chrome > Settings.

. Click Security from the Privacy and security pane.

. Click Manage certificates, and then Import.

. Click Next in the Certificate Import Wizard window.

. Click Browse and select the CA that you want to import, and then click Next.

. Select the Place all certificates in the following store option to store the CA securely.
. Click Browse, and then select Trust Root Certification Authorities as certificate store.
. Click OK, and then Finish.
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Results
You have imported the CA into the Google Chrome browser.

Importing Certificate Authority into the Microsoft Edge browser

You must import Certificate Authority (CA) into the Microsoft Edge browser to prevent certificate errors when
accessing the HCL OneTest™ Server Ul.

Before you begin

You must have completed the following tasks:

« Saved a certificate authority (CA) during the installation of HCL OneTest™ Server.

You can run the following command to get the certificate from the system:

kubectl get secret ingress -n test-system -o jsonpath={.data.ca\\.crt} | base64 -d

n Remember: test-system is the name of the namespace. If you created a namespace by using a

different value, then you must use that value in place of the test-system.

* Installed the browser that you want to use to access HCL OneTest™ Server.

1. Type certnyr. nsc in the Start menu Search filed, and then press Enter.

2. Expand Trusted Root Certification Authorities, and then select Certificate.

3. Right-click on the empty space, and then select All tasks > Import.

4. Click Next in the Certificate Import Wizard window.

5. Click Browse and select the CA that you want to import, and then click Next.

6. Select the Place all certificates in the following store option to store the CA securely.
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7. Click Browse, and then select Trust Root Certification Authorities as certificate store.

8. Click Next, and then Finish to import the certificate.

Results

You have imported the CA into the Microsoft Edge browser.

Importing Certificate Authority into the Mozilla Firefox browser
You must import Certificate Authority (CA) into the Mozilla Firefox browser to prevent certificate errors when
accessing the HCL OneTest™ Server Ul.

Before you begin

You must have completed the following tasks:

« Saved a certificate authority (CA) during the installation of HCL OneTest™ Server.

You can run the following command to get the certificate from the system:

kubectl get secret ingress -n test-system -o jsonpath={.data.ca\\.crt} | base64 -d

n Remember: test-system is the name of the namespace. If you created a namespace by using a

different value, then you must use that value in place of the test-system.

* Installed the browser that you want to use to access HCL OneTest™ Server.

. Open a Mozilla Firefox browser.

. Enter “about : pref erences#privacy” in the address bar, and then press Enter.

. Locate and click the View Certificates option.

. Select Authorities tab, and then click Import.

. Select the CA that you want to import, and then click Open.

. Select Trust this CA to identify websites in the Downloading Certificate window.

. Click OK to import the CA into the browser, and then close the window.

0 N o oA WON =

. Restart Firefox.

Results
You have imported the CA into the Mozilla Firefox browser.

Extending the trusted CA list on Linux

HCL OneTest™ Server trusts the certificates signed by a recognized Certified Authority (CA). When you have any
additional CAs, you must extend the trusted certificates list by using an environment variable on Linux.

Before you begin

You must have saved the CA assigned to HCL OneTest™ Server.
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Note: You can contact the administrator of HCL OneTest™ Server if you do not have a copy of the CA.

1. Open the terminal.

2. Run the following command to create an environment variable on the Linux operating system:

export NODE_EXTRA_CA_CERTS= {path of the downloaded CA with the file extension}

For example,

export NODE_EXTRA_CA_CERTS=/opt/mycert/ca-master.crt

Results

You have extended the trusted CA certificates list on Linux.

Extending the trusted CA list on Windows systems
HCL OneTest™ Server trusts the certificates signed by a recognized Certified Authority (CA). When you have any
additional CAs, you must extend the trusted certificates list by using an environment variable on Windows systems.

Before you begin

You must have saved the CA assigned to HCL OneTest™ Server.

Note: You can contact the administrator of HCL OneTest™ Server if you do not have a copy of the CA.

. Right-click the Windows icon EH from the windows taskbar, and then click System.
. Click Advanced system settings from the Related setting section.

. Click the Advanced tab, and then click Environment Variables.

. Click New from the System variables section.

. Enter NODE_EXTRA_CA CERTS in the Variable name field.
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. Enter the path of the downloaded CA with the file extension in the Variable value field.

For example, if you stored the ca-master.crt CAinthe C:\ User s\ Deskt op\ cert location, then enter the

Variable value field as ¢\ User s\ Deskt op\cert\ca-naster.crt

7. Click OK.

Results

You have extended the trusted CA certificates list on Windows systems.

Copying third-party application Jars to Kubernetes

You can run API Suites in a project on HCL OneTest™ Server. If the API Suite uses a transport and the transport
requires third-party application Jar files for a successful run, you must ensure that the third-party application Jar
files are available at the test run time. To achieve this, you must copy the third-party application Jar files to the
computer where HCL OneTest™ Server is installed on Kubernetes.
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Before you begin

If you want to copy the third-party application Jar files to the remote Docker host, see Copying third-party application

Jars to a remote Docker host on page 282.
You must have server administrator or cluster administrator privileges.

You must have completed the following tasks:

« Identified the third-party application Jar files that are required and copied the files. See Test run
considerations for API Suites or API tests on page 259.
- Copied the third-party application Jar files from HCL OneTest™ API to the directory or folder in Kubernetes

from where you can run the kubectl commands.

About this task

You can copy the third-party application Jar files to the folder that is specific for the application under the / dat a/

<appl i cat i on_nane> folder. You need not extract the files.

You can perform this task any time after you have installed HCL OneTest™ Server and you plan to run an API Suite

that meets any of the following conditions:

« The API Suite uses transports and the transports require third-party application Jar files to be available at the
test run time.

» The API Suite in the project has a results database configured.

You can copy the JDK version Jar files that you have used to create the JUnit tests.

You can get help on the kubectl commands by running the command: kubectl cp —-help from the / kube directory. For

more information, refer to the kubectl documentation.

1. Use the following table to find the name of the folder that corresponds to the specific third-party application
for the transport used in the API Suite.

Table 2. Name of the folder for the application

Application Name of the folder to use
Camel Camel
CentraSite CentraSite
CICcs CICcs
Coherence Coherence
Database JDBC
IMS IMS
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Application Name of the folder to use
Integra Integra
JMS JMS
SAP RFC SAP
Software AG Universal Messaging SoftwareAGUM
TIBCO EMS TIBCO
TIBCO Rendezvous
TIBCO SmartSockets
WebSphere Application Server Service Integration WAS
Bus (SiBus)
WebLogic WebLogicJMX
Software AG webMethods webMethods

2. Open the command prompt from the / kube directory and copy the Jar files to the folder that corresponds to

the application by using the following command:

kubectl cp <compressed_files> test-system/{ny-ots}-userlibs-0:/data/<application_name>/

For example, if you are copying the Database Jar files, then the name of the folder is JDBC and the command

to use is:

kubectl cp mysql-connector-java.jar test-system/{ny-ots}-userlibs-0:/data/JDBC/

Note: You must substitute { ny- ot s} with the release name of your choice.

3. Verify whether the Jar files are copied by running the following command:

kubectl exec {ny-ots}-userlibs-0 -n test-system -- 1ls /data/<folder_created>

For example, if you copied the Database Jar files, mysgl - connect or -j ava. j ar to the folder JDBC, then

the command to verify is:

kubectl exec {ny-ots}-userlibs-0 -n test-system -- 1ls /data/JDBC

The following information is displayed for the JDBC folder:

|mysql—connector—java.jar

Note: You must substitute { ny- ot s} with the release name of your choice.

Results
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You have successfully copied the third-party application Jar files to the folder in Kubernetes.
What to do next
You can configure the API Suite run. See Configuring an API Suite or an API test run on page 323.

Changing the password seed

As an administrator, you can change the password seed that is used when you install the server software to provide
enhanced security to HCL OneTest™ Server.

Before you begin

You must have completed the following tasks:

« Installed HCL OneTest™ Server. See Installation of the server software on page 36.

* Installed the JSON command-line tool, jq, and ensured that the jq is in your environment PATH. For

information about jq, refer to jg documentation.

« Installed the Curl command line tool. For more information refer to curl documentation.

About this task

When you install HCL OneTest™ Server, you supply a password seed when you run the hel m i nstal I command.
This password seed is used to generate several Kubernetes secrets. Kubernetes Secrets can contain the following
information:

» The authentication credentials for micro-services.

« An encryption key for the user-created secrets collection or other secrets.
When you change the password seed for HCL OneTest™ Server, you must consider the following scenarios:

« HCL OneTest™ Server cannot communicate until you reconcile the passwords which are in Kubernetes Secrets
by using the old and a new password seed.

« Users cannot read secret collections or other secrets that they have created in HCL OneTest™ Server until you
re-encrypt them using a new password seed.

! Important: You must provide an offline token and old password seed that you used during the

installation of server software to re-encrypt user secrets.

1. Run the following command to change the password seed for HCL OneTest™ Server:

helm upgrade {my-ots} ./hcl-onetest-server -n test-system \
--reuse-values \
--set global.hclOneTestPasswordAutoGenSeed= {my-new-super-secret}
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Notes: You must substitute the value of the following variables with the actual value in the command:
o {ny- ot s} with the release name that you used during the installation of the server software.
° {ny- new super - secr et } With a new value of your choice as the password seed.

> You must run the following hel m upgr ade command from the same directory where the hel m
i nstal | command was run during the installation of the server software. Because the upgrade
is dependent on the helm charts and .yaml file values used during the run time of the hel m

instal | command.

2. Run the following script to generate new server secrets from the updated password seed and to save them to

the persistent storage:
./hcl-onetest-server/files/reconcile-secrets.sh -n test-system {my-ots}
3. Run the following command to restart all the pods:

kubectl delete pods -n test-system \
-lapp.kubernetes.io/instance={my-ots} \
—-lapp.kubernetes.io/managed-by=Helm

4. Run the following commands to re-encrypt the user-created secrets collection or other secrets by providing

the old password seed:

export ACCESS_TOKEN=$(curl -k -X POST {SERVER_URL}/rest/tokens/ \
-H "Content-Type: application/x-www-form-urlencoded" \

-H "accept: application/json" \

-d "refresh_token={OFFLINE_TOKEN}" | jq -r '.access_token')

curl -k -X POST {SERVER_URL}/rest/secrets/re-encrypt/ \
-H "Authorization: Bearer $ACCESS_TOKEN" \
-H "Content-Type: application/json" \
-d "{\"type\":\"helm\",\"password_auto_gen_seed\":\"{OLD_SEED}\"}"

Note: You must substitute the value of the following variables with the actual value in the following

commands:
° { SERVER_URL} with the URL of your HCL OneTest™ Server Ul.
o { OFFLI NE_TOKEN} with the offline token that belongs to a user with the administrator role.

o {OLD_SEED} with the previous password seed that you used during the installation of the server
software.

5. Run the following command to display the log file of the gateway pod:

kubectl logs {my-ots}-gateway-abcdefghij-abcde -n test-system

Note: You must substitute the value of the following variables with the actual value in the command:
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o {ny-ot s} with the release name that you used during the installation of the server software.
o abcdef ghi j - abcde with an identifier that is assigned to the name of the gateway pod.

You can run the kubect| get pods -n test-systemcommand to obtain the identifier that is
assigned to the gateway pod.

Result

The following message is displayed when re-encryption is completed:

reEncrypt conplete. StringyReEncryptor [total =100, fixed=100, broken=0, noop=0]

Results

You have successfully changed the password seed for HCL OneTest™ Server.

Server extensions and features

You can run specific tests in HCL OneTest™ Server by enabling the server extensions. You can also author or edit test

assets if test authoring feature is enabled.

The server extensions are enabled at the time of installation of the server software. When the server extensions are

enabled, you can perform the following tasks on HCL OneTest™ Server:

« Add repositories that contain the test assets for the Postman collections, JMeter tests, or JUnit tests.
- Configure a test run for the following test types:

o JMeter

> JUnit

o Postman

The test authoring feature provides you to author or edit test assets in HCL OneTest™ Server. Depending on the

platform you used to install the server software, the default status of the feature can be enabled or disabled.

The default status of the test authoring feature is disabled when you install the server software on Ubuntu (by using
k3s). However, the test authoring feature is enabled when you install the server software on Azure Kubernetes Service
(AKS).

After you install the server software, you can enable or disable the test authoring feature based on your requirements.

To learn more about enabling and disabling the server extensions and test authoring feature, refer to the following

topics:
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Disabling server extensions and features

When you do not want the server extensions to run on the cluster to save server resources or when you no longer

want to use the test authoring feature, you can disable them.
Before you begin

You must have ensured that the server extension or the test authoring feature that you want to disable is enabled and

running.

Note: You can verify the status by running the kubectl get pods -n test-system command. The status of an

enabled server extension is displayed as Runni ng.

About this task
You must substitute { ny- ot s} with the release name that you provided during the installation of the server software in

the following procedure.

1. Log in to the Ubuntu server using an SSH session.
2. Run the following command to disable the test authoring feature:

helm upgrade {my-ots} -n test-system ./hcl-onetest-server \
--reuse-values \
--set global.hclOneTestAuthorEnabled=false

3. Run the following command to disable all the extensions:

helm upgrade {my-ots} -n test-system ./hcl-onetest-server \
--reuse-values \

--set global.hclOneTestPostmanEnabled=false \

--set global.hclOneTestIMeterEnabled=false \

--set global.hclOneTestJUnitEnabled=false

If you want to disable any specific extension, then you can set the respective helm parameter value to false.
For example, to disable the JMeter extension alone, then you can run the following command:

helm upgrade {my-ots} -n test-system ./hcl-onetest-server \
--reuse-values \
--set global.hclOneTestIMeterEnabled=false

4. Run the following command to verify the status of the extensions or the test authoring feature:

kubectl get pods -n test-system

Note: The pod for each server extension that you disabled no longer displays.

Results
You have disabled the test authoring feature or required server extensions on HCL OneTest™ Server.
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Enabling server extensions and features

If you find that the server extension or test authoring feature is disabled and you want to run the tests supported by

the server extension or you want to edit test assets, then you must enable them.

About this task
You must substitute { ny- ot s} with the release name that you provided during the installation of the server software in

the following procedure.

1. Log in to the Ubuntu server using an SSH session.

2. Run the following command to enable the test authoring feature:

helm upgrade {my-ots} -n test-system ./hcl-onetest-server \
--reuse-values \
--set global.hclOneTestAuthorEnabled=true

3. Run the following command to enable all the extensions:

helm upgrade {my-ots} -n test-system ./hcl-onetest-server \
--reuse-values \

--set global.hclOneTestPostmanEnabled=true \

--set global.hclOneTestIMeterEnabled=true \

--set global.hclOneTestJUnitEnabled=true

If you want to enable any specific extension, then you can set the respective helm parameter value to true. For
example, to enable the Postman extension alone, then you can run the following command:

helm upgrade {my-ots} -n test-system ./hcl-onetest-server \
--reuse-values \
--set global.hclOneTestPostmanEnabled=true

4. Run the following command to verify that specific or all the extensions are enabled:
kubectl get pods -n test-system

Result
The status of the specific extension or all the extensions in the pod is displayed as Runni ng.

Results
You have enabled the test authoring feature or required server extensions on HCL OneTest™ Server.

Related information

Test authoring on page 121
Configuring a run of a JMeter test on page 386
Configuring a run of a JUnit test on page 392

Configuring a run of a Postman test on page 399
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Team space administration

You can find information about team spaces including the initial team space on HCL OneTest™ Server along with the
tasks that you can perform to administer a team space.

You can find the following information about team spaces:

» Team space overview on page 102

« Creating a team space on page 105

« Tasks in a team space on page 107

« Tasks in projects in a team space on page 110

« Management of licenses in HCL OneTest Server on page 113

 Configuring an SMTP server to manage email notifications on page 704

Team space overview

Team spaces are logical partitions of HCL OneTest™ Server. Team space is an exclusive, separate, and secure space

on HCL OneTest™ Server that enables you to share a single installation among multiple teams.

You can find the following information about team spaces:

« Initial team space on page 102
» Team spaces on page 103

« Migration from earlier releases of HCL OneTest Server on page 104

Initial team space
After you install HCL OneTest™ Server and log in for the first time, you enter the Initial team Space.
The initial team space is the default logical partition that is created on an instance of HCL OneTest™ Server.

As a server administrator, you must consider the following points:

« After you install HCL OneTest™ Server and log in for the first time, the Projects page of the initial team space
is displayed.

- You must configure the license server for the initial team space.

« Add or remove users in the team space and assign them different roles in a team space.

« You can assign the role of a Team Space Owner to any other member in the initial team space.

» Change the type of the initial team space from the default type of permissive.

The following table describes the type that you can assign to a team space:

Type Description

Permissive Specifies that any licensed user of HCL OneTest™ Server can access a team space

and get assigned the default roles of a Project Owner and Member in the team

space.
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Type Description

Restrictive Specifies that all licensed users of HCL OneTest™ Server must request for access to
a team space and must be provided access and assigned roles by the Team Space

Owner.

The Restrictive type of team space can be either Public or Private. A Public team
space is visible in the team spaces dashboard, while a Private team space is not
visible in the team spaces dashboard.

« You can evaluate the requirement and create team spaces other than the initial team space.
As a licensed user, you must consider the following points:

« When you log in for the first time immediately after the installation of HCL OneTest™ Server, the Projects page
of the initial team space is displayed.

- After you log in to the initial team space, you are assigned the default roles of Project Creator and Member of
the initial team space.

« On subsequent logins, the My Projects page in the initial team space is displayed as the default page.

Team spaces

You can either work with the initial team space or you can create multiple team spaces on HCL OneTest™ Server. The

team space facilitates users of the same team space to work together.

Apart from being a container for projects, a team space facilitates the registration of remote Docker hosts and

Resource Monitoring agents, designing the system model, and viewing the registered agents, Dockers, or intercepts.

After you create a team space as a server administrator, you must consider the following actions:

Note: You are assigned the default role of a Team Space Owner for team spaces that you create.

- Add users in the team space and assign them different roles in a team space.
« Assign the role of a Team Space Owner to other team space members, if you want other members to own the

team space.

Note: As a Team Space Owner, you can remove any member of your team space from the assigned
role. The member who is removed from a team space, can send a request and become a member of

that team space after the request is accepted.

« If the Team Space Owner is no longer a member of a team space, then you as the server administrator can
access that team space with the default role of a Team Space Owner. You can then assign the role of a Team

Space Owner to any other member.
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- Delete the initial team space or any other team space that you created, if required.

Note: If you delete the initial team space, the users of the initial team space are redirected to the Team

Space Dashboard page.

You as a server administrator or the Team Space Owner must perform the following tasks in a team space before

other members can start using the team space:

« Configure the license server.
- Configure the team space type as either Restrictive or Permissive.
- Configure the SMTP server and add members who can receive notifications about the operations performed

in the team space.
As a member of a team space, you must consider the following points:

» When you log in for the first time immediately after the installation of HCL OneTest™ Server, the Projects page
of the team space is displayed.

- After you log in to the team space, you are assigned the default roles of a Project Creator, and Member of the
team space.

- You can request to become a member of any other team space. After your request is approved, you are
assigned the default role of a Member of that team space.

* You can become a member of either a Permissive or Restrictive type of team space.

- On subsequent logins, the Team Space Dashboard page is displayed as the default page.

Migration from earlier releases of HCL OneTest™ Server

The initial team space is the only logical partition in HCL OneTest™ Server 10.1.3. If you migrate from an earlier
release of HCL OneTest™ Server to 10.2 or later, then all the assets and resources that you created and associated
with the initial team space are migrated to associate with the initial team space in HCL OneTest™ Server 10.2 or later.

Note:

The results of migration are as follows:

« All projects are contained in the initial team space.

« If you created a repository in a team space, then you can find the repository in the initial team space in 10.2.

« All Dockers, agents, and intercepts that you registered with the server are then registered with the initial team
space and you can view from the Agents and Intercepts page of the initial team space.

- If you configured a resource monitoring agent in any project, then the details of the configured agent are
available in the project.

* You can find the details of SMTP configuration on the server. Only you as a server administrator can view the

details of SMTP configuration.
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- The license server that is configured for the server for earlier release of HCL OneTest™ Server is then
configured for the initial team space.

« All users are assigned the role of a Project Creator and Architect of the initial team space.

« All users with server administrator roles are assigned the default role of a Team Space Owner of the initial

team space.

Notes:

o All users of earlier releases are migrated to HCL OneTest™ Server 10.2 or later. You can view
the list of all migrated users in the application only when they log into the application at least
once.

o After you migrate the server data from a previous version to a newer version, the Project
Owner must log in to HCL OneTest™ Server so that other members of the project can access

the test assets in that project.

Related information

Team space administration on page 102

Default user administration on page 79

Creating a team space

To manage projects in the logical containers of HCL OneTest™ Server, you must create team spaces.
Before you begin

You must have been assigned the role of a server administrator of HCL OneTest™ Server.

About this task

As a server administrator, you can create multiple team spaces on HCL OneTest™ Server.

1. Log in to HCL OneTest™ Server.
Result
The Projects page of the initial team space is displayed.

2. Click the Settings icon from the left navigation pane, and then click Create team space.
Result
The New Team Space dialog box is displayed.
3. Provide a name to the team space.
Result
The URL alias field is automatically filled.
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Note: If you modify the name of a team space, the URL alias is also modified automatically.
4. Optional: Modify the URL alias for the team space, if required.
Note: You must enter the URL alias that starts with a letter.

5. Select an option to set the permissions to access the team space. You can select any one of the following
options:
- Permissive — When a team space is set as Permissive, the new user gets the permissions
automatically on sending the request to become a member of that team space.
- Restrictive — When a team space is set as Restrictive, the Team Space Owner provides permission to

the new user who becomes a member of that team space.

You can set the visibility mode of the Restrictive type team space as Public or Private.
= The Public team space is visible to all users in the Team Space Dashboard.
= The Private team space is visible only to the members of that team space in the Team Space
Dashboard.

Note: If you select the Restrictive type team space, then the default setting of the team space
becomes Public.

6. Provide a brief description of the team space.
7. Select the owner of the team space from the list of users who accessed the application.

The selected user is assigned the role of a Team Space Owner.
Note: You can assign the Team Space Owner role to only one user when you create a team space.

8. Click Create.
Result
The dashboard of the team space is displayed.

Results

You have created a team space.

If you are assigned the role of a Team Space Owner, then you can view the name of the team space that you created

in the navigation pane.

If you assigned any other licensed user with the role of a Team Space Owner, then you can view the team space under

the Other Team Spaces panel.

What to do next
You must configure the license for your team space. See Configuring licenses for team spaces on page 115.
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You can find information about the tasks that you can perform as a Member, Project Owner, Architect, or Team Space

Owner in a team space on HCL OneTest™ Server.

The roles assigned in a team space for users are as follows:

Initial team space

Any team space

Persona
Role

Notes

Role

Notes

Server ad-

ministrator er

Team Space Own-

Default role assigned

Team Space Own-

er

Default role assigned

Space Owner

Licensed Team Space Own- | Role assigned by Server ad- | Team Space Own- | Role assigned by Server ad-
user er ministrator er ministrator
Architect Role assigned by Team Architect Role assigned by Team

Space Owner

Project Creator

Default role assigned

Project Creator

- Default role assigned
in a Permissive team

space.
* Role assigned by
Team Space Owner

in a Restrictive team

space.

Member

Default role assigned

Member

Default role assigned in ei-
ther a Permissive or Restric-

tive team space.

The following table shows the tasks that can be performed by licensed users with their assigned roles in a team

space:
Team Space . Project
Tasks Architect Member
Owner Creator
Configuring licenses v
Configuring a Simple Mail Transfer Protocol v
(SMTP) server to send email notifications.
Changing the license server configuration v
Adding members in a team space v
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Team Space . Project
Tasks Architect Member
Owner Creator
Assigning different roles to other team space v
members
Modifying configuration details of a team space v
Deleting a team space v
Renaming a team space v
Adding or removing the team space repository v v
from a team space
Designing a system model v v
Creating projects in a team space v v
Adding, removing, or modifying remote Docker v v v v
hosts
Adding agents 4 W v 4
Adding, modifying, or removing resource moni- v
toring sources
Connecting resource monitoring agents v
Adding resource monitoring labels v
Working with projects in a team space v v v v

The following table provides the links to the information about the tasks that can be performed by users with different
roles in a team space:

Tasks Roles More information

Configuring a team space license Team Space Owner Configuring licenses for team spaces

server on page 115

Configuring the Named Users Team Space Owner Adding users to the Named Users list

on page 117

Modifying the configuration of a Team Space Owner Modifying the configuration of a

team space team space on page 648

Viewing the configuration of ateam | All members of a team space Viewing the configuration of a team

space space on page 650
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Tasks

Roles

More information

Reassigning the role of team space

members

Team Space Owner

Managing members and their roles in

a team space on page 653

Becoming a team space member

» Team Space Owner

« All users can send a request

Becoming a team space member on

page 652

Viewing team spaces

All members of a team space

Notes:

¢ The Permissive and
public Restrictive
team spaces are visi-
ble to all the users.

* The private Restric-
tive team spaces
are only visible to its

members.

Viewing team spaces on page 644

Deleting a team space

Team Space Owner

Deleting a team space on page 656

Adding a project in a team space

Project Creator

Adding a project on page 660

Viewing existing projects

All members of a team space

Viewing active projects on

page 665

Viewing details about the users or li-

cense server

All members of a team space

Viewing license details of the team

space on page 120

Installing remote agents and con-
figuring them to register with HCL
OneTest™ Server

All members of a team space

Management of agents on

page 268

Registering a remote Docker host
with HCL OneTest™ Server

All members of a team space

Registering a remote Docker host on

page 284

Editing configurations of a remote

Docker host

All members of a team space

Editing configurations of a remote

Docker host on page 288

Unregistering a remote Docker host

All members of a team space

Unregistering a remote Docker
host from HCL OneTest Server on

page 292
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Tasks

Roles

More information

Viewing remote agents, remote Dock-
ers, or intercepts that are registered
with HCL OneTest™ Server in the ini-
tial team space

All members of a team space

* Viewing remote Docker
hosts that are registered
with HCL OneTest Server on
page 286

« Viewing agents that are regis-
tered with HCL OneTest Serv-
er on page 271

« Viewing intercepts that are
registered with a team space
on HCL OneTest Server on

page 447

Adding resource monitoring sources

and agents

Team Space Owner

Resource monitoring on page 508

Adding resource monitoring labels to

the sources

Team Space Owner

Controlling resource monitoring

sources in a schedule on page 542

Viewing the performance metrics

All members of a team space

Viewing resource monitoring usage

data on page 549

Creating a model of the system un-

der test

Architect

System modeling on page 230

Adding a repository to a team space

» Team Space Owner
« Architect

Adding a repository to a team space

on page 234

Viewing an existing system model

All members of a team space

Viewing the system model on

page 255

Related information

Team space administration on page 102

Tasks in projects in a team space

You can find information about the roles that you can assign in a project for members of a team space and the tasks

that you can perform in projects in a team space.
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Members of a team space with the role of a Project Creator can create projects in the team space and become the
Owner of a project. The owners of projects can add Members of the team space to a project and assign them the
following roles:

* Owner
« Tester

« Viewer

For the list of actions that members assigned any of the roles can perform, see Managing access to server projects

on page 667.

All projects are created in a team space. When you open a project, the options that are displayed in the navigation

pane are specific to the projects within a team space.

When you are working on a project in a team space and you want to return to the options available to work in the team

space, you can click the Home icon E in the navigation pane.
Note: You must be assigned the role of an Owner, a Tester, or a Viewer of a project.

The following table lists the tasks that members of a team space can perform while working with projects in a team

space:
Tasks More information...
Viewing projects in a team space. Viewing active projects on page 665
Adding a project. Adding a project on page 660
Adding a repository that contains test assets and re- Adding repositories to a server project on page 661

sources that you want to run on the server.

Adding secrets to a secrets collection. Secrets configuration on page 664

Encrypting the data set resources. Data security

Configuring a change management system. Configuration of a change management system on
page 553

Adding members to a project and configuring their roles. | Adding users to a project on page 664

Selecting the global branch in a project to view the test [ Selecting the global branch in a project on page 678
assets and resources.

Adding agents to your project, if you are using remote Adding a performance agent to a project on page 272
agents as a location to run certain tests.

Adding remote Dockers, if you are using a remote Docker [ Adding a remote Docker host to the project for running

host as a location to run tests. tests on page 287
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Tasks More information...

Reading the considerations that you must take into ac- | Prerequisites to running tests on page 257

count before you configure a test run.

Reading the considerations that you must take into ac- | Prerequisites for running virtual services on page 441

count before you configure a run or start a virtual ser-

vice.

Configuring a run of the test assets. Test run configurations on page 308

Configuring a run of the virtual service resource. Configuring a run of a virtual service on page 451

Viewing the progress of a test run. Viewing the progress of running test assets on
page 430

Managing a running test. Management of running tests on page 427

Viewing the results of a test run after the run is complet- | Test results on page 486
ed.

Reviewing the test results and creating defects for test | Creating Jira defects on page 557
runs from the Results page.

HCL license portal

Licensing for HCL OneTest™ Server is administered through HCL Software License & Download portal. This portal is a

FlexNet-based web application that helps to manage software entitlements and licenses.

When a software order is placed and acknowledged, a software entitlement is created. You must then follow the
instructions in the Software Order Acknowledgment document that you receive to activate your entitlement, create

devices, and download the software from the portal.

The license portal provides both software distribution and management of your software entitlements that are
purchased from HCL Software. The portal provides control and flexibility on how to consume your licenses. An
organization identifies one of its resources as a License Manager (also called Tech or Portal Admin) who is familiar
with the language of licenses.

For more information about the HCL Software License & Download portal, you can refer to the following knowledge
articles:

» What is the HCL Software License & Download portal (FlexNet portal)?
« How to find HCL Product Releases in HCL Software License & Download portal

« Managing Users on the HCL Software License & Download portal
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Management of licenses in HCL OneTest™ Server

As a Team Space Owner, you can configure and manage licenses for your team spaces in HCL OneTest™ Server. As
a member of any team space, you can only view the details of the licenses that are configured for the team space. If
you are not a member of any team space, you cannot view or perform any operations in any of the team spaces on
HCL OneTest™ Server.

Depending on your privileges, you can perform the following tasks in HCL OneTest™ Server:

Privileges Tasks More information

Read about licensing on HCL OneTest™ Server. Server software licensing informa-

Team Space Owner
P v tion on page 113

Configure licenses. Configuring licenses for team

spaces on page 115

Configure named users. Adding users to the Named Users

list on page 117

Remove or replace named users. Removing or replacing named users
on page 118
Licensed user Perform tasks or operations in a team space. Tasks in a team space on
page 107
Viewing details about licenses. Viewing license details of the team

space on page 120

Server software licensing information

You can find information about the licensing on HCL OneTest™ Server.

To use the features offered by HCL OneTest™ Server, you must purchase the following licenses:

- Named user

» Concurrent Virtual Service

Named user licenses

As a Team Space Owner, you can configure the License Server and add users to the Named Users list for the team

spaces.

The Named user licenses are automatically self-acquired on a first-come-first-serve basis. The licenses are always
available for the users who are added to the Named Users list. Also, those users can perform the project tasks in
their team space even though the Disable automatic self-acquisition of named user licenses checkbox is cleared in
the License Configuration page. However, the other users receive an error notification about the unavailability of the
license when they try to perform the project tasks.
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n Remember: A single Named user license is used from the total number of Named user licenses when you

perform most of the operations in HCL OneTest™ Server.

! Important: You can perform only the following operations in team space without using a license:

- Configure the License Server
 Modify the user roles in a team space

« Delete the team space

n Remember: The Named user license is returned to the license pool only under any of the following conditions:

- When the Named user is no longer a member of any team space.

» When the Named user is removed as a user of HCL OneTest™ Server.

! Important: The Named user license can take a few minutes to return to the license pool.

Concurrent Virtual Service licenses

HCL OneTest™ Server requires an additional license to use the service virtualization feature. You must have sufficient
Concurrent Virtual Service licenses to run instances of virtual services that are contained in API Suites on HCL

OneTest™ Server.

A single Concurrent Virtual Service is used from the total number of Concurrent Virtual Service licenses when any of

the following events occur:

« An instance of a virtual service is started by running a virtual service resource. A license is consumed for

every running instance of the virtual service.

« An API suite is run that has a scenario that references a local virtual service and the scenario begins

The Concurrent Virtual Service license is returned to the license pool when the virtual service instance stops.

For example, consider you decided to have three team spaces including the initial team space, then you must
configure the licenses required for each team space on the License Server based on your requirement. You must then

use the URL and ID of those License Servers to configure the licenses for the team spaces.
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Related information

Configuring licenses for team spaces on page 115

Configuring licenses for team spaces

As a Team Space Owner, you can configure the License Server for the team spaces on the License Configuration page
so that members of the team space can perform various operations such as creating a project, running tests, and so
on.

Before you begin

You must have completed the following tasks:

- Configured the licenses that you purchased on the Licensing Server.
- Been assigned the role of a Team Space Owner of the team space.
« Installed the product and signed up as a user on HCL OneTest™ Server.

« Optional: Created a team space. See Creating a team space on page 105.

About this task

You must have a valid license to work with the team spaces that you create on HCL OneTest™ Server. You must
provide a separate URL and ID of the License Server for the team spaces when you configure the License Server.

If you provided the URL and ID of the License Server that is already configured for any other team space, then the
configuration of the license for the team space fails with an error message. If you delete the team space, then the
URL and ID of the License Server used for that team space is released. You can then use that for another team space.

Note: When you upgrade the server software from the previous version to the latest version, then the license
configuration of the previous release applies to the initial team space. You can verify the information from the
License Configuration page of the initial team space.

1. Log in to HCL OneTest™ Server.

2. Click the Settings icon from the left navigation pane.
3. Open the team space for which you want to configure the license from the Switch to option.

Note: The Switch to option is displayed only if you have two or more team spaces.

4. Click the Settings icon , and then License.
Result

The License Configuration page is displayed.

115



116

HCL OneTest™ Server

5. Enter the values in the License Server URL and License Server ID fields to configure the licenses for the team

space.
Result

The following information is displayed:

> The License usage section displays the number of Named user licenses that are currently in use.

However, the License usage section does not display the number of Concurrent Virtual Service that

are currently in use.

> The License configuration section displays the following information:

= The number of Named user licenses that are configured on the License Server.

= The number of Concurrent Virtual Service licenses that are configured on the License Server.

= The number of Studio licenses that are configured on the License Server.

You can view the following messages based on the value that you enter in the License Server URL and

License Server ID fields:

Values Messages
No value Add the missing license details or enter the License Server URL.
Incorrect format of the License This is not a valid format of the License Server URL or License Server
Server URL or License Server ID ID.
Correct value License Server is already in use by another team space owner

6. Click Check connection to verify the current status of License Server.

Based on the availability of License Server, you can view the following messages:

o License Server is available

o License Server is unreachable

7. Select the Disable automatic self-acquisition of named user licenses option if you do not want to self-acquire

Named users license on a first-come-first-serve basis for your team space.

The following table describes the functionality of the Disable automatic self-acquisition of named user

licenses option:

Option When

Description

Disable automat- | Cleared
ic self-acquisi- |O

Any member of a team space can get a license when there are sufficient licens-
es are available for the team space.
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Option When Description
tion of named Select- | Only such users who are added to the Named Users list get a license to per-
user licenses ed™ |[form the tasks in their team space. If other users try to perform any project op-

erations in any of the team spaces, they cannot get a license even if sufficient

licenses are available.

8. Click Configure to apply the license configuration.

Results
You have configured the license for the team space.
What to do next

You can perform any of the following tasks:
« Add users to the Named Users list. See Adding users to the Named Users list on page 117.
« Add members to your team space. See Adding members to a team space on page 645.

Adding users to the Named Users list

As a Team Space Owner, you can add users to the Named Users list so that the licenses are always available for

those users.
Before you begin

You must have completed the following tasks:

- Been assigned the role of a Team Space Owner of the team space.
« Optional: Created a team space. See Creating a team space on page 105.

« Configured the license for the team space. See Configuring licenses for team spaces on page 115

1. Log in to HCL OneTest™ Server.

2. Click the Settings icon from the left navigation pane.
3. Open the team space for which you want to add users from the Switch to option.

4. Click the Settings icon , and then License.
Result
The License Configuration page is displayed.
5. Enter the name or the email ID of the user in the Add named users field, and then select the name from the list

that displays to add members to the Named Users list.
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Note: You can press Ctrl to select multiple users simultaneously.

6. Click Add to make selected users as Named users.

Results

You have added users to the Named Users list.

n Remember: The License usage section does not display the number of Concurrent Virtual Service that are

currently in use.

Removing or replacing named users
When you want to remove a user from the list of named users or you want to replace an existing user with another
named user, you as a Team Space Owner can perform these changes from the License Configuration page.

Before you begin

You must have completed the following tasks:

- Been assigned the role of a Team Space Owner for the team space that you want to modify the users from the

Named Users list.

» Added users to the list of named users for the team space on HCL OneTest™ Server.

1. Log in to HCL OneTest™ Server.

2. Click the Settings icon from the left navigation pane.
3. Open the team space for which you want to remove or replace the users from the Named users list from the

Switch to option.

4. Click the Settings icon , and then License.
Result
The License Configuration page is displayed.
5. Perform the actions described in the following table to remove or replace users from the Named Users list:

Tasks Actions

Remove a user | Perform the following steps:

from the list of

a. Locate the user that you want to remove from the Named Users list.
named users.

b. Click the Menu icon next to the name of the user, and then click Remove.

c. Click Remove on the Remove named user dialog box to complete the action.
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Tasks

Actions

n Remember:

> When the Disable automatic self-acquisition of named user licens-
es option is cleared, and if the user who is removed from the Named
Users list tries to perform any project operation, then the name of the
user is added back to the list. The name of the user is added only if
sufficient licenses are available.

> When the Disable automatic self-acquisition of named user licenses
option is selected and you remove the user from the Named Users list,
then the following operations are impacted by the user who is removed

from the list:
= The test runs scheduled by the user might fail to run.

= The test results which are in progress by the user might fail to

record complete details.

= The user cannot perform any of the project operations that in-
clude the generation of offline tokens that are used for long-run

tests.

Note: If the user is currently on HCL OneTest™ Server, then the

license can be used while the current session remains active.

Replace a userin
the list of named

users.

Perform the following steps:

a. Locate the user from the Named Users list that you want to replace with anoth-

er user.

b. Click the Menu icon next to the name of the user, and then click Replace.

c. Enter the email ID or name of another user that you want to add to the Named
Users list.

d. Click Replace to complete the action.

Results

You have removed or replaced a user from the Named Users list.
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Viewing license details of the team space

You can find information about the number of licenses configured, licensed users, or details of the license server on

the License Configuration page.

Before you begin

The Team Space Owner must have configured the licenses for the team spaces on HCL OneTest™ Server.
About this task

You as a licensed user can create projects or use the other features in HCL OneTest™ Server only after the Team
Space Owner has configured the licenses for the team space. If you are not a licensed user, you cannot view or
perform any operations on HCL OneTest™ Server.

1. Log in to HCL OneTest™ Server.

2. Click the Settings icon from the left navigation pane.
3. Open the team space for which you want to view the license details from the Switch to option.

4. Click the Settings icon , and then License.
Result

The License Configuration page is displayed with the following license information:
> The number of Named user licenses that are currently in use
> The number of Named user licenses that are configured on the License Server
> The number of Concurrent Virtual Service licenses that are configured on the License Server
> The number of Studio licenses that are configured on the License Server
> The URL and ID of License Server
> The status of License Server
> Whether the self-acquisition of named user licenses feature is enabled or disabled

> The name and email ID of the users that are configured as named users by the Team Space Owner

n Remember: The License usage section does not display the number of Concurrent Virtual Service

that are currently in use.

Results

You have viewed the details about the licenses for the team space.
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This guide describes how to create test assets in HCL OneTest™ Server and publish test assets to the Git repository
that you have configured. You can also edit existing test assets that are in the repository added to your project. This

guide is intended for testers and test managers.

Test authoring

You can use HCL OneTest™ Server to author tests instead of creating the tests by using the desktop products.

HCL OneTest™ Server 10.2.2 provides you with the test authoring capability, which utilizes a containerized version of

the HCL OneTest™ Studio desktop authoring tools.

Refer to the following table to know about the default status of the test authoring feature during server installation:

Server installation Test authoring feature
Ubuntu Server (using k3s) Disabled
Azure Kubernetes Service Enabled

! Important:

By design, the test authoring feature provides you with the capability to author and edit tests that include
writing code, executing code, and accessing the shell. The container in Kubernetes that is used by the test
authoring or editing feature does not run as root and the container is not privileged. Hence, it results in
providing some protection to the host and other workloads that run on the same node.

You must not install the test authoring feature in the following scenarios:

« If you administer a network policy for your server installation.

- If you do not intend to use the test authoring feature.

Note: If you are installing the server on the Azure Kubernetes Service platform and you do not want
to use the test authoring feature, you must run a helm command to turn off the installing of the test

authoring feature.

Prerequisites for authoring tests

You must be familiar with the methods for authoring or creating tests in any of the following desktop products before

you can use the test authoring capabilities in HCL OneTest™ Server:
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* HCL OneTest™ API
» HCL OneTest™ Performance
*« HCL OneTest™ Ul

You must ensure that you have not disabled the test authoring feature at the time of installation of HCL OneTest™

Server or any time after installation.

You must be a Team Space Owner, Project Owner or Member with Tester role to create or edit tests.

Working with the test authoring feature
You must create a project in your team space on HCL OneTest™ Server and add a repository to your project.

You must enable the browser that you use to start an instance of HCL OneTest™ Server to trust the self-signed
certificate so that the containerized product can be displayed in another tab of the same browser. See Certificate

authority: Importing and extending lists on page 91.

A containerized version of the HCL OneTest™ Studio desktop authoring tools is launched on a new browser tab
different from the tab that displays the HCL OneTest™ Server instance when you initiate any of the following tasks on
HCL OneTest™ Server:

« Create a test in a branch of the project repository.

- Edit a test in a branch of the project repository.

You must select the type of test that you want to create. After you select the type of test, the corresponding
containerized product is displayed in a new browser tab. Refer to the following table for the types of tests that you

can create in the containerized product:

Test type selected Containerized product displayed Supported tests that you can create
API test HCL OneTest™ API The following test types are support-
ed:

» API Test Suite
* APl tests
« Virtual services

Functional test HCL OneTest™ Ul The following test types are support-
ed:

Performance test
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Test type selected

Containerized product displayed

Supported tests that you can create

Note: This is a shell-shared
version with HCL OneTest™
Performance with which you
can create both functional

tests and performance tests.

» AFT Suite
« Compound tests that contain
any of the following types of
tests:
o HTML tests
> Performance tests
> Web Ul tests
« Functional Web Ul tests
- Performance tests
- Rate Schedules
VU Schedules

The containerized product displays the product GUI similar to the desktop product. You must use the options similar

to the desktop product to create the tests in the containerized products. Refer to the following table for the supported

technologies and features in the containerized products in comparison with the desktop products:

Container-

ized product

Supported features

HCL OneTest™
API

All features as in the desktop product

excluding the following features:

 Topology Discovery in the Ar-
chitectural School perspec-
tive.

* Rules Cache in the Architec-
tural School perspective.

 Monitoring logging of tests in
the Test Factory view.

« Results Gallery.

« Results Publishing and Quali-
ty Management in the Project
Settings Ul.

« Test Cycles, General Tool
Configuration, Project Securi-
ty, and Ant task.

Supported technologies
All technologies as in the desktop product excluding the
following technologies used as a physical transport in
tests:
Virtual
Transport Testing | Recording .
services
FIX Yes No No
Mongo Yes No No
TCP Server Yes No No
UDP Server No No No
CICS Region Yes No No
IMS Connect Yes No No
Software AG IS Yes No No
Database No No No
z/0S DB2 No No No
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Container-
. Supported features Supported technologies
ized product

HCL OneTest™ Ul | All features as in the desktop prod- | All technologies as in the desktop products.
shell-shared with | ucts.
HCL OneTest™

Performance

You can refer to the product documentation of the desktop products to find information about the specific tasks that

you want to perform in the containerized product. Use the following links to the product documentation:

* HCL OneTest™ Performance documentation
* HCL OneTest™ Ul documentation
* HCL OneTest™ APl documentation

After you create the test in the containerized product, you must save the test assets or resources to the branch in the
repository of your project. You accomplish committing the assets or resources by publishing them.

You can pause your test creation activities in the containerized product and resume the task in the following
conditions:

» When you do not delete the ongoing session in the browser tab with the containerized product.

- When you resume the test authoring session within 8 hours of pausing the task.

! Important: You might not be able to continue with the test creation activities if you close the browser

and delete the session with the containerized product.
After the created test assets are published to the project repository, you can run the test assets from the Execution
page or the virtual services from the Resources page.

When you want to edit the created tests or other tests that are in the project repository, you can open the test in the
containerized product and use the containerized product to edit the test. After you edit the test, you must publish the
test assets to the repository so that the edited test asset is available for a run.

Limitations when using the test authoring feature
You can initiate only one session to either create or edit a test in the containerized product.

When you open a test for editing, the browser displays a message whether you want to view copied text and images

on the clipboard. You must choose Allow so that the test is opened for editing.
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Note: If you select Block, the test is not opened for editing.

When you create a Performance test or Functional test for the first time in the containerized product, after the product
is loaded in a new browser, the New Test From Recording window is displayed. You can ignore this message by

clicking Cancel and continue with test creation in the containerized product.

When you work in the containerized HCL OneTest™ Ul on Performance or Functional tests, you can do any of the

following actions to display the context menu:

* Press Shift+F10
« Keep the right mouse key pressed for a few seconds

When you work in the containerized HCL OneTest™ API to create or edit API tests or resources and if you want to copy
and paste API tests or resources, then you must use the Context menu by selecting Edit > Copy and then click Edit >
Paste.

Note: The shortcut keys Ctrl+C and Crtl+V do not work to copy and paste API test resources.

The window size control options do not work in the HCL OneTest™ API containerized product.

The SSL certificate validation fails when you commit assets or resources to Git repositories in the containerized
product. You can choose to skip the SSL validation and continue with committing assets to Git.

Creating tests or virtual service resources

You can create tests or virtual service resources by using the test authoring capabilities of HCL OneTest™ Server.
After you create and publish the test assets or resources to a branch in your project repository, you can run the tests

or virtual service resources on HCL OneTest™ Server.
Before you begin

You must have completed the following tasks:

 Read the information presented in Prerequisites for authoring tests on page 121 and Working with the test

authoring feature on page 122.
« Created a project in HCL OneTest™ Server. See Adding a project on page 660.

+ Added a Git repository to your project. See Adding repositories to a server project on page 661.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Open the project, and then click Author > Tests.

The existing test assets in the branch of the project repository are displayed if they exist.
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The details such as test design considerations, the load test profile, or other details that you entered as

properties of the test asset in the desktop products are displayed in the Description column.

3. Click Create test, and then select the type of test assets that you want to create.

You can select any of the following types of tests:
o APl test

o Functional test

o Performance test

After you select the type of test, the corresponding containerized product is displayed in a new browser tab.

Refer to the following table for the types of tests or virtual services that you can create in the containerized

product:

Test type selected

Containerized product displayed

Supported tests
that you can create

API test

HCL OneTest™ API

The following test types are sup-
ported:

o API Test Suite

o APl tests

> Virtual services

Functional test

Performance test

HCL OneTest™ Ul

Note: This is a shell-
shared version with HCL
OneTest™ Performance
with which you can create
both functional tests and
performance tests.

The following test types are sup-
ported :
o AFT Suite
> Compound tests that con-
tain any of the following
types of tests:
= HTML tests
= Performance tests
= Web Ul tests
> Functional Web Ul tests
o Performance tests
o Rate Schedules
> VU Schedules

The containerized product displays the product GUI similar to the desktop product. You must use the options

similar to the desktop product to create the tests or virtual services in the containerized products.

4. Create the test or virtual services by using the containerized product.

You can refer to the product documentation of the desktop products to find information about the specific

tasks that you want to perform in the containerized product. Use the following links to the product

documentation:
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o HCL OneTest™ Performance documentation
o HCL OneTest™ Ul documentation
o HCL OneTest™ API documentation
5. Save and commit the test assets or virtual service resources to the Git repository that is configured in your
project from the containerized product.
6. Delete the containerized product session by closing the browser tab of the containerized product, and then
click Delete session.

The test assets that you created in the containerized product are displayed in the TESTS tab. The virtual
services that you create are displayed on the Resources page.

7. Click Author > Changes.
8. Select the Git repository to which the test asset or resource was committed in the containerized product.
9. Click Publish.

Publishing the test assets or resources to the Git repository makes the test assets or resources to be available
to other members of your project.

Results

You created a test by using the containerized product on HCL OneTest™ Server.
What to do next
You can configure a run of the tests that you created. See Test run configurations on page 308.

If you created virtual services in the containerized HCL OneTest™ API product, you can configure a run of the virtual

services. See Configuring a run of a virtual service on page 451.

Editing a test

You can modify an existing test asset that you created from the desktop product or a test that you created in the
containerized product on HCL OneTest™ Server. After you publish the edited test to a branch in your project repository,

you can run the test on HCL OneTest™ Server.
Before you begin

You must have completed the following tasks:

« Created a project in HCL OneTest™ Server. See Adding a project on page 660.

« Added a Git repository to your project. See Adding repositories to a server project on page 661.

« Created a test asset by using the containerized product on HCL OneTest™ Server. See Creating tests or virtual

service resources on page 125.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.
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2. Open the project, and then click Author > Tests.
The existing test assets in the branch of the project repository are displayed if they exist.

The details such as test design considerations, the load test profile, or other details that you entered as
properties of the test asset in the desktop products are displayed in the Description column.
3. Select the branch of the repository that contains the test assets.

The test assets that are contained in the selected branch of the repository are displayed in the following tabs

on the Tests page:

Tab Description

SUITES Lists all Suites, compound tests, Rate Schedules, or VU Schedules that are in the se-

lected branch of the repository.

TESTS Lists all API tests, functional tests, and performance tests that are in the selected

branch of the repository.

ADVANCED Lists all assets that are displayed when custom filters are applied for assets in the se-

lected branch of the repository.

4. ldentify the test asset that you want to edit by performing any of the following actions:

» Scroll through the list.

e Tip: You can hover over the icon in the Type column to know the type of the test asset.

Note: You can also identify the type of the asset from the icon that represents the test type as

shown in the following table:

Listed Listed Listed in

in the in the the AD-
Icon Represents
SUITES TESTS VANCED
tab tab tab
APl test o

Functional test

Q00|00

y Performance test O
AFT Suite a
API Suite a
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Listed Listed Listed in
in the in the the AD-
Icon Represents
SUITES TESTS VANCED
tab tab tab
Compound Test o o

Rate Schedule o o

VU Schedule o o

- Enter any text, that is contained in the test asset name, in the Search field.

o Click the Filter icon ? in the SUITES or TESTS tab to filter the displayed assets based on the asset
type.

For example, select API Suite in the SUITES tab to display all the API Suites or select Functional Test
in the TESTS tab to display all the functional tests that are in the selected branch of the repository.

o Click the Filter icon ? in the ADVANCED tab, and then create a filter query by using the New filter
option by performing the following steps:
a. Click New filter.
b. Enter a name for the filter.
c. Select an operator, and add a rule, or a group of rules.
d. Add or enter the relevant parameters and either select or enter the condition and the criteria for

the condition.

You can select a parameter from the following list:
= Type
= Test Asset Name
= Test Asset Path
= Description
e. Save the filter query to save and apply the filter query to filter the assets based on the query.

The test assets that match the filter criteria are displayed.

o Retrieve and apply a saved filter query, if you have saved filter queries previously by performing the

following steps:
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Note: The filter query applied previously is selected and the assets based on that filter query

are displayed. To apply a different filter query, you must have created and saved the filter

query.

a. Click the Filter icon ? in the ADVANCED tab.

The filter queries that you created and saved are displayed.

b. Click the filter that you want to apply.
The test assets that match the filter criteria are displayed.

You have identified the test asset that you want to edit.

5. Click the Edit icon & in the Actions column of the test asset.

Based on the type of test asset that you select, the corresponding containerized product is displayed in a new

browser tab as detailed in the following table.

Note: If you are presented with a message prompting you to allow the content to be copied on the
clipboard, select Allow and continue with your task.

Test asset type selected Containerized product displayed

o API Test Suite HCL OneTest™ API

> APl tests

o AFT Suite HCL OneTest™ Ul

o Compound tests that contain any of the fol-

lowing types of tests: Note: This is a shell-shared version with HCL

= HTML tests OneTest™ Performance with which you can
= Performance tests create both functional tests and performance
= Web Ul tests tests.

o Functional Web Ul tests

o Performance tests

o Rate Schedules

> VU Schedules

The containerized product displays the product GUI similar to the desktop product. You must use the options
similar to the desktop product to edit the tests in the containerized products.

6. Edit the test by using the containerized product.
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You can refer to the product documentation of the desktop products to find information about the specific
tasks that you want to perform in the containerized product. Use the following links to the product
documentation:
o HCL OneTest™ APl documentation
o HCL OneTest™ Ul documentation
o HCL OneTest™ Performance documentation
7. Save and commit the test assets or virtual service resources to the Git repository that is configured in your
project from the containerized product.
8. Delete the containerized product session by closing the browser tab of the containerized product, and then
click Delete session.
9. Click Author > Changes.
10. Select the Git repository to which the test asset or resource was committed in the containerized product.
11. Click Publish.

Publishing the test assets or resources to the Git repository makes the test assets or resources to be available

to other members of your project.

Results
You edited a test by using the containerized product on HCL OneTest™ Server.

What to do next
You can configure a run of the tests that you edited. See Test run configurations on page 308.

Editing virtual service resources

You can modify an existing virtual service resource that you created from the desktop product or a virtual service
resource that you created in the containerized product on HCL OneTest™ Server. After you commit the edited virtual
service resource to a branch in your project repository, you can start an instance of the virtual service resource on
HCL OneTest™ Server.

Before you begin

You must have completed the following tasks:

« Created a project in HCL OneTest™ Server. See Adding a project on page 660.

- Added a Git repository to your project. See Adding repositories to a server project on page 661.

« Created virtual service resources by using the containerized product on HCL OneTest™ Server. See Creating

tests or virtual service resources on page 125.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.
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2. Open the project that contains the virtual service resources in the test assets by clicking Projects > My

Projects > project_name.

The Overview page is displayed.

3. Click Virtualization > Resources in the navigation pane.

The Resources page is displayed.

4. Select the branch of the repository that contains the virtual services that you want to edit from the list in the
Branch field.

All virtual services in the selected branch are displayed on the Resources page.

5. Identify the virtual service by completing any of the following steps:

- Search for the virtual service by entering the name or the path of the virtual service in the repository in
the Search field box.
o Create a filter query by using the New filter option and complete the following steps:
a. Create a rule with an appropriate operator.
b. Select criteria such as Name, Path, Instance number, or Instance state. Select the condition and

enter the value for the criteria. Apply the filter query.

The virtual services that match the filter criteria are displayed.

c. Save the filter query for retrieving it from the saved filters list.

- Retrieve a saved filter by using the Open filters icon = by completing the following steps:
Note: To open the filter query, you must have created and saved a filter query.

a. Select the saved filter.
b. Apply the filter.

The virtual services that match the filter criteria in the filter that is applied are displayed.

6. Click the Edit icon & in the Actions column of the virtual service resource.

The containerized HCL OneTest™ API Ul is displayed in a new browser tab.

Note: If you are presented with a message prompting you to allow the content to be copied on the

clipboard, select Allow and continue with your task.

7. Edit the virtual service resource by using the containerized product.

You can refer to the HCL OneTest™ API product documentation to find information about the specific tasks
that you want to perform. See HCL OneTest™ API Product Documentation.
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8. Save and commit the virtual service resources to the Git repository that is configured in your project from the
containerized product.

9. Delete the containerized product session by closing the browser tab of the containerized product, and then
click Delete session.

Results

You edited the virtual service resources by using the containerized product on HCL OneTest™ Server.
What to do next

You can configure a run of the virtual service resource that you edited. See Configuring a run of a virtual service on
page 451.

Datasets overview

A dataset provides tests with variable data during a run. The test that uses a dataset at run time replaces a value in
the recorded test with variable test data that is stored in the dataset.

In HCL OneTest™ Server, you can create a dataset and use it to replace the dataset values with original values during

run time, when you want to run test assets that contain the dataset.

From the Datasets page, you can perform the following actions:

Table 3. Options available in Datasets page

Ac-

. Descriptions
tions

View | You can view the contents of a dataset. See Viewing a dataset on page 144.

Cre- | You can create a dataset to use it during a test or schedule run. See Creating a dataset on page 134.

ate

Edit | You can edit a dataset when you want to run a test asset with different dataset values. See Editing a dataset
on page 135.

Con- | You can configure the string values in a dataset that contains variable data for tests to use when they run.
figure | See Editing a dataset on page 135.

Delete | You can delete the dataset when it is not required in your test environment. See Deleting a dataset on
page 146.

Save

As You can save a copy of a dataset in a different folder or make a copy with a different name by clicking the

L]
Menu icon s and then by selecting the Save As option.
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Table 3. Options available in Datasets page (continued)

Ac- L.
. Descriptions
tions
Branch
selec- You can view the dataset listed in the other branches of the repository by selecting the name of the branch
tion from the Branch list. When you access the Datasets page for the first time after adding the repository, the

global branch is set to the default branch of the repository.

When multiple repositories are added to the same project, the following events occur:

 The datasets stored in the selected branch of all the repositories are displayed.

« All the branches in all the repositories are listed in the drop-down list.

- If the selected branch is not present in a repository, then datasets from that repository are not dis-
played.

To differentiate a common branch across multiple repositories added to the project, the tooltip is not dis-
played in front of the common branch name in the list.

Notes:

* Only a project Owner or a project member whose role is a Tester can view and edit the dataset.

« To view the content of an encrypted dataset, you must provide an encryption key that you set while
encrypting the dataset column.

- As a Viewer, when you try to access the Datasets page, an error message is displayed because you do
not have the permission to view this page.

Creating a dataset

You can create datasets in HCL OneTest™ Server to replace the existing dataset values with new dataset values
during a test or schedule run.

Before you begin
You must be a member of the project with the Owner or Tester role and must have completed the following tasks:
« Created a project in HCL OneTest™ Server. See Adding a project on page 660.

+ Added a Git repository to your project. See Adding repositories to a server project on page 661.

About this task
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When you create a dataset in HCL OneTest™ Server, it always creates 1 Row, 2 Column (1R X 2C) dataset. Later, you

can edit the dataset by adding some rows and columns that you want, to add the data in it.

. Go to the HCL OneTest™ Server URL.

. Enter your user name and password, and then click Login.
. Open your project from the HCL OneTest™ Server Ul.

. Go to the Datasets page, and then click Create dataset.

a A W N =

. Enter a name for the dataset in the Asset name field, and then select the place where you want to save the
dataset in the Location drop-down list.

6. Click Create.

Result

The new dataset opens in a CSV Editor in a web browser. The dataset created is listed on the Datasets page.

Results
You have created a dataset in your project.

What to do next

* You can add, modify, or remove data in the dataset. See Editing a dataset on page 135.

« You can publish the dataset to the Git repository so that other members of the project can use the dataset.
See Publishing a dataset on page 143.

Editing a dataset

You can add, modify, remove, import, or export data from a dataset by using the CSV Editor. The working principle of
the CSV Editor is similar to that of a spreadsheet.

Before you begin
You must have created a dataset or configured a repository that contains the dataset.
About this task

If you are a project Owner or Tester in HCL OneTest™ Server V10.1.0 or later, you can perform basic tasks in the
CSV Editor by right-clicking any row, column, or cell in the dataset to organize your data in a better way. For example,
you can perform tasks such as updating data in a cell, inserting or deleting rows and columns, or renaming column

names.

When you edit the dataset in the CSV Editor, you can use the following keyboard shortcuts to control the cursor
selection in the CSV Editor:
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« Tab - To move the cursor control to the next available option.
« Shift-Tab — To move the cursor control to the previous option.

« Shift+F10 — To open the context menu from the dataset cell.

After you edit the dataset, you can save the changes made to the dataset, and then you can publish the dataset to the
Git repository. If you save and close the edited dataset, the Changes page lists the edited dataset and later you can

publish to the Git repository for other members to use.

When you or other members of the project edit the same dataset, you can see an icon with the initials of the member
next to the name of the dataset on the Datasets and Changes pages. If you do not see the icon, you must refresh the
Datasets page to view the icons. The Changes page denotes conflicting edits when another member publishes their
edited dataset first.

Dataset name Table matrix Actions
» AdditionalLocations @ Q 2 Col x 7 Row p s
LU;Beia_-'LUgicel;’LUce’.iUns,-detiunaIL
s Locations 3 Col x 3 Row :
LogData/Logical/Locations/Locations. sit
|:| Asset name Change Last changed by Last updated Actions
| AdditionalLocations @ Undate v Amy Smith 7 minutes ago H

aData/Logical/Locations/Addi }
LogData/Logical/Locations/Addif . © has conflicting edits |

When a member with conflicting edits tries to publish the edited dataset, an error about conflicting changes is
displayed. However, the member can use the Save As option to save and publish a copy of the dataset edits under a
new asset name. The member must discard the edits that were made to the original dataset.

For example, consider a scenario when Amy Smith and John Doe edit the same dataset, and Amy Smith edits and
publishes the dataset. On the Changes page, a message that indicates a conflict is displayed when John Doe tries to
publish the same dataset.

Note: You cannot resize the width of rows in the CSV Editor. When you have a large amount of data in a cell,
you can right-click the cell and select Copy (or Ctrl+C), and then paste it into a text-editing program to view the

content. Alternatively, you can hover the mouse over the cell to view the content.

When you have a CSV file that has data separated from a character, then you can import that CSV file into the dataset.
You can select any of the following separator characters from the Configure Dataset window, and the selection can
be the separator character that you used in the CSV file:

« Comma

» Semicolon



» Space
» Tab
« Other
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Consider that you have the data in the CSV file in the following format:

| Mame;CCNum

John;1234 5678 1234 5678

Bob;1122 3344 5566 7788

Amy;2233 4455 6677 8899

When you import the CSV file in the dataset, and then select the separator value as Semicolon, the data in the dataset

is displayed as follows:

Name
John

Bob

Amy

CCNum

1234 5678 1234 5678

1122 3344 5566 7788

2233 4455 6677 8899

If you want the data in its original format, that is, a semicolon (;) character to separate the data, then you can choose

any other separator value from the Configure Dataset window.

Note: The default separator value is Comma.

1. Go to the Datasets page and find the dataset which you want to edit.

2. Click the Edit icon 2 from the Actions column of the dataset.

Result

The dataset opens in the CSV Editor in a web browser.

3. Perform the following actions to use the options available in the CSV Editor:

Q

place

Options Actions
Find To find:
and Re-

a. Click the Find and Replace icon
b. Enter the content that you want to search in the Find field.
c. Select any or all the following options to find the search content more effectively:
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Options

Actions

= Select the Case sensitive checkbox to search the content that is the exact letter
case of the content entered in the Find field.

= Select the Match entire cell contents checkbox to search for cells that contain
only the characters that you have entered in the Find field.

= Select the Search using regular expression checkbox to search the pattern that
matches strings.

For example, to search a cell that contains any number between 0 to 9, do the
following:
i. Enter \d in the Find filed.
ii. Select the Search using regular expression checkbox.
iii. Click Find.
d. Click Find. If the text is found, the cell containing that text is selected.
e. Click Find again to find further instances of the search text.

To find and replace:
. Click the Find and Replace icon

. Enter the content that you want to search in the Find field.

. Enter the content that you want to replace in the Replace field.

o O T o

. Select any or all the following options to find and replace the content more effectively:
= Select the Case sensitive checkbox to find the content that is the exact letter
case of the content entered in the Find field.
= Select the Match entire cell contents checkbox to find and replace for cells that
contain only the characters that you have entered in the Find and Replace fields.
= Select the Search using regular expression checkbox to find and replace the pat-
tern that matches strings.
e. Click Replace to replace the individual instances.
f. Click Replace All to replace every instance of the content throughout the dataset.

Undos

a. Click the Undo icon 5

b. Select the recent changes from the list that you want to undo, and then click the list.
The Undo option undoes anything you do in the dataset. The CSV Editor saves the unlimited un-
do-able action. You can perform the undo action even after you save your changes made to the
dataset.

Redo C':"

a. Click the Redo icon & .
b. Select the recent changes from the list that you want to redo, and then click the list.
The CSV Editor saves the unlimited redo action.
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Options

Actions

Import

4

When you have a large amount of data stored in a CSV file, you can import that into a dataset in-
stead of creating a new dataset. You must have a .csv file that contains variable data to import
into a dataset.

b. Click Choose File and select the CSV file that you want to import in the Import File dia-

a. Click the Import icon

log box.
c. Select one of the following options to append or overwrite data in the dataset:
= Click Overwrite to add the rows and columns from the selected CSV file from the
beginning of the dataset.
= Click Append to add rows and columns from the selected CSV file to the end of
the dataset.
d. Select the First row contains headers checkbox if your CSV file contains the header.

Export

E.

You can export variable data from the dataset into a CSV file to reuse in future tests when re-

quired. You must have a dataset that you want to export.

Click the Export icon to download the dataset as a CSV file.

Set as cur-

rent row

During the test run, if you want variable data to be selected from a current row instead of the

first row in a dataset, right-click any cell in a row and select Set as current row.

Also, you can set the current row from the Datasets page by clicking Menu, and then the Config-
ure option.

When rows are deleted:

If you delete any row between row 1 to current row, the current row data is taken from the next
row. For example, when you set the current row as 6, and then you delete any row between row

1 to row 6, the current row remains at row 6, but the content of row 7 is moved to row 6.
When rows are inserted:

If you insert any new row between row 1 to the current row, the current row data is taken from

the previous row. For example, when you set the current row as 6, and then you insert any row

between row 1 to row 6, the current row remains at row 6, but the content of row 5 is moved to
row 6.

Dataset
configu-

ration set-

tings

In the Configure Dataset window, you can change the row and column settings and configure
the string values in the dataset that contains variable data for tests to use when they run.

a. Click the Menu icon , and then select the Configure option.

b. Select any of the separator values that you used in the CSV file.
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Options Actions
The available options are Comma, Semicolon, Space, Tab, and Other. In the CSV file, if
you have any other separator characters other than the available options, then you can
select the Other option, and then can specify a value.
For example, if the data in the CSV file is separated by a character #, then select the Oth-
er option and enter # in the field.
c. Configure the following options to change the row and column settings:
= Column header - Use an up-down control button to increment or decrement the
value of the column header.
= Data start point - Use an up-down control button to increment or decrement the
value of the data starting pointer.
= Current row - Use an up-down control button to increment or decrement the val-
ue of the current row.
d. Configure the following options to change the string values in the dataset:
= Treat as null - Enter a string value that is to be treated as null when running the
test.
= Treat as empty - Enter a string value that is to be treated as empty when running
the test.
For example, when you run the test and the data 723 in the dataset to be treated
as empty, then you can specify 723 in the Treat as empty field.
= Treat empty text as null - Select this field when you want the dataset that con-
tains any blank cells, and the value of those blank cells to be interpreted as null.
e. Click Update to apply the changes.
Discard ]
Q Click the Menu icon * and select Discard to discard the changes made to the dataset.

4. Click the Save icon to save the changes made to the dataset.

5. Click the Publish icon & to publish the dataset to the Git repository, and then close the CSV editor.

Results

You have edited the dataset.
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Dataset encryption
Encrypted datasets are useful when you want to run tests that contain confidential information such as a set of

passwords or account numbers.

When you run a test that uses an encrypted dataset, then you must provide an encryption key for decrypting the
encrypted data in columns so that the data can be used in the test. If the test uses data from the multiple encrypted
dataset columns, you must enter the same encryption key for every encrypted dataset column that the test uses.

When you run the test that uses the dataset with the encrypted column, the value of the column is decrypted at a run
time. The data in the column is sent as a clear-text string in requests to the server. The actual values of the encrypted
dataset variables are not displayed in the test log. The test log displays asterisks for the encrypted dataset variables.

You can use only one encryption key to encrypt data in the columns in any dataset.

! Important:

The encryption keys that you use to encrypt data in a dataset are not stored on the server nor can be retrieved
from the server. Therefore, you must remember to store the encryption keys in a secure location. You must

use the same encryption keys to perform the following operations:

« View the encrypted values
- Decrypt data

- Enable the use of the encrypted dataset during test runs

Encrypting a dataset column

To secure test data, you must encrypt datasets. You can encrypt data in the columns of a dataset by using an
encryption key. When you run a test that utilizes a dataset with encrypted variables, you must enter the encryption key
for the encrypted column that the test uses.

Before you begin
You must have created a dataset. See Creating a dataset on page 134.

. Go to the HCL OneTest™ Server URL.

. Enter your user name and password, and then click Login.

. Open your project from the HCL OneTest™ Server Ul.

. Go to the Datasets page and find the dataset that you want to encrypt.

a »h W N =

. Click the Edit icon ¢ from the Actions column of the dataset.

Result

The dataset opens in the CSV Editor in a web browser.
6. Right-click any cell in a column that you want to encrypt and select Encrypt column data.
Result
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The Encrypt Column window is displayed.

7. Enter an encryption key in the Encryption Key field to encrypt the data in the column.

n Remember: When you have already encrypted other columns in the dataset, you must enter the same
encryption key that you used previously. You can use only one encryption key to encrypt columns in a
dataset.

Important:

The encryption keys that you use to encrypt data in a dataset are not stored on the server nor can
be retrieved from the server. Therefore, you must remember to store the encryption keys in a secure

location. You must use the same encryption keys to perform the following operations:
o View the encrypted values
> Decrypt data

o Enable the use of the encrypted dataset during test runs

8. Click Encrypt Column.
Result
Asterisks are displayed instead of actual data for the encrypted column.

Results
You have encrypted the dataset column in your project.

What to do next
You can publish the dataset to the Git repository so that other members of the project can use the dataset. See

Publishing a dataset on page 143.

Decrypting a dataset column

To view the content of an encrypted dataset, you can decrypt the dataset column. Removing encryption from a

dataset revokes the protection offered to the test data.

Before you begin
You must have created at least one dataset and encrypted the dataset with an encryption key. See Creating a dataset

on page 134 and Encrypting a dataset column on page 141.

1. Go to the HCL OneTest™ Server URL.

2. Enter your user name and password, and then click Login.

3. Open your project from the HCL OneTest™ Server Ul.

4. Go to the Datasets page and find the dataset that you want to decrypt.

5. Click the Edit icon & from the Actions column of the dataset.
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Result
The dataset opens in the CSV Editor in a web browser.
6. Right-click encrypted cells that display the contents with asterisks, and then select Decrypt column data.
Result
The Decrypt Column window is displayed.
7. Enter the encryption key that you used to encrypt the data in the column in the Encryption Key field.
8. Click Decrypt Column.
Result

Asterisks are replaced with the actual data in the decrypted column.

Results
The encryption is removed from the selected column in the dataset. When you run a test that uses a dataset that
contains decrypted data, the variable data is substituted for the original data in the recorded test without prompting

for the encryption key.

What to do next
You can publish the dataset to the Git repository so that other members of the project can use the dataset. See

Publishing a dataset on page 143.

Publishing a dataset

When you create or edit any datasets in HCL OneTest™ Server, you can publish your changes to the Git repository.
Therefore, when you publish a dataset, other members in the project can use your dataset in their test assets run, if
required.

Before you begin
You must have created, edited, or deleted dataset assets in HCL OneTest™ Server.
About this task

The Changes page lists dataset assets that are modified. You can publish all datasets or a single dataset listed in the
Changes page to the Git repository by selecting the appropriate checkboxes.

Asset name a Change Last changed by Last updated Actions
ds_server Deletion v User1 a few seconds ago
Projectd/ds_servercsy
D31 Update v User1 a few seconds ago

Project1/DST.csv

HCL OneTest™ Server processes one publish request at a time. Therefore, when multiple users attempt to publish the
same dataset, the request that reaches first from the users is processed. The other users receive an error message,
and they are unable to publish.

When you modify the dataset and publish it to the Git repository, the other members who have access to that dataset
can view the updated dataset.

143



144

HCL OneTest™ Server

L]
You can also perform the following actions from the Changes page by clicking the Menu icon s.

« Edit - If you want to make any last-minute updates to the dataset before publishing.
- Discard - To remove the changes that you made to the dataset asset.

- Save As - To save a copy of dataset.

. Go to the HCL OneTest™ Server URL.

. Enter your user name and password, and then click Login.

. Open your project from the HCL OneTest™ Server Ul.

. Go to the Changes page, find the dataset that you want to publish.

. Select the checkbox that precedes the Dataset name to publish to the Git repository, and then click Publish.

o A WN =

. Enter a description for the changes made to the dataset, and then click Publish.
Result
A message is displayed for successful pushing of changes to the Git repository.

Results
You have published the modified dataset into the Git repository.

Viewing a dataset

When test assets includes datasets, you can view the contents of a dataset from HCL OneTest™ Server. The datasets
residing in the Git repository are listed in the Datasets page.

Before you begin

You must be a member of the project with the Owner or Tester role and must have completed the following tasks:

« Created a project in HCL OneTest™ Server. See Adding a project on page 660.
- Added a Git repository to your project. See Adding repositories to a server project on page 661.

« Created at least one dataset and encrypted the dataset with an encryption key. See Creating a dataset on

page 134 and Encrypting a dataset column on page 141.

- Created a classification for an encrypted dataset. See Creating a classification on page 687.

1. Go to the HCL OneTest™ Server URL.
2. Enter your user name and password, and then click Login.
3. Open your project from the HCL OneTest™ Server Ul.
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4. Go to the Datasets page, find the dataset that you are interested in, and then expand the dataset by clicking
the Expand icon .

Note: You can click the Dataset Name field to sort the datasets by name in alphabetical order.

Alternatively, you can use the Search field to search the dataset by name.

Results
You have viewed the contents of the dataset.

Viewing an encrypted dataset

You can use the Dataset page to view the contents of an encrypted dataset from HCL OneTest™ Server.

1. Go to the Datasets page, find the encrypted dataset that you are interested in, and then expand the dataset by
clicking the Expand icon .*.
2. Perform the following steps, if you have created a classification but yet to add the encrypted dataset to it:

a. Find the encrypted dataset that you are interested in, and then click the Lock icon EI from the Actions
column of the dataset.
b. In the Change the classification for the dataset window, select a classification from the list and enter
the encryption key set for the dataset.
c. Click Save to save the classification details.
3. Right-click the encrypted column and click Show encrypted data.
You can right-click the decrypted column and select Hide encrypted data to encrypt the data again.

! Important: The Show encrypted data option is available only when you have added the encrypted

dataset to the respective classification.

Results
You have viewed the contents of an encrypted dataset.

Changing classification for an encrypted dataset
To move the encrypted dataset from one classification to another, you can change the classification for an encrypted

dataset from the Dataset page.

Before you begin
You must have created at least two or more classifications. See Creating a classification on page 687.

1. Go to the Datasets page and find an encrypted dataset for which you want to change the classification.

2. Click the Lock icon ] from the Actions column of a dataset.

3. In the Change the classification for the Dataset window:
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a. Choose the classification from the list.
b. Enter the encryption key for the dataset that was set while encrypting the dataset column.
c. Save the classification details.

n Remember: You can perform this task only if you know the encryption key set for the dataset while
encrypting the dataset column.
Results

You have changed the classification for an encrypted dataset.

Related information

Managing an encrypted dataset on page 687

Creating a classification on page 687

Deleting a dataset

You can delete the dataset when it is not required in your test environment.

Before you begin

You must have at least one dataset asset in your Git repository that you have configured.
About this task

You can delete datasets in HCL OneTest™ Server in the following scenarios:

- Datasets that you created in the desktop clients and that are cloned to the repository in your project on HCL
OneTest™ Server.

- Datasets that you created in HCL OneTest™ Server and that are published to the repository in your project.

» Datasets that are in the . csv file format.
You cannot delete the following datasets:

« Datasets that you created or edited in HCL OneTest™ Server and that are not published to the repository in

your project.

» Datasets that are in the . si t file format.

1. Go to the HCL OneTest™ Server URL.

2. Enter your user name and password, and then click Login.

3. Open your project from the HCL OneTest™ Server Ul.

4. Go to the Datasets page, find the dataset that you want to delete.



Chapter 5. Test Author Guide

L]
5. Click the Menu icon & from the Actions column of a dataset, and then click Delete.
6. Clear the Publish delete to <branch name of the configured Git repository> checkbox to delete the dataset

from your project.

When you clear this option, the deletion of the dataset does not reflect in the configured Git repository.
Therefore, the other members of the project can still use the dataset that you have deleted. If you want, later

you can publish the dataset to the Git repository from the Changes page.
Note: By default, Publish delete to <branch name of the configured Git repository> field is selected.

7. Enter a description for deleting the dataset in the Description of change field.
8. Perform the following action:

Option When Action

Publish delete to <branch name of the config- | Selected ™| Click Delete and Publish

ured Git repository> Clearedd [Click Delete

Result

A message is displayed for the successful deletion of the dataset.

Generation of test data

To test an application, you use data that is passed to get real-time results. Since creating test data manually is time-
consuming, you can use HCL® OneTest™ Data, an automated tool to generate random test data. You can generate the

test data in various file formats.

Test data is a core element in the process of testing any application. A sufficient amount of data is necessary to test

all the possible scenarios of any application. HCL® OneTest™ Data requires a schema to generate the test data.

When you want to generate the test data, then you must fabricate a schema or generate a schema by using any
external resource. After you fabricated a schema, you must define types of the schema and set properties for each
type. You can then generate the test data for one or multiple schemas at a time. You must generate multiple schemas
in HCL® OneTest™ Data by using the schemas created in the JDBC supported databases.

Schema fabrication

A schema is a graphical structure to represent different types of data. You can fabricate a schema for the generation
of test data.

HCL® OneTest™ Data supports the following ways to fabricate the schema:
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- Import a schema from local file system into HCL® OneTest™ Data.
» Generate a schema in external resource by using HCL® OneTest™ Data.
« Create a schema by using HCL® OneTest™ Data.

You can fabricate a schema by using various methods. You can also manage the schema for your project to generate
the test data.

Schema import

HCL® OneTest™ Data requires a schema to generate the test data. If you have a schema in your local file system, then

you can import the same schema into your project.

HCL OneTest Data supports the import of the schema, which is either in JavaScript Object Notation (JSON) or XML
Schema Definition (XSD) file format.

After you import the schema, you can perform all the following tasks to the imported schema:

« Defining types

« Setting type properties
« Setting restrictions

- Applying functions

® Restriction: You cannot modify the properties of the types in an XSD or a JSON schema.

Importing XSD or JSON files from the local file system

When you have an XSD or a JSON format file in your local file system, you can import the same files from the local file

system into your HCL® OneTest™ Data project.

Before you begin

« You must have created a project.
 You must have an XSD or a JSON format file in your local file system.

About this task

XSD or JSON files are in schema format. To create a schema, you can import an existing schema that is in the XSD or

JSON format from your local file system.
® Restriction: You cannot modify all the properties of the types in an XSD or a JSON schema.

The following table shows the list of properties supported by JSON or XSD schema:
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Properties Read-only JSON schema Editable JSON schema XSD schema
JavaScript rules Yes Yes No
Regular expression Yes Yes No
Restrictions No Yes No
Default values No Yes No

Note:

If a schema that you import resembles the JSON structure, then that schema is represented as a read-only

JSON schema. However, when a schema that you import resembles the JSON data, then that schema is

represented as an editable JSON schema.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.

2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.
4. Click the Schemas tab.
5. Click XSD/JSON from the Schemas menu.

Result

The Import XSD/JSON dialog box is displayed.

6. Select the JSON or XSD file that you want to import.

7. Provide a schema name with a brief description and keywords as Tags.

8. Click OK and save the changes.

Results

You have successfully imported XSD or JSON files from the local file system.

What to do next

You must define the types in the schema. See Defining Types on page 157.

You can also perform the following actions:
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- View the imported file listed under the Schemas tab.
« Use the Search field to search for any schema from the existing schemas.
« Sort the list of schemas by name, folder, and recently used schemas.

Related information

JSON Schemas

Schema generation

When you want to generate the test data in any external resource, you must generate the schema by using that

specific resource.
To generate the schema, you must establish a connection between HCL® OneTest™ Data and the external resource.

HCL® OneTest™ Data supports the establishment of connections with the following external resources:

« Java Database Connectivity (JDBC)

« Systems, Applications, and Products in Data Processing (SAP)
* MongoDB

* Excel

Note: After you generate schema by using any external resource, you can perform all the following tasks to

the generated schema in HCL® OneTest™ Data:

« Defining types
« Setting type properties
» Setting restrictions

- Applying functions

The following topics show how HCL® OneTest™ Data connects with an external resource and generates the test data.

Tasks More information

Generate test data in JDBC-supported databases HCL OneTest Data support to write the generated test
data in JDBC-supported databases on page 177

Generate test data for SAP IDOC or DXOB HCL OneTest Data support to generate test data for an
SAP IDoc or DXOB file on page 184

Generate test data for SAP BAPI HCL OneTest Data support to generate test data for SAP
BAPI on page 187
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Tasks More information

Generate test data in MongoDB HCL OneTest Data support to write the generated test
data in MongoDB on page 191

Generate test data for an Excel file HCL OneTest Data support to generate test data for an
Excel file on page 196

Schema creation

When you do not have an existing schema or you do not want to generate a schema in any database, then you can

create a schema by using HCL® OneTest™ Data.

To create a schema, you need to design a schema by defining the types, setting the properties for each type of
schema, and designing a structural view of schema. You can also set restrictions or apply functions to the defined

types.

Composing a schema

To generate the test data, you require a schema. You can compose a new schema if you do not have an existing

schema or you do not want to generate the schema by using any external resource.
Before you begin

You must have a project.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click New from the Schemas. Otherwise, select Create a schema from Quick Links.
Result
The New Schema dialog box is displayed.
. Provide a schema name.
. Select the default project folder or enter any project folder name.

. Enter keywords as tags which can help for quick search.

0 N oo o

. Provide a brief description of the schema and click OK.
Result
The schema opens in the schema designer as Root as the data dictionary. You can view the schema name as

a tab in the workspace.

Results
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The schema is displayed in the schema designer.
What to do next

You must define the types in your schema. For information about defining types, see Defining types on page 157.

Importing data from local file system

If you have data or a sample file, you can import it into your project and can use that data to design a schema.

Before you begin

« You must have created a project.
 You must have a data file in your local file system in CSV or Excel files.

About this task

The Files tab on the Data Fabrication page is one of the design components of a project. By clicking this tab, you can
create a file. This tab helps you to import an existing file from the local file system, for which you want to generate

test data.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click the Files tab.
5. Click New from the Files to create a file.
Result
The New File dialog box is displayed.
6. Select a file that you want to import from your local file system.
7. Provide a name to a file, folder details, keyword as Tag for quick search, and a brief description of the file.

8. Click OK to import and create a file.

Results

You achieved the following results:

- View the list of all the files imported for this project in the Files tab.
« Use the Search field to search any file from the existing files.

« Sort the list of files by name, folder, and recently used files.

What to do next
After you have created a file into your project, you can import a file into schema designer to create a schema.

152



Chapter 5. Test Author Guide

Related information

Integrating sample files into a schema on page 165

Importing files into schema designer

To create a schema by using the data you imported, you must import the data file into schema designer.

Before you begin
You must have imported a data file into your project from the local file system.

About this task

When you want to create a schema, you require data. You can use the data which you have imported from your local

file system.

1. Click Import from the Schemas.
Result
The Import dialog box is displayed.
2. Select the file type as CSV.
3. Select the file that you want to import from the Sample File Path and define the import properties of the data.
4. Provide a schema name for this data and click Import.
Result
The schema appears in the schema designer.

5. Save the changes.

Results
You can view the imported file listed under the Schemas tab.

What to do next
You must define the types in the schema. For information about defining types, see Defining types on page 157.

Copying artifacts of a schema to another schema

When a schema in your project includes artifacts, and you want to reuse those artifacts in another schema in the

same project, then you can copy the artifacts of a schema to another schema by using HCL® OneTest™ Data.
Before you begin

You must have a schema in your HCL® OneTest™ Data project.

About this task

While you copy the artifacts of the schema, you can either create a schema or select an existing schema.
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® Restriction: You cannot copy an XSD or a JSON schema to another schema.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Open your schema from the Schemas tab.
5. Select a category, group, or item type from Dictionary, and then click Copy to Schema from the menu.
Result
The Copy Type dialog box is displayed.
6. Toggle the Create New Schema switch to select the destination schema. You can either create a schema or
select an existing schema.
Choose from:
> To copy the artifacts of a schema into a new schema, go to step 5.
> To copy the artifacts of a schema into an existing schema, go to step 6.

7. Copy the artifacts to a new schema by performing the following steps:
a. Toggle the Create New Schema switch to the on position to create a schema.
b. Enter a name for the new schema.
c. Toggle the Copy Child Types switch to the on position to copy all the child types of the selected type.

d. Toggle the Copy Referenced Types switch to the on position if you want to copy the types referenced

as the components of the group.
Note: The referenced types are always copied to the same path as the source schema.

8. Copy the artifacts to an existing schema by performing the following steps:
a. Toggle the Create New Schema switch to the off position to select an existing schema.
b. Select a schema from the Schema drop-down list.

c. Toggle the Retain Same Type Paths switch to the on position if you want to copy the types to the

same path in the destination schema.



Chapter 5. Test Author Guide

Note: If you toggle the switch to the off position, then you must provide the type path in the
Type Path field.

d. Toggle the Copy Child Types switch to the on position to copy all the types and the child types of the
selected type.

e. Toggle the Copy Referenced Types switch to the on position if you want to copy the types referenced

as components of the group.

f. Toggle the Overwrite Existing Types switch to the on position to overwrite the type in the destination

schema that already exists.

9. Click Copy.

10. Save the changes.

Results
You have successfully copied the artifacts of a schema into another schema.

Schema management

In a schema you can perform certain tasks such as editing and deleting of a schema. You can also split a schema

view.

Editing a schema

At any point in time, you can edit the details of a schema of your project.
Before you begin

You must have completed the following tasks:

- Logged into HCL OneTest™ Server.
« Created schemas in HCL® OneTest™ Data. See Schema fabrication on page 147.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click the Schemas tab to view the list of schemas.
5. Identify the schema that you want to edit.

6. Click the Menu icon %, and then click Edit.

Result
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The Edit Schema dialog box is displayed.
7. Edit the schema details and click OK.

Results

You have edited the selected schema.

Deleting a schema

If you do not need a schema anymore, you can remove that specific schema from your project.
Before you begin

You must have completed the following tasks:

« Logged into HCL OneTest™ Server.
+ Created schemas in HCL® OneTest™ Data. See Schema fabrication on page 147.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
. Click the Schemas tab to view the list of schemas.

. Identify the schema that you want to delete.

L ]
. Click the Menu icon %, and then click Delete.

. Click Yes to confirm and save the changes.

Results
You have deleted the selected schema.

Splitting a schema view

The schema designer displays a single schema. However, you can split the schema designer to view two schemas
simultaneously. This is useful for copying, editing, or viewing different components of very large schemas.

Schema design overview

When you compose a schema by using HCL® OneTest™ Data you must define the types of the schema. You can also
modify the types of the schema when you import any schema from local file system or use the schema generated by

using any external resource.

You can find information about the tasks that you must perform to design and create the structural view of the

schema in your project.
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Defining types

For optimum test data generation, you must define entire data of schema into types. Types are the components
of schemas. After you design schema in the schema designer, you must define entire data as types by using type

designer.

Adding types to a schema

The types in the schema are arranged in a hierarchy. A new schema by default has Root type. You can add subtypes

to the Root type to define a schema.

Before you begin
You have a schema for your project.

About this task

Types are the set of data objects. A new schema has a single Root type. All types are added as subtypes of the Root

type and then as subtypes of other types.

1. Select the type under which you want to add a subtype. For example, select "Root".
2. From the menu of the selected type, click Add.
Result
The subtype is created of the similar type as of the selected type and it appears under the selected type.

Note: You cannot add any type to a JSON or an XSD schema.

3. Save the changes.

Results
You can view the nested structure of types.

What to do next

You must define the properties of the types of the schema. For information about how to setup type properties, see
related links at the end of this page.

Copying a type

To create more types with similar properties, you can copy an existing type.
About this task

In addition to using the drag-and-drop method, you can use the menu to copy a type.

1. Select the type that you want to copy and click Copy from the menu.
2. Select the target type—the type under which you want to copy the given type.
3. Click Paste from the menu of the target type.
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Results
You can view a new type with the properties similar to an existing type.

What to do next
You can modify the name, description, and the properties of the copied type.

Deleting a type

When you want to remove any type from the schema, you can delete it.

1. Select the type that you want to delete and click Delete from the menu.
2. Click Yes to confirm and save the changes.

You can select more than one type simultaneously by using Multiselect option.

Note: You cannot delete any type of a JSON or an XSD schema.

Results
The selected type is deleted.

Related information

Objects, types, and classes on page 715

Setting type properties

After you add types to your schema, you must set type properties.

Before you begin

You must have a schema with types.

1. Select a type and click the menu of the type.
2. Click Properties.
Result
The Properties dialog box is displayed.
3. Enter the name, class, and description details of the type.
4. Choose the class of the type as Category, Group, or ltem.
Result
The properties of the selected type is displayed.
5. Define the required properties for the selected type.
6. Click Advanced properties to provide additional property details of the type.

You can set multiple properties for an item type.
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Note: If you want to import any JSON or XSD format schema, you cannot modify the properties of any

type of the schema.

7. Save your changes.

Results

You have set the type properties of schema and saved them successfully.

What to do next
When you finish setting the properties for all the types of your schema, you must prepare a structural view of the
schema by using the drag-and-drop method. See Designing a structural view of the schema on page 170.

Note:

If you set multiple properties for an item type, then HCL® OneTest™ Data considers the following order of

priority while executing the properties:

« Data generation for multiple schemas based on schema integrity
« Pairwise data property

* Property to set Javascript rules

« Setting output rule in Rule Editor

* Property to set Implied Default value

* Regular expression property

- Property to set weightage values by using a file

* Property to set restrictions

Read the following topics to understand how to set certain properties for any item type:

Related information

Type properties on page 715

Value assignation for item types

When you want to use specific item type values to generate the test data, then you can assign those values to the
item types. To assign the values to any item type, you can either import the item type values or add the values

manually.

Prerequisites

You must have completed the following tasks:
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« Created a project in HCL OneTest™ Server.
* Created a schema in HCL® OneTest™ Data.

You can assign values to any item type by using any one of the following methods:

« Assigning values for item types from a file on page 160

« Inserting values for item types manually on page 161

Assigning values for item types from a file

When a file contains values for an item type on your computer, then you can assign those values to the item type to

generate the test data.
Before you begin

You must have created a file with item type values on your computer.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
. Click Files and import the file of item type values from your computer into your project.
. Open your schema from the Schemas tab.
. Select the item type for which you want to assign the values.
. Select Restrictions from the Item Properties drop-down list of the Properties dialog box.

. Enable the Values from file toggle button.

O 00 N o o b

. Provide the details of the file that you want to use to get the values of the item type in the Values file field.
You can use any one of the following methods to provide the details of the file:
Choose from:
> Upload the file from your computer.
> Provide the name of the imported file with an extension.
10. Enter the column number of the file where the item type values are specified in the Values column number
field.

11. Save the changes.

Results
You have successfully assigned the values for item types from a file.
What to do next

You must prepare the structural view of the schema. See Designing a structural view of the schema on page 170.
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Inserting values for item types manually

When you want to assign specific values to an item type that does not exist in any file on your computer, then you can

assign those values by inserting them manually.

N o o0 b

9.

. Login to HCL OneTest™ Server and open the team space that contains your project.

. Open your project.

Result

The Overview page is displayed.

. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.

. Open your schema from the Schemas tab.
. Select the item type for which you want to assign the values.
. Assign a default value or multiple values.

. Perform the following steps to assign a default value to the item type:

a. Select Item Properties from the Properties dialog box.

b. Click the Advanced Properties icon

c. Enter a default value in the Implied Default field.

. Perform the following steps if you want to assign multiple values to the item type:

a. Select Restrictions from the Item Properties drop-down list of the Properties dialog box.
b. Click Include.

c. Enter the value for the selected item type in the first row.

d. Optional: Click Description to provide the details of the values of the item type.

: 4

e. Click Menu * , and then click the Value include restrictions icon “™ to add another row.

Save the changes.

Results

You have successfully inserted the values for item types manually.

What to do next

You must prepare the structural view of the schema. See Designing a structural view of the schema on page 170.

Setting weightage values

You can set weightage values for an item type to determine how often the value of that item type can be displayed in

the generated test data.

Before you begin
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» You must have a project and a schema.

- You must have created a weightage file that can be of CSV or Microsoft Excel Open XML format.

Note: The weightage file consists of one column for values of item types and another column for

weightage values for each item type value. The weightage values must be integers.

About this task

The property of weightage values is set as a restriction on an item type. The probability to get higher accuracy

increases in the results of the weightage values in the following scenarios:

» When HCL® OneTest™ Data processes a large amount of data.

» When there is a large difference between the weightage values.

Computation of weightage value

The probability of occurrence of any item type value in the generated test data can be computed by using the
following formula:

Probability of occurrence of any item type value = Weight of each item type value / Total weight of all
the ditem type values

The following table shows an example when you have a weightage file with five item type values and its

corresponding weightage values:

Item type values Weightage values
Red 50000
Bl ue 5000
Green 500
Orange 50
Purpl e 5

The total weightage value of all the item type values = 50000 + 5000 + 500 + 50 + 5 = 55555.

The probability of occurrence of each item type value in the generated test data can be computed as shown in the
following table:

Item type values Probability of occurrence Computed values
Red 50000/ 55555 0.9
Bl ue 5000/ 55555 0.09
Geen 500/ 55555 0. 009
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Item type values Probability of occurrence Computed values
Orange 50/ 55555 0. 0009
Purpl e 5/ 55555 0. 00009

From the computed values, Red has a higher probability value than other colors.

When you use this weightage file to set the weightage value for any specific item type and generate the test data, then

you can find the generated test data with more occurrences of Red as compared to the other colors.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.

0 N o o b

9.
10.
11.
12.

. Open your project.

Result
The Overview page is displayed.

. Click Author > Data Fabrication.

Result
The Data Fabrication page is displayed.

. Click Files and import the weightage file from the local file system into your project.

. Open your schema from the Schemas tab.

. Select the item type on which you want to apply the weightage value.

. Select Restrictions from the Item Properties drop-down list of the Properties dialog box.
. Enable the Values from file toggle button.

Provide the name of the weightage file in the Values file field.

Enter the column number in Values column number and Weights column number.
Click Save.

Select the group and generate the test data.

Results

You can view more occurrences of the values that are set with higher weightage values as a result of the test data

generation.

What to do next

You must prepare the structural view of the schema. See Designing a structural view of the schema on page 170.

Related information

Value assignation for item types on page 159

Setting regular expressions

When you want values of an item type to appear in a certain pattern in the generated test data, you must set the

Regular Expression property for that item type in a defined schema.
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Before you begin

 You must have logged in to HCL OneTest™ Server.
 You must have created a project and a schema.

About this task

The regular expression is a special text to describe a pattern. For example, you can specify regular expressions for

email address, phone number, or website. HCL® OneTest™ Data provides you some sample regular expressions.

To set regular expressions to any item type, you can either insert a value or select from the sample list of regular
expressions that best suits your testing requirements. HCL® OneTest™ Data then validates the value you inserted for

the Regular Expression field and generates the values of the selected item type in a similar pattern.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Open your schema from the Schemas tab.
5. Select the item type for which you want to set regular expressions.

6. Click Regular Expression from the Properties dialog box.

The sample list of regular expressions is displayed.

7. Set the regular expression in the Regular Expressions field by using any one of the following methods:

o Type the regular expression. HCL® OneTest™ Data then validates the regular expression.

For example, [ 0-9] {18}

0 Tip: If you want to reuse the validated regular expression then click Add to sample list, to add

the expression in the list.

> Select the regular expression from the sample list. The selected regular expression is displayed in the
Regular Expressions field.
8. Click Save.

Results
You have successfully set the regular expression for the selected item type.
What to do next

You must prepare the structural view of the schema. See Designing a structural view of the schema on page 170.
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Related reference

Regular expressions on page 739

Integrating sample files into a schema

When you want to generate the test data, you must define a schema. HCL® OneTest™ Data provides sample files with

item type values so that you can integrate the sample file into a schema by mapping it to any item type.

Before you begin

« You must have logged in to HCL OneTest™ Server.
« You must have created a project and a schema.

About this task

The Files tab on the Data Fabrication page is one of the design components of a project. From the Files tab, you can

integrate a file into a schema by using any one of the following options:

- Create a file by retrieving the data.
« Upload a file from the local file system.
» Use any sample file.

Sample files contain the values for a specific item type. The sample files are in CSV and Excel file formats. You can

map these sample files to an item type in a schema.
Note: You can map only one sample file to one item type in a schema.

You can use the Search field to search for any specific sample file from the Sample Files list. After you select a

sample file, you can use the menu to manage the file for the following actions:

- Edit: You can modify the file name and the description of the selected sample file.
« Delete: You can delete the selected sample file from the list of files you can view in the File tab.
» Download: You can download the selected sample file into your local file system.

Note: If you want to modify the selected sample file, you must first download the file into your local file
system, and then edit the file for changes.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

165



166

HCL OneTest™ Server

Result

The Data Fabrication page is displayed.
4. Click Use sample from the Files tab.

The Sample Files dialog box is displayed.

5. Select one or more sample files that you want to import into your project, and then click Select.

6. Click the Files tab, and then download the selected sample file that you imported into your project.

Note: You can open the sample file and check the column number of the file that you want to map
with the item type.

7. Open your schema from the Schemas tab.
8. Select Restrictions from the Item Properties drop-down list of the Properties dialog box.
9. Enable the Values from file toggle button.
10. Provide the file name of the selected sample file with an extension in the Values file field.
11. Enter the column number of the sample file where the item type values are specified in the Values column
number field.
12. Click Save.

Results

* You can view the list of all the sample files you have selected in the Files tab.

- You have successfully integrated the sample file into a defined schema.
What to do next
You must prepare the structural view of the schema. See Designing a structural view of the schema on page 170.

Adding JavaScript rules

When you have a JavaScript file with defined rules to create values for any item type, then you can add the JavaScript

rules to create the values for the mapped item type.

Before you begin

« You must have created a project and a schema.
 You must have created a JavaScript file with defined rules in your local file system.

About this task

If you want to add the JavaScript rules to create the values for the mapped item type, then you must use the following

command to define the rules in the JavaScript file:

function getData()

You can additionally set any one of the following properties for the mapped item type by using the JavaScript rules:
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» Regular expression: The JavaScript rule uses the regular expression that you enter in the Properties dialog
box as an input for the regular expression rule.

- Seed value: The JavaScript rule uses the seed value that you enter in the Generate Data dialog box as an input
for the seed value rule.

To set either regular expression or seed value property, you must define the rules in the JavaScript file by using the

following commands:

Property Command Parameter description

Regular expressions function getData(param) (param): Represents the regular expres-
sion pattern in the Regular Expression
field.

Seed value function getData(param) (param): Represents the seed value in the
Numeric Seed Value field of the Generate
Data dialog box.

Note: If you set the values for both regular expression and seed value properties in HCL® OneTest™ Data and
define the rule in the JavaScript file by using the command function getData(param), then only the value set

for regular expression property is accepted while creating the item type values.

After you define rules in the JavaScript files, you can import the JavaScript file from your local file system into your
project, and then map the file to any item type in a schema.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
. Click Files and import the JavaScript file from the local file system into your project.
. Open your schema from the Schemas tab.
. Select the item type for which you want to create the values by using the JavaScript file.
. Select Item Properties from the drop-down list of the Properties dialog box.

o N o o b

. Select Text in the Item Subclass field.

O

. Click the Advanced Properties icon [:] 3
10. Optional. Provide the pattern in the Regular Expression field, if you want to set the regular expression for the
mapped item type.

11. Provide the name of the JavaScript file with an extension in the JavaScript Name field.
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! Important: You must enter the correct file name of the JavaScript file that you imported into your

project. For example, address. j s.

12. Click Save.

Results
You have successfully added the JavaScript rules for the item type.
What to do next

You must prepare the structural view of the schema. See Designing a structural view of the schema on page 170.

The pairwise data generation method

When you test any application, you might want to ensure that the test data that you use covers all possible
combinations of item type values. To achieve this goal of maximum coverage of all possible scenarios, you must
apply the pairwise data generation method on the required item types of a schema.

For testing any application, you must attain the maximum test coverage. You can achieve the maximum test coverage
and discover more defects with less effort and time by applying the pairwise data generation method. The pairwise
data generation method in HCL® OneTest™ Data helps to generate all the possible combinations of the item type
values for each pair of item types. The use of this method decreases the number of the generated test data but

covers all the possible combinations of the item type values.

For example, consider that there are three item types in a schema such as a list box with five values (zero, one, two,
three, four), one radio button with two values (selected or unselected), and one check box with two values (selected
or cleared). Therefore, the combination becomes 5x2x2 as the generated test data, which is equal to 20 values. These
20 values are required to cover all combinations of the item types of the schema without applying the pairwise data
generation method. After you apply the pairwise data generation method, you can observe that the generated test
data comprises all combinations of item type values for the three pairs of item types among the three item types.
This pairing of item types results in 12 combinations of values of the generated test data.

For more information about how to set the pairwise data generation method in HCL® OneTest™ Data, see Setting the
pairwise data property on page 168.

Setting the pairwise data property

When you want to generate an optimum test data that covers all possible combinations of item type values for each
pair of item types in a schema, you can set the pairwise data property for those item types.

Before you begin

You must have completed the following tasks:
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« Created a schema in HCL® OneTest™ Data.
* Read the details about how to assign the values to an item type. See Value assignation for item types on
page 159.

About this task

The pairwise data generation method is a combinational method to find all the possible values of the selected pairs
of item types. The pairwise data generation method is efficient when you have a large number of item types and the
item type values in a schema. When you apply the pairwise data generation method in such cases, the number of
generated test data decreases drastically although covering all the combinations. To implement the pairwise data
generation method, you must have multiple item types in a group type of a schema. To assign item type values, you

must either import the values of item type from a file or insert values for each item type.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
. Open your schema from the Schemas tab.
. Select the item type from Dictionary for which you want to set the pairwise data property.
. Select Restrictions from the Item Properties drop-down list of the Properties dialog box.

N o o b

. Set values for the selected item type by using any one of the following methods:
Choose from:
° Import item type values from the file by using Values from file.
o Include values for the selected item type in the Properties dialog box.
8. Save the changes.

9. Select Item Properties from the drop-down list of the Properties dialog box.

10. Click the Advanced Properties icon E] 3
11. Select Yes from the Pairwise Data drop-down list.

169



HCL OneTest™ Server

Note: The default value of the Pairwise Data drop-down list is No.
12. Save the changes.

! Important: You must select multiple item types to apply the pairwise data generation method.

Note: When you want to apply the pairwise data generation method for each item type, you must
repeat step 4 through step 10.

Results

You have successfully set the pairwise data property for the selected item type.

What to do next

You must select a group type to generate the test data of a schema. See Generating test data on page 200.

Note: The group type that you select to generate the test data can comprise both the item types set for the
pairwise data property and the item types that are not set for this property.

! Important: When you generate the test data for a group type with a few or all of the item types set for the
pairwise data property, then during the test data generation, the value you enter for the Number of records
field is ignored. Based on the pairwise data property, HCL® OneTest™ Data auto calculates the number of
records.

Related information

Value assignation for item types on page 159

Designing a structural view of a schema

To define how the item and group types are organized and are related to each other, you must design the structural

view of a schema before generating the test data.

Before you begin

You must have a group type in your schema.

About this task
When you design the structural view of a massive schema, you can filter the item or group types of your schema by
using Filter.
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1. Double-click any group type from Dictionary.

Alternatively, you can click the menu of the selected group, and then select Structure.

Result
The Structure dialog box appears.
2. Drag and drop the types from Dictionary to the Structure dialog box to map Item and Group types.

Note: You can use the Category type to organize the data dictionary entities. You cannot map the
Category type in the structure view.

3. Save the changes.

What to do next
You can set restrictions and apply functions to define the component rules to any item type. You can also generate

the test data without applying restrictions and functions. See Generating test data on page 200.

Setting a range

After you define the structure of a schema, you can set a number range to specify the number of occurrences to

generate an item type in the test data.

Before you begin

« You must have a group type in your schema.
 You must have a structural view of your schema.

About this task

You can set the number range only for item types and group types of your schema.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Select the generated schema from the Schemas tab.

For example, schema_<number>

5. Click the Menuicon *  of the group type of the schema and select Structure.

The structural view of the schema is displayed.
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6. Click the Menu icon

occurrences of the item types in the generated test data.

of all item types in the Structure dialog box to set the restriction for several

You can set the following restriction rules:
> Set Optional
- Set Required
- Set Range
> Set Unlimited

In the following table, you can find the value of the minimum and maximum occurrences that you can set as
restrictions for the item types:

Item properties Minimum occurrences Maximum occurrences
Optional 0 1 or more
Required 1 1
Unlimited 1 1 or more
Set Range Any minimum value Any maximum value

Note: Minimum value
should be equal to or less

than the maximum value

7. Save the changes.

You can modify the properties of the selected item type by using Properties in the context menu.

Results

You have set the number range for the selected item types.

What to do next
You can apply functions to define component rules to any item type. You can also generate test data without applying

functions. See Generating test data on page 200.

Related information

Restrictions settings on page 776

Applying functions

You can apply functions on the item types of a schema to define the component rules.
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Before you begin
You must have a defined schema in a schema designer. See Schema design overview on page 156.
About this task

You can also apply functions on the types of the imported JSON or XSD schemas.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
. Click Schemas, and then select the schema for which you want to generate the test data.
. Select the group type, and then open the structural view of the schema.

. Select the item type on which you want to apply the function, in the Structure dialog box.

N o o0 b

. Click the menu on the right side of the Structure dialog box.
Result
A blank field is displayed next to the item type.
8. Click the blank field.
Result
The Rule Editor pane is displayed on the page.
9. Enter the equal sign (=) in the Rule Editor pane.

10. Provide the function in the Rule Editor pane.

You can enter the function by performing any one of the following methods:

Choose from:
o Enter the function manually.
> Select from the list of functions by using the following steps:

a. Click the Insert mapping functions icon fx.
b. Select the function that you want to apply as a component rule, and then click Insert from the

menu of the selected function.

For example, if you want the generated value of an item type in uppercase, then you must enter or select the
UPPERCASE() function.

=UPPERCASE( RANDDATA( ) )
11. Optional: Enter a parameter for the selected function.

You can provide the parameter value either as a constant value or as a reference of the item type.

You must use the following syntax to provide the parameter in any function:
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<item type name>: Qut1l
where:

o item type name - Represents the name of the item type.
o : Qut 1 - Represents a standard output argument.

For example, consider that you have a group type as Fl ower s with Col ors and Pat t ern as two item types. If
you want to generate the value of col or s item type in uppercase, then you can select the item type Pattern in
the Structure dialog box. You must open the Rule Editor pane, and then select the upPERCASE() function with
reference of col or s item type as the parameter.

= Uppercase (Col ors: Qut1)

12. Press the Enter key.

Result

The selected function is displayed in the item type field of the Structure dialog box.
13. Save the changes.

Results
You have successfully applied the function on an item type of the schema.

What to do next
You can generate the test data for the designed schema. See Generating test data on page 200.

Related information

Functions and expressions on page 815
Designing a structural view of a schema on page 170

Setting a function to concatenate the values of item types on page 174

Setting a function to concatenate the values of item types

You can set a function to concatenate the values of multiple item types so that the values are displayed as the value

of another item type.
Before you begin

You must have completed the following tasks:

« Defined a schema. See Schema design overview on page 156.

« Created the structural view of the schema. Designing a structural view of a schema on page 170.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
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Result

The Overview page is displayed.

. Click Author > Data Fabrication.

Result
The Data Fabrication page is displayed.

. Click Schemas, and then select the schema for which you want to generate the test data.

5. Open the structural view of the schema.

11.

12.

! Important: You must have all the item types in the same group type for the values that you want to

concatenate.

Result

The Structure dialog box is displayed.

. Select the item type for which you want the values of the generated test data in the concatenated format.

Note: You must not place the item type, for which you want the values in the concatenated format, in

the same group type.

For example, consider that a schema includes a group type, gr oup_nane1 and three item types such asitem
typel,item type2, anditem type3. If you want to concatenate the values of i tem t ype1 and i t em t ype2 as the
generated value of i t em t ype3, then you must add i t em t ype1 and i t em t ype2 item types in the gr oup_nane1

group type. You must ensure that i t em t ype3 does not exist in the gr oup_name1 group type.

. Click the menu on the right side of the Structure dialog box.

Result
A blank field is displayed next to all the item types.

. Click the blank field of the item type for which you want to set the function for concatenation.

Result

The Rule Editor pane is displayed on the page.

. Enter the equal sign (=) in the Rule Editor menu.

. Select the serl EsTOTEXT() function from the Insert mapping functions Jx icon.

Note: You can also provide the following rule manually in the Rule Editor pane: "item typel" + "item

type2".

Provide the name of the group type as the parameter for this function.
For example, if you have a gr oup_nare1 group type, then you must provide the following function:

SERI ESTOTEXT( gr oup_namedl: OUT1)

Press Enter.

Result
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The selected function is displayed in the item type field of the Structure dialog box.

13. Save the changes.

Results
You have successfully set the function to concatenate the values of multiple item types.

What to do next
You can generate the test data for the designed schema. See Generating test data on page 200.

Related information

Functions and expressions on page 815

Test data generation from structured schemas

When you want to test your application by using randomly generated test data, then you must generate the test data

from the structured schemas.

You can generate the test data for schemas that you import, create, or generate in HCL® OneTest™ Data by using any
external resource. You can generate the test data simultaneously for multiple schemas that are related to each other
through common item types. The item types of the child schema refer to the item types of the parent schema. After
you view the relationship among the selected schemas, you can generate the test data. When you generate the test
data by using the related schemas, the generated values of referring item types of the child schema are available in

the generated values of the referred item types of the parent schema, based on referential integrity.

You can also establish or delete parent and child relationships among multiple non-JDBC schemas, based on

referential integrity.

Notes:

- When you generate the test data by using multiple schemas, you must select either JDBC-supported
or non-JDBC schemas.
« If you generate the test data for JDBC-supported schemas, then all the selected schemas must be

generated from the same JDBC connection.

When you generate the test data for JDBC-supported schemas, then you can either download the generated test data
or can insert it into the connected database. You can insert the test data into the following databases if there is a

successful connection between HCL® OneTest™ Data and the database:

» JDBC-supported databases
» MongoDB
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HCL OneTest Data support to write the generated test data in JDBC-supported
databases

When you want the generated test data in any Java Database Connectivity (JDBC) supported database, you can
generate the test data by using HCL® OneTest™ Data. Subsequently, HCL OneTest Data inserts the generated test
data directly in the configured JDBC-supported database.

To enable HCL® OneTest™ Data to write the generated test data in the database, you must create a sample schema
with tables in the installed JDBC-supported database, establish a connection with the installed database, select the

generated schema in HCL® OneTest™ Data, and then generate the test data of the selected schema.

HCL® OneTest™ Data supports the following JDBC-supported databases:

« |IBM DB2
» MySQL Server
« Microsoft SQL Server

« Oracle database
HCL® OneTest™ Data supports the test data generation for the following data types:

* INTEGER
* VARCHAR
* CHAR

* DATETIME
« DATE

* TIME

« BOOLEAN

Note: You must add the restriction values for BOOLEAN data type as 0 and 1.

Prerequisites

The following prerequisites must be met to enable HCL OneTest Data to write the generated test data:

* You must have access to HCL OneTest™ Server.

 You must have installed a JDBC-supported database.

Task flow

You must perform the following tasks in sequence to enable HCL OneTest Data to write the generated test data
directly in the JDBC-supported database. The table also provides you the links to the information about the tasks.
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Task More Information

Create a sample schema in a database
Creating a sample schema in a database on page 178

Establish a JDBC connection with HCL OneTest Data
Establishing a JDBC connection with HCL OneTest Data

on page 180

Generate a schema in HCL OneTest Data
Generating a schema in HCL OneTest Data on

page 181

Insert the generated test data in the database
Inserting the generated test data in a database on

page 183

Creating a sample schema in a database

To generate a schema in HCL® OneTest™ Data, you must create a schema with a table in the database.

About this task
After you download the connector jar files of the JDBC-supported database, you must copy the jar files from your
computer to the pods such as HIP REST and HIP Server. These pods are responsible for the following actions:

* HIP Server is responsible to establish a connection with the JDBC-supported database. This pod also
generates a schema by using the tables of the database. The structure of a schema is a flat hierarchy, where
all the item types are in a single group called a Row. The item types in a schema refer to the columns of the
table.

» HIP REST is responsible to run the map and generate the data. This pod also writes the generated data to the

JDBC-supported database.

Both the pods use the connector jar file to communicate with the JDBC-supported database.

You can download the connector jar files from the following locations:

Connector jar Location
Mysql Server connector jar https://dev.mysqgl.com/downloads/connector/j/
Microsoft SQL Server connector jar https://docs.microsoft.com/en-us/sql/connect/jd-

bc/download-microsoft-jdbc-driver-for-sql-serv-

er?view=sql-server-ver15

IBM DB2 https://www.ibm.com/support/pages/db2-jdbc-dri-

ver-versions-and-downloads
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1. Download the JDBC-supported database connector jar file to your local file system.
Note: You must download the connector jar file that is compatible with the database server.

2. Copy the connector jar file from your local file system to the pods by using the following commands from the
command prompt.

For example, run the following commands if you are using the MySQL database:
For HIP REST

kubect| cp /<source path>/nysql-connector-java-8.0.19.jar {ny-ots}-<hip rest podname>:/opt/runti me/

extjar/ mysqgl -connector-java-8.0.19.jar -n test-system
For HIP Server

kubect| cp /<source path>/nysql-connector-java-8.0.19.jar {ny-ots}-<hip server podnanme>:/opt/hcl/hip/

extjar/ mysqgl -connector-java-8.0.19.jar -n test-system

Notes:

- Depending on the database you use, you must copy different connector jar files to the pods.
> While copying the jar files to the pods, you must ensure that the names of pods are same as

those installed on HCL OneTest™ Server.

For example:
= HIP Rest is displayed as { ny- ot s} - hi p-rest - 6757¢99d9- 4qj t |
= HIP Server is displayed as { ny- ot s} - hi p- ser ver-0
> When you install or restore HCL® OneTest™ Data, you must copy the connector jars files again.

3. Create a schema with a table in the database by using the following commands from the command prompt.

For example, you can use the following command to create a table in a schema:

create schema <schema_name>;
use <schema_name>;
CREATE TABLE IF NOT EXISTS <table_name> (
Columnl <DataType> Constraint,
Column2 <DataType> Constraint,
Column2 <DataType> Constraint,,,,,,

)3

n Remember: In HCL® OneTest™ Data, you must refer to the schema name and the table name that you
created by using this command.

Results

You have created a sample schema with a table in the database.
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What to do next

After you create a schema in the database, you must establish the connection between HCL® OneTest™ Data and the
JDBC-supported database. See Establishing a JDBC connection with HCL OneTest Data on page 180.

You can view the schema name that you created in the database as the value of the Catalog or Schema property in
HCL® OneTest™ Data.

Establishing a JDBC connection with HCL OneTest Data

You must establish a connection between HCL® OneTest™ Data and the JDBC supported database to generate the

schema and to write the generated test data in the database.
Before you begin

You must have created a sample schema in the database. See Creating a sample schema in a database on
page 178.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click New from the Connections tab to create a new connection.
5. Select JDBC as a connection type and click Next.

6. Enter the following properties of the connection in the Properties dialog box.
a. Enter the URL of the database.
You must provide the URL in the following format:
j dbc: <Dat abaseType>: / / <Host Name/ | PAddr ess>: <Por t Nunber >/ <Cust onSet ti ngs>

For example, the URL for a MySQL database server can be j dbc: mysql : // 10. 0. 2. 15: 8081 or for
a Microsoft SQL database Server can be j dbc: sqgl server://10. 134.59. 16: 1433.

Notes:

= When you want to establish a connection with IBM DB2, you must provide the database

name as the <cust onset ti ngs>.
For example, the URL for IBM DB2 can be j dbc: db2://10. 134. 59. 16: 50000/
testdb.

= When you want to establish a connection with an Oracle database, you must enter
details in the following format:
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j dbc: <Dat abaseType>: <cl i ent _Type>/ / <Host Nane/
| PAddr ess>: <Por t Nunber >: <Ser vi cel I Ser vi ce_Nane>

For example, j dbc: or acl e: t hi n: @0. 543. 89. 22: 1521: ORCLCDB.

You can get the details of the service ID or service name from the properties of the
Oracle database that you set up.

b. Enter the name and password to access the database.

7. Click Test to verify whether the connection is established successfully.

Note: If the connection fails to establish, it can be because of any of the following reasons:
o Mismatch in the version of the drivers.
> Unreachable database.
> Missing database.

> Unsuccessful copying of the connector jar file.
You can run the following command to check the logs of HIP Server to get more information about the reason

of failure:

kubect!| 1ogs {my-ots}-hip-server-0 -n test-system

Results

You have successfully established the connection between HCL® OneTest™ Data and the database.
What to do next

You must provide a name for the connection, and then generate a schema. See Generating a schema in HCL OneTest

Data on page 181.
Generating a schema in HCL OneTest Data
After you establish the connection between HCL® OneTest™ Data and the JDBC-supported database, you can

generate a schema in HCL® OneTest™ Data from the configured database.

1. Click the Connections tab and select the connection that you created.

2. Click the context menu and select New Action.

3. Select Target as the Action Type in the New Action dialog box and click Next.

4. Enter the following properties of the schema that you want to generate, and then click Next.
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Properties Actions Required/Optional

Target Required
Select the target as Table that you created in

the database from the list.

Catalog Required
Select the schema that you created in the data-

base from the list.

Schema Optional
Select the schema that you created in the data-

base from the list.

The name of schema is displayed either in the
Catalog or in the Schema field for the selected

database.

Table Required
Select the table that you created in the data-

base from the list.

Note: You can click the Advanced Properties icon to set the additional properties of the schema.

5. Click Generate.

The schema is generated in HCL® OneTest™ Data by using the schema you created in the database. HCL®

OneTest™ Data generates the schema name as schema_<number>.

Note: You must select this schema name as the schema for HCL® OneTest™ Data to generate the test
data.

6. Select the schema type as Row and click Next.
7. Provide the identification details of the new action, and then click OK.

The new action is created and is listed under the JDBC connection.

Results

You have successfully generated the schema in HCL® OneTest™ Data.

! Important: If you want to generate schemas for other tables in the same database, then instead of creating a

new connection, you must click New Action on the existing JDBC connection.

What to do next
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You can provide the action name under the Identification dialog box, and then generate the test data in the database.

See Inserting the generated test data in the database on page 183.

Inserting the generated test data in a database

After you generate the schema from the configured database in HCL® OneTest™ Data, you can directly insert the

generated test data into the database.
Before you begin

You must have generated the schema by using the database. See Generating a schema in the database on
page 181.

1. Select the schema that you generated with the following name from the Schema tab:

schema_<number>

2. Click the menu of the group type of the schema and select Structure.

You can view the list of all item types associated with the selected group type in the structure view.

3. Click the menu for all the item types to set the property as Set Required, and then click Save.
Note: If you have a numeric item type, you must set Min size (digits) and Max size (digits) properties.

For example, when you select I nt eger as Presentation then you can set the Min size (digits) as 1 and the Max
size (digits) as 9.

4. Select the group type in the Dictionary dialog box and click Generate Data from the menu.

The Generate Data dialog box is displayed.

5. Select the Connection option and provide values for the Number of records and Numeric Seed Value.

The seed value acts as an instance of random data that can produce the same set of data multiple times. By

default, the seed value is blank.

Note: The following table lists the maximum values for numeric seed value and number of records:

Description Maximum values
Numeric Seed Value 8 digits (99,999,999)
Number of records 9 digits (999,999,999)

6. Select the connection type from the list, and then click OK.
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Results
You have successfully inserted the generated test data from HCL® OneTest™ Data in the JDBC supported database.
What to do next
You can click the Jobs tab to view the status of the job. The tooltip of the job displays the following details:
» URL of the connection.
» Name of the table.

- Schema name from which the test data is generated.

Important:

You cannot download the generated test data from the Jobs page because the test data is written to the
configured database and is not available in HCL® OneTest™ Data.

You can log in to the configured database to view the generated test data.

HCL OneTest Data support to generate test data for an SAP IDoc or DXOB file

When you want to generate the test data for an SAP Intermediate Document (IDoc) or Data Transfer Object (DXOB)
file, you can generate a schema in HCL® OneTest™ Data by using the structured schema of the SAP IDoc or DXOB file.
You can then generate the test data by using the generated schema in HCL® OneTest™ Data.

The SAP applications provide file-based interfaces, such as the SAP IDoc and DXOB interfaces. The SAP IDoc
interface supports Application Link Enabling (ALE) and Electronic Data Interchange (EDI) file formats, and the SAP
DXOB interface supports the DXOB files.

You must perform the following tasks to generate the test data for any SAP IDoc or DXOB file:
« Schema generation for an SAP IDoc or DXOB file on page 184

« Generating test data on page 200

Related information

SAP applications on page 707

Schema generation for an SAP IDoc or DXOB file

When you want to generate the test data for an SAP IDoc or DXOB file, then you must generate a schema for the
selected SAP IDoc or DXOB file.
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The SAP IDoc or DXOB file is a standard data structure in SAP applications to transfer data between SAP system
applications and external resources. Every SAP IDoc or DXOB file has a unique number.

If you have an SAP IDoc or DXOB file that you want to use for test data generation in your local file system, then you
must import the file into your HCL® OneTest™ Data project. After importing the file, you must establish a connection
between the SAP IDoc or DXOB interface and HCL® OneTest™ Data. The established connection helps to transfer and
interpret the data of the imported SAP IDoc or DXOB file. The interpreted information then helps HCL® OneTest™ Data

to generate a schema.

You must perform the following tasks to generate a schema in HCL® OneTest™ Data for the SAP IDoc or DXOB file:

Importing an SAP IDoc or DXOB file

When you want to establish a connection with an SAP IDoc or DXOB interface, you must import the SAP IDoc or DXOB
file into your HCL® OneTest™ Data project from your local file system.

Before you begin

You must have completed the following tasks:

- Created a project.
« Created the SAP IDoc or DXOB file in your local file system.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Files, and then click New to import the SAP IDoc or DXOB file from the local file system into your project.

Results
You have successfully imported the SAP IDoc or DXOB file from the local file system into your project.

What to do next
You must establish a connection between the SAP IDoc or DXOB interface and HCL® OneTest™ Data. See
Establishing an SAP IDoc or DXOB interface connection with HCL OneTest Data on page 185.

Establishing an SAP IDoc or DXOB interface connection with HCL OneTest Data

When you want to generate a schema for an SAP IDoc or DXOB file, you must establish a connection with the SAP
IDoc or DXOB interface.

Before you begin
You must have imported the SAP IDoc or DXOB file into your project.
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1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Connections.

5. Click New to create a new connection type.

The New Connection dialog box is displayed.

6. Select SAP IDoc from the Type drop-down list, and then click Next.
7. Set the following properties under Connection Properties:

> Enable Bypass Client Connection.

o Select 2 (uni code) as Bytes Per Character.
8. Click Next, and then provide a name to the established connection.
9. Click OK.

You can see the name of the SAP IDoc connection under the Connections tab.

Results

You have successfully established the connection between HCL® OneTest™ Data and the SAP IDoc or DXOB

interface.

What to do next
You must generate a schema in HCL® OneTest™ Data by using the SAP IDoc or DXOB file. See Generating schema by
using an SAP IDoc or DXOB file. on page 186

Generating schema by using an SAP IDoc or DXOB file

When you want to generate the test data for an SAP IDoc or DXOB file, then you must generate a schema for the
selected SAP IDoc or DXOB file.

Before you begin
You must have established the connection with the SAP IDoc or DXOB interface.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.
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4. Click Connections.

5. Select the SAP IDoc connection name that you established, and then click New Action from the menu.

The New Action dialog box is displayed.

6. Select Target as the action type, and then click Next.
7. Enter the following properties for the new action:
a. Select one of the following file types from the Data record type drop-down list.
= ALE - 1000 byte segments (ALE/RFC port)
= EDI - Segments terminated by line feed (file port)
= DXOB - Data Transfer Object
b. Select the imported SAP IDoc or SAP DXOB file name from the IDoc or DXOB File drop-down list.
c. Select Native from the Character set drop-down list.
8. Click Next.
9. Click Generate to generate a new schema by using the imported SAP IDoc or SAP DXOB file.

A schema is generated as anonynous_schenma_<nunber >.

10. Select Schema type.
11. Click Next.
12. Provide the name to the new action, and then click OK.

The new action is created and listed under the SAP IDoc or DXOB connection name that you established.
Note: You can create multiple actions for each established connection.

13. Click Save.

Results

You have successfully generated a schema for the SAP IDoc or DXOB file in HCL® OneTest™ Data.
Note: You can modify the schema name anonynmous_schena_<nunber > from the Schemas tab.

What to do next

You can generate the test data by using the generated schema. See Generating test data on page 200.

HCL OneTest Data support to generate test data for SAP BAPI

When you want to generate test data for SAP Business Application Programming Interface (BAPI), you can generate a
schema in HCL® OneTest™ Data based on structured schema of SAP BAPI function modules. You can then generate

the test data by using the generated schema in HCL® OneTest™ Data.

SAP BAPIs are APl methods of SAP Business Object Types. HCL® OneTest™ Data uses SAP BAPI to access the
application layer of the SAP System.
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Prerequisites
You must have access to HCL OneTest™ Server.

Task flow

You must perform the following tasks in sequence to generate the test data for SAP BAPI in HCL® OneTest™ Data.

The table also provides you the links to the information about the tasks:

Task

More Information

Install SAP connector files in HCL® OneTest™ Data

Installing the SAP connector files in HCL OneTest Data
on page 188

Establish an SAP BAPI connection with HCL® OneTest™
Data

Establishing an SAP BAPI connection with HCL OneTest
Data on page 189

Generate a schema in HCL® OneTest™ Data

Generating a schema in HCL OneTest Data on

page 190

Generate test data in HCL® OneTest™ Data

Generating test data on page 200

Related information

SAP applications on page 707

Installing the SAP connector files in HCL OneTest Data

To generate a schema in HCL® OneTest™ Data, you must install the SAP connector files in HCL® OneTest™ Data.

1. Download the SAP connector files libsapjco3.so and sapjco3.jar to your local file system.

2. Copy the connector files from your local file system to the HIP Server pod by using the following commands

from the command prompt:

kubect!| cp /source path/libsapjco3.so {ny-ots}-hip-server-0:/opt/hcl/hip/libs/libsapjco3

kubect| cp /source path/sapjco3.jar {ny-ots}-hip-server-0:/opt/hcl/hip/libs/sapjco3.jar

Note: When you install or restore HCL® OneTest™ Data, you must copy the connector files again.

3. Enter the following command to change the current user as the root user:

chown <user>:root |ibsapjco3.so sapjco3.jar
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4. Run the following command to modify the access permissions of the connector file:

chrmod 777 |ibsapjco3.so sapjco3.jar

Results
You have successfully installed the SAP connector files in HCL® OneTest™ Data.
What to do next

You must establish the connection between HCL® OneTest™ Data and the SAP BAPI connector. See Establishing an
SAP BAPI connection with HCL OneTest Data on page 189.

Establishing an SAP BAPI connection with HCL OneTest Data

When you want to generate a schema for SAP BAPI, you must establish a connection between HCL® OneTest™ Data
and SAP BAPI.

Before you begin
You must have installed the SAP connector files in HCL® OneTest™ Data. Ensure that you have installed the

connector files a few minutes back. See Installing SAP connector files in HCL OneTest Data on page 188

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Connections.

5. Click New to create a new connection type.

The New Connection dialog box is displayed.

6. Select SAP BAPI from the Type drop-down list, and then click Next.
7. Set the following properties under Connection Properties, and then save the changes:

> Enter the SAP System host name in the Host ID field.
> Enter Client Number and System ID of the SAP System.
> Provide the SAP System credentials in the User and Password fields for authentication.
8. Go to the Connection Properties pane of the Data Fabrication page, and then click Test to verify whether the
connection is established successfully.

Note: Your connection might fail to establish because of any one of the following reasons:
o Trouble at the SAP server port.
o Firewall blockage between HCL OneTest™ Server and the SAP server.
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Results

> Unsuccessful copying of the connector files.
> Unsuccessful refresh of the HIP Server pod.

9. Click Next, and then provide a name for the SAP BAPI connection that you established.
10. Click OK.

You can view the name of the SAP BAPI connection under the Connections tab.

You have successfully established the connection between HCL® OneTest™ Data and SAP BAPI.

What to do next
You must generate a schema in HCL® OneTest™ Data by using the SAP BAPI. See Generating a schema in HCL

OneTest Data on page 190.

Generating a schema in HCL OneTest Data

After you establish the connection between HCL® OneTest™ Data and an SAP BAPI, you can generate a schema in

190

HCL® OneTest™ Data.

. Login to HCL OneTest™ Server and open the team space that contains your project.

. Open your project.

Result

The Overview page is displayed.

. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.

. Click Connections.
5. Select the SAP BAPI connection name that you established, and then click New Action from the menu.

The New Action dialog box is displayed.

6. Select Target as the action type, and then click Next.

. Enter the following properties for the new action:

a. Click Fetch to select the function module category from the BAPI Function Module category drop-
down list.
b. Click Fetch to select the function module of the selected function module category from the BAPI

Function Module drop-down list.

8. Click Next.
9. Select New, and then click Generate to generate a new schema in HCL® OneTest™ Data.

The schema with a name as schema_<number> is generated in HCL® OneTest™ Data.

The Schema Type is populated automatically based on the selected BAPI function module.
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Note: You must select this schema name as the schema for HCL® OneTest™ Data to generate the test
data.

10. Click Next, and then provide the identification details of the new action.
11. Click OK.

The new action is created and is listed under the SAP BAPI connection.

Results

You have successfully generated a schema for SAP BAPI in HCL® OneTest™ Data.
Note: You can modify the schema name schenma_<nunber > from the Schemas tab.

What to do next
You can generate the test data by using the generated schema. See Generating test data on page 200.

HCL OneTest Data support to write the generated test data in MongoDB

When you use MongoDB as a database in your application testing environment and you want the generated test data
in MongoDB, then you can generate the test data by using HCL® OneTest™ Data. Subsequently, HCL® OneTest™ Data
inserts the generated test data directly in MongoDB.

To enable HCL® OneTest™ Data to write the generated test data in the database, you must either import or create a
schema in HCL® OneTest™ Data, and then establish a connection with MongoDB. After you establish the connection,
you must associate the selected schema with MongoDB, and then generate the test data by using HCL® OneTest™

Data. Subsequently, HCL® OneTest™ Data writes the generated test data directly in MongoDB.
! Important: HCL® OneTest™ Data always writes the generated test data in MongoDB in the JSON format.

Prerequisites
You must have access to HCL OneTest™ Server.
Task flow

You must perform the following tasks in sequence to enable HCL® OneTest™ Data to write the generated test data

directly in MongoDB. The table also provides you the links to the information about the tasks.

Task More information

Create a schema in HCL® OneTest™ Data Create a schema in HCL OneTest Data on page 151

Import a JSON or XSD into HCL® OneTest™ Data project
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Task

More information

Import a JSON or XSD into HCL OneTest Data project on
page 148

Establish a MongoDB connection with HCL® OneTest™
Data

Establishing a MongoDB connection with HCL OneTest
Data on page 192

Associate a schema with MongoDB

Associating a schema with MongoDB on page 193

Insert the generated test data in a database

Inserting the generated test data in a database on

page 194

Establishing a MongoDB connection with HCL OneTest Data

You must establish a connection between HCL® OneTest™ Data and MongoDB to associate a schema with the

database.
Before you begin

You must have completed the following tasks:

- Created or imported a schema in the HCL® OneTest™ Data project.

« Installed MongoDB on your computer and the MongoDB instance must be ready to connect. For more

information, refer to Install MongoDB.

- Created a database in MongoDB. For more information, refer to Database Methods.

—_

2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.
4. Click Connections.

5. Click New to create a new connection.

The New Connection dialog box is displayed.

o

. Log in to HCL OneTest™ Server and open the team space that contains your project.

. Select MongoDB as a connection type and click Next.

7. Enter the following properties of the connection in the Properties dialog box:

a. Enter the host name of MongoDB in the Host field.

b. Enter the server port number of the computer where MongoDB is running in the Port field.

c. Enter the user name and password to access MongoDB.
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8. Click Test to verify whether the connection is established successfully.

Note: If the connection fails to establish, it can be because of any one of the following reasons:
> Unreachable database.
> Missing database.

o Incorrect host name and port number.

9. Click Fetch to upload all the databases available in the configured MongoDB in the Database drop-down list,
and then select the database that you want to use to write the generated test data.
10. Click Next, and then provide a name to the established MongoDB connection.
11. Click OK.

You can see the name of the MongoDB connection under the Connections tab.

Results

You have successfully established the connection between HCL® OneTest™ Data and MongoDB.
What to do next

You must associate a schema with a database of MongoDB. See Associating a schema with MongoDB on
page 193.

Associating a schema with MongoDB

After you establish the connection between HCL® OneTest™ Data and MongoDB, you must associate a schema with

a database of MongoDB. You must select the schema that you want to use to generate the test data.

Before you begin

You must have created a collection in the selected MongoDB database.

For more information, refer to db.createCollection() section of Database Methods.

About this task

You can associate any schema with the MongoDB database that can generate the test data in the JSON format.

The following schema formats support the output format in JSON:

* Excel
- JDBC
« XSD
- CSV

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
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The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
. Click the Connections tab and select the MongoDB connection name that you created.
. Click the menu and select New Action.
. Select Target as the Action Type in the New Action dialog box, and then click Next.

N o o b

. Click Fetch to extract a list of all the collections of the selected database, and then select a collection from the

Collection drop-down list.

Note:

You can retain the default property settings for all other boxes.

8. Click Next to provide the schema details.
9. Click the Schema drop-down list to select the schema that you want to use to generate the test data.
10. Click the Schema Type drop-down list to select the group type for which you want to generate the test data,
and then click Next.

11. Provide the identification details of the new action, and then click OK.

The new action is created and listed under the MongoDB connection.

Results

You have successfully associated the schema with the database.

0 Tip: If you want to associate any other schema in the same database, then you must click New Action on the

existing MongoDB connection. You need not create a new connection.

What to do next

You can generate the test data from the schema that you associated with the database of MongoDB. The generated
test data is directly inserted into the database. See Inserting the generated test data in a database on page 194.

Inserting the generated test data in a database

After you associate a schema with a database of MongoDB, you can generate the test data and insert the generated
test data directly in the database by using HCL® OneTest™ Data.

Before you begin

You must have associated the schema with MongoDB. See Associating a schema with MongoDB on page 193.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
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Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.
4. Select the schema that you associated with the database from the Schemas tab.
5. Select the group type of the schema for which you want to generate the test data.
6. Click the menu of the selected group type, and then click Generate Data.

You can view the list of all item types associated with the selected group type in the structure view.

Result
The Generate Data dialog box is displayed.
7. Select the Connection option.
8. Select the MongoDB connection name that you established from the Connections drop-down list.

Note:

When you select MongoDB to insert the generated test data, you can generate only one record of test

data at a time.

9. Provide a value for Numeric Seed Value, and then click OK.

Results
You have successfully generated and inserted the test data in MongoDB.
What to do next

You can click the Jobs tab to view the status of the job. When you hover over the status of the job, you can view the

following details in the tooltip:

« Connection URL that includes details of host name and port number.
- Name of the collection.

» Database name with which the schema is associated.

! Important:

You cannot download the generated test data from the Jobs page because the test data is written directly in

the MongoDB database and the generated test data is not available in HCL® OneTest™ Data.

You must log in to the database to view the generated test data.
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HCL OneTest Data support to generate test data for an Excel file

When you use Microsoft Excel as a database in your application testing environment and you want to use the
structure of an Excel file to generate test data, then you can generate the test data for the selected Excel file by using
HCL® OneTest™ Data.

When you want to generate the test data for the Excel file, then you must import the file into your HCL® OneTest™
Data project. After importing the file, you must establish a connection between Excel and HCL® OneTest™ Data. The
established connection helps to transfer the data and interpret the data of the imported Excel file into your HCL®
OneTest™ Data project. The interpreted information then helps HCL® OneTest™ Data to generate a schema. You can

then use the generated schema to generate the test data in HCL® OneTest™ Data.
Prerequisites

The following prerequisites must be met to enable HCL® OneTest™ Data to write the generated test data:

» You must have access to HCL OneTest™ Server.

« You must have an Excel file on your computer.

Task flow

You must perform the following tasks in sequence to enable HCL® OneTest™ Data to generate the test data for the
Excel file. The table also provides you the links to the information about the tasks.

Task More Information

Import an Excel file.
Importing an Excel file. on page 196

Establish a connection between Excel and HCL®

™ Establishing a connection between Excel and HCL
OneTest™ Data.

OneTest Data on page 197.

Generate a schema based on an Excel file.
Generating a schema based on an Excel file on

page 198.

Generate test data by using the generated schema.
Generating test data by using the generated schema on

page 199.

Importing an Excel file

When you want to establish a connection between HCL® OneTest™ Data and an Excel file, you must import the Excel

file into your HCL® OneTest™ Data project from your computer.
Before you begin

You must have completed the following tasks:
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« Created a project in HCL OneTest™ Server.

« Opened an Excel file or created a file if it did not exist.

1. Select your project in HCL OneTest™ Server and navigate to the Data Fabrication page.

2. Click Files, and then click New to import the Excel file from the computer into your project.

Results
You have successfully imported the Excel file from the computer into your project.

What to do next
You must establish a connection between Excel and HCL® OneTest™ Data. See Establishing a connection between
HCL OneTest Data and Excel on page 197.

Establishing a connection between HCL OneTest Data and Excel

When you want to generate a schema based on an Excel file, you must establish a connection between HCL®
OneTest™ Data and Excel.

Before you begin

You must have imported an Excel file from your computer into your project. See Importing an Excel file on page 196.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Connections.
5. Click New to create a new connection.

The New Connection dialog box is displayed.

6. Select Excel as a connection type, and then click Next.
7. Provide a name for this connection.
8. Click OK.

You can see the name of the connection under the Connections tab.

Results
You have successfully established the connection between HCL® OneTest™ Data and Excel.

What to do next
You must generate a schema in HCL® OneTest™ Data based on the Excel file. See Generating a schema based on
Excel file on page 198.
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Generating a schema based on an Excel file

After you establish the connection between HCL® OneTest™ Data and Excel, you can generate a schema that is
based on an Excel file in HCL® OneTest™ Data.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
. Click the Connections tab and select the connection that you created.
. Click the menu, and then select New Action.
. Select Target as the Action Type in the New Action dialog box, and then click Next.

N o o0 b

. Enter the following properties of the schema that you want to generate, and then click Next:
- Select the Excel file that you imported into your project from the Excel File drop-down list.
o Click Fetch to upload all the worksheets of the Excel file in the Worksheet drop-down list.

> Select the worksheet from the Worksheet drop-down list.

Note:

You can retain the default property settings for all other fields.

8. Select New, and then click Generate.

The schema is generated in HCL® OneTest™ Data. HCL® OneTest™ Data generates the schema name as

schema_<number>.

Note: You must select this schema name as the schema for HCL® OneTest™ Data to generate the test
data.

9. Select the schema type as Sheet.

10. Click Next to provide the identification details of the new action, and then click OK.

The new action is created and listed under the connection that is established between HCL® OneTest™ Data

and Excel.

Results

You have successfully generated the schema in HCL® OneTest™ Data.

Note:
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You can modify the schema name schema_<number> from the Schemas tab.

0 Tip: If you want to generate schemas for other Excel files, then you must click New Action on the existing

Excel connection. You need not create a new connection.

What to do next

You can view the generated schema listed under the Schemas tab. You can generate the test data for the generated
schema in HCL® OneTest™ Data. See Generating test data by using the generated schema on page 199.

Generating test data by using the generated schema

After you generate the schema in HCL® OneTest™ Data, you can use this schema to generate the test data in HCL®
OneTest™ Data.

Before you begin

You must have generated the schema by using the connection that is established between HCL® OneTest™ Data and

Excel. See Generating a schema based on Excel file on page 198.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Select the schema name schema_<number> from the Schemas tab.
Result
The schema is displayed.

5. Select the Sheet group type, and then select Structure from the menu.
You can view a group as Row in the structure of the schema. All item types of a schema are listed under the
Row group type.

6. Click the menu for the Row group type, and then set the property as Set Required.
7. Click the menu for all the item types that you want to use to generate the test data, and then set the property

as Set Required.
Note: If you have a numeric item type, you must set Min size (digits) and Max size (digits) properties.

For example, when you select I nt eger as Presentation, then you can set the Min size (digits) as 1 and the Max
size (digits) as 9.

8. Click Save.
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9. Select the Sheet group type in the Dictionary dialog box, and then click Generate Data from the menu.

The Generate Data dialog box is displayed.

10. Provide the number of records that you want to generate in Number of records.

11. Optional: Provide a seed value that acts as a reference number to generate the same set of data in Numeric
Seed Value.

12. Select the output file format for the generated test data from the list, and then click OK.

Results
You have successfully generated the test data by using the generated schema.
What to do next

You can click the Jobs tab to view the status of the job. You can then download the generated test data of the jobs

that are completed successfully.

Generating test data

When you have a defined and structured schema for the entire data, you can generate test data to perform application

testing.
Before you begin

The following prerequisites must be met to generate the test data:

 You must have created a project.
» The schema must have a group type.

« You must have a structured view of your defined schema.

About this task

You can generate the sample test data from the group type of schema. When you import the XSD format schema,
then HCL® OneTest™ Data generates only XML test data. If you import JSON format as input, the application
generates only JSON test data.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click the Schemas tab and select the schema for which you want to generate the test data.
5. Select the group type that you want to use to generate the test data from the Dictionary dialog box.

6. Click Generate Data from the menu.
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Result
The Generate Data dialog box is displayed.
7. Enter the number of records that you want to generate in the Number of records field.

! Important: When you select the pairwise data generation property for any item type, then the number
of records you enter is ignored. Based on the pairwise data generation approach, HCL® OneTest™
Data autocalculates the number of records.

8. Enter seed value in the Numeric Seed Value field.

The seed value acts as an instance of random data that can produce the same set of data multiple times. By

default, the seed value is blank.

Note: The following table lists the maximum values for numeric seed value and number of records:

Description Maximum values
Numeric Seed Value 8 digits (99,999,999)
Number of records 9 digits (999,999,999)

9. Choose the output file format of the test data that you want to generate from the Output File Format list.
HCL® OneTest™ Data supports the following formats:
> CSV
o Native
> JSON
o XML
o Excel

Notes:

> If you create a schema by using the schema designer, by default, the output file format is CSV.

o If you import a schema into your project or have a schema with nested groups, you can select
only the Plain text file as the output file format.

o You can generate line numbers in the output by creating an auto-increment rule by using

functions and expressions.

10. Click OK.

Results
The test data is generated successfully.
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Note: The column headings for the generated test data are available only for the CSV and Excel file output
formats.

What to do next
You can view and download the generated test data on the Jobs page. See Status of generated test data on

page 223.

Generating the test data by using multiple schemas

You can generate the test data either by using multiple JDBC-supported or non-JDBC schemas.
Before you begin

You must have completed the following tasks:

» Logged into HCL OneTest™ Server.
- Installed any JDBC-supported database, such as Oracle, MySQL, and so on, for generating the test data from

JDBC-supported schemas.

About this task

You can generate the test data for multiple schemas simultaneously. To generate the test data you can either use
only JDBC-supported schemas or non-JDBC schemas.

To generate the test data by using multiple JDBC-supported schemas, you must create tables in a database that

are supported by the JDBC connection. After you establish the JDBC connection between the database and HCL®
OneTest™ Data, you must generate multiple schemas. You can then import the selected schemas into the Schema
Canvas page. After you import the schemas into the Schema Canvas page, you can view an existing parent-child
relationship. You must select a single schema or multiple schemas for which you want to generate the test data, and
then generate the test data.

To generate the test data by using multiple non-JDBC schemas, you must create a schema in HCL® OneTest™ Data.
You must then define the properties and structural view of the schemas. When the schemas are created, you can
import the selected schemas into the Schema Canvas page. After you import the schemas into the Schema Canvas
page, you can view an existing parent-child relationship or establish a relationship among the schemas. You must
select the schemas, and then generate the test data.

Notes:
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» When you generate the test data by using multiple schemas, you must select either JDBC-supported
4 or non-JDBC schemas.
» When you select a child schema on the Schema Canvas page, the parent schema is automatically
selected. Similarly, if you select a parent schema, then all the child schemas are selected on the

Schema Canvas page.

The output formats that are supported in HCL® OneTest™ Data for the generation of test data for multiple schemas
by using referential integrity are CSV, Excel, Native, JSON, and XML. You can also insert the generated test data into
the database by using the JDBC connection.

Note: You can generate the test data among the common output formats that are supported by all selected

schemas.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Choose any one of the following types of schemas that you want to use to generate the test data:
Choose from:
- JDBC

You must perform the following tasks to generate the test data in HCL® OneTest™ Data for multiple
JDBC-supported schemas:
a. Create a sample schema in a database on page 178.
b. Establish a JDBC connection with HCL OneTest Data on page 180.
c. Generate a schema in HCL OneTest Data on page 181.
d. Define properties of schemas on page 205.
e. Import schemas into Schema Canvas on page 207.
f. Select schemas on page 212.
g. Generate test data for selected schemas on page 202.
> Non-JDBC

You must perform the following tasks to generate the test data in HCL® OneTest™ Data for multiple

non-JDBC schemas:

a. Create schemas on page 151.

b. Design schemas on page 156.

c¢. Import schemas into Schema Canvas on page 207.
d. Establish a parent-child relationship among schemas.
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Results

e. Select schemas on page 212.

f. Generate test data for selected schemas on page 202.

You have generated the test data by using multiple schemas simultaneously.

Selecting multiple schemas

After you define the properties of schemas, you must select schemas and view the relationships among them to

generate the test data for multiple schemas simultaneously.

Before you begin

You must have completed the following tasks:
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1. Created a project.
. Generated schemas in HCL® OneTest™ Data by using a JDBC connection. See Generating a schema in HCL

OneTest Data on page 181.

. Defined properties for the generated schemas. See Defining properties of schemas on page 205.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.

. Open your project.

Result
The Overview page is displayed.

. Click Author > Data Fabrication.

Result
The Data Fabrication page is displayed.

. Click Schema Integrity to select schemas.

Result

The Select Schemas dialog box is displayed.

5. Click the field to view the list of schemas that are generated by using the JDBC connection.
. Select multiple schemas.

Note: You can select a maximum of 10 schemas.

. Click Import to import the selected schemas into the Schema Integrity page.

You can find the structural view of all the selected schemas with their relationships with each other.

Note: You can use the scroll wheel or pinch-to-zoom option on the Schema Integrity page to view the

structural view of all schemas and relationships.

8. Verify the relationships among the selected schemas.

. Select schemas based on the following criteria:
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- If a schema does not have a relationship with any other schema on the Schema Integrity page, then
you must select that schema manually. Otherwise, click Select All to select all schemas to generate
the test data.

o If a schema has a relationship with other schemas and is selected, then all the related schemas get

selected automatically.

Notes:

> You cannot select schemas that belong to different JDBC connections.

> You can use Modify canvas to add or remove the selected schemas.

o If any of the selected schema is deleted from the workspace, then the view of the Schema
Integrity page changes as the deleted schema is removed from the Schema Integrity page.

Results
You have successfully selected multiple schemas for the generation of test data.
What to do next

You can generate the test data for the selected schemas. See Generating test data for selected schemas on

page 215.

Defining properties of schemas

After you generate the schema from the configured database in HCL® OneTest™ Data, you must define the required

properties for all schemas.
Before you begin

You must have completed the following tasks:

1. Created a project.
2. Generated schemas in HCL® OneTest™ Data by using a JDBC connection. See Generating a schema in HCL
OneTest Data on page 181.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.

4. Select the generated schema from the Schemas tab.

For example, schema_<number>
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5. Click the Menu icon of the group type of the schema and select Structure.

You can view the list of all item types associated with the selected group type in the structural view of the

schema.

6. Click the Menuicon " of all item types in the Structure dialog box to set the following properties:

a. Click Set Required to get at least one occurrence of the item type in the generated test data, and then

click Save.

b. Click Properties for the selected item types and perform the following steps for Item Properties:

i. Verify the values of the Item Subclass and Presentation fields.

For example, if the item type is of a number data type, then the value for Item Subclass is

Nunber and Presentation is | nt eger.

ii. Set the Min size and Max size for the item types of the schema.
If the value of Subclass is Nunber and Presentation is | nt eger for an item type, then set the
value of Min size and Max size as the number of digits that can be generated in the test data.

Note: The value for Min size (digits) should be less than or equal to Max size (digits).

For example, if the item type is of a number data type, then you can set the Min size (digits) as

1 and the Max size (digits) as 9.

Notes:

> The values of both the Min size (digits) and Max size (digits) properties for item types that act
as a primary and foreign keys must be same.

> You must set the value of Min size and Max size for an I nt eger item type such that the number
of digits of the generated test data is between the range of 1 and 9 and the generated test data
is between -27147483648 to 2147483647.

7. Save the changes.
You must repeat steps 2 through step 5 to set the properties for all schemas.

Results
You have defined the properties for all schemas.
What to do next

You can click Schema Canvas to select the defined and structured schemas that you want to use to generate the test
data. See Selecting multiple schemas on page 204.
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Related information

Item properties on page 725

Setting a range on page 171

Importing schemas into the Schema Canvas page

When you want to generate the test data or the Data Definition Language (DDL) statements by using single or
multiple schemas, you must import schemas into the Schema Canvas page. You can import multiple schemas

simultaneously.

Before you begin

You must have fabricated schemas in HCL® OneTest™ Data.
About this task

To import the schemas, you must select the type of schemas that you want to import. You can import either the
JDBC-supported schemas or non-JDBC schemas into the Schema Canvas page. You can view the list of schemas
under the Schemas tab of the Canvas Settings dialog box. Under the Groups tab, you can view the list of all the group
types of the schemas. You can also enter the text in the Search field to find the schemas or the group types that

match with the characters of the search text.

The schemas or the group types that you select to import are listed under the Selected Schemas panel.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Schema Canvas to select the schemas.
Result
The Canvas Settings dialog box is displayed.
5. Select any one of the following options in the Canvas Settings dialog box to display the list of schemas:
> JDBC: When you select JDBC, you can view only the list of JDBC-supported schemas. To import the
JDBC schemas, go to Step 4.
> Non-JDBC: When you select Non-JDBC, you can view only the list of non-JDBC schemas. To import
the non-JDBC schemas, go to Step 5.
6. For JDBC schemas: Select a schema by using any one of the following methods:

Choose from:
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o Use the Database tab:
a. Click the Database tab.
b. Select a schema.

The group types within the selected schemas are selected.

Notes:

= You can also search for the schema by entering the name of the schema in the
Search field.
= Each JDBC schema includes only one group type.

= The group types are selected automatically with the selection of schemas.

> Use the Table tab:
a. Click the Table tab.
b. Select the group type.

The group types along with their schemas are selected.
Note: You can find only one group type in JDBC schemas.

Result

The selected schemas are displayed in the Selected Schemas panel.

Notes:

> If you select a child schema, then the parent schema is selected automatically.
> If you select a child group, then the parent group of parent schema is selected automatically.
o If you clear the selection of any group type of schema, then you can view the updated list of

the selected schemas in the Selected Schemas panel.

7. For Non-JDBC schemas: Select a schema by using any one of the following methods:
Choose from:
> Use the Schema tab:
a. Click the Schema tab.
b. Select a schema.

The group types within the selected schema are displayed.
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Note: You can also search for the schema by entering the name of the schema in the
Search field.

c. Select the group types of the selected schema that you want to import.
Note: You can select multiple group types from a single schema.

> Use the Group tab:
a. Click the Group tab.
b. Select the group types that you want to import.

The group types along with their schemas are selected.

Result

The selected schemas are displayed in the Selected Schemas panel.

Notes:

o If you select a child schema, then the parent schema is selected automatically.

> If you select a child group, then the parent group of the parent schema is selected
automatically.

o If you clear the selection of any group type of schema, then you can view the updated list of

the selected schemas in the Selected Schemas panel.

8. Click Set Canvas.
Result

The selected schemas are imported into the Schema Canvas page.

Note: If you select multiple group types from the same schema and import that schema into the
Schema Canvas page, then the structure of each group is represented separately on the Schema

Canvas page.

Results
You have imported the non-JDBC schemas into the Schema Canvas page.

What to do next
You must select schemas from the Schema Canvas page before generating the DDL statements or the test data. See

Selecting schemas on page 212.

You can also establish a new parent-child relationship among non-JDBC schemas. See Establishing a parent-child

relationship among schemas.
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After you import schemas into the Schema Canvas page, if you want to modify or remove the selection of schemas,
then you must click the Modify canvas button on the Schema Canvas page. See Modifying the selection of imported

schemas on page 213.

Modifying a relationship among schemas

When you want to alter the existing relationship between schemas, then you can modify the established relationship
on the Schema Canvas page.

Before you begin

You must have completed the following tasks:

1. Created a project.

2. Fabricated the schemas in HCL® OneTest™ Data. See Schema creation on page 151.

3. Defined properties for the fabricated schemas. See Defining properties of schemas on page 205.

4. Imported schemas from the Schema Canvas page. See Importing schemas into the Schema Canvas page on
page 207.

5. Established relationships among non-JDBC schemas. See Establishing a parent-child relationship among
schemas.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Schema Canvas.
Result
The Schema Canvas page is displayed.
. Identify an item type of a relationship that you want to modify.
. Hover over the relationship line that you selected.

. Click the end of the relationship line that points to the item type you want to modify.

0 N oo o

. Drag-and-drop the line to the item type with which you want to establish a new relationship.

Notes:

> You can select an item type either from the same schema or a different schema to establish a
new relationship.

> You can modify only the child schemas in a relationship.

Results

The relationship is modified among the item types of non-JDBC schemas.
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What to do next
You can establish another relationship among the item types of other schemas. See Establishing a parent-child

relationship among schemas.

You can also select the schemas on the Schema Canvas page to generate the test data. See Selecting schemas on

page 212.

Deleting a relationship among schemas

When any established relationship among the item types of non-JDBC schemas is no longer required, you can delete

that relationship on the Schema Canvas page.

Before you begin

You must have completed the following tasks:

. Created a project.
. Fabricated the schemas in HCL® OneTest™ Data. See Schema creation on page 157.
. Defined properties for the fabricated schemas. See Defining properties of schemas on page 205.

. Imported schemas from the Schema Canvas page. See Importing schemas into the Schema Canvas page on

page 207.

. Established relationships among non-JDBC schemas. See Establishing a parent-child relationship among

schemas.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.

. Open your project.

Result
The Overview page is displayed.

. Click Author > Data Fabrication.

Result
The Data Fabrication page is displayed.

. Click Schema Canvas.

Result
The Schema Canvas page is displayed.

5. Identify a relationship among schemas that you want to delete.

6. Hover over the relationship line of the selected relationship.

Result

>
You can view a red cross mark *a? on the line that is drawn to show the relationship among the schemas.

>
. Click the red cross mark *a* to delete the relationship.

Alternatively, click the arrow “*" of the drawn line, and then drag-and-drop the line anywhere on the Schema
Canvas page.

Result

The Detach relationship dialog box is displayed for your confirmation before the deletion of the relationship.
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8. Click Detach.
Result
The line that is drawn among the schemas is erased.

Results

The relationship is deleted among the item types of non-JDBC schemas.

What to do next
You can establish another relationship among the item types of other schemas. See Establishing a parent-child

relationship among schemas.

You can also select the schemas on the Schema Canvas page to generate the test data. See Selecting schemas on

page 212.

Selecting schemas

After you import schemas into Schema Canvas, you must select schemas to view the relationships among
them, generate the Data Definition Language (DDL) statements, or generate the test data for multiple schemas

simultaneously.
Before you begin

You must have completed the following tasks:

1. Created a project.
2. Fabricated the JDBC-supported or non-JDBC schemas in HCL® OneTest™ Data:
> For JDBC-supported schemas, see Generating a schema in HCL OneTest Data on page 1871.
> For non-JDBC schemas in HCL® OneTest™ Data, see Schema creation on page 151.
3. Defined properties for the generated schemas. See Defining properties of schemas on page 205.
4. Imported schemas into the Schema Canvas page. See Importing schemas into the Schema Canvas page on

page 207.

About this task

You can view all the imported schemas on the Schema Canvas page. When you select a schema on the Schema
Canvas page, the other schemas are also selected if they are related to each other based on referential integrity.
Otherwise, you can select Select All to select all the schemas that are imported on the Schema Canvas.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.
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4. Click Schema Canvas.
Result
The Schema Canvas page is displayed.

You can view the structural view of all the imported schemas with their relationships with each other.

Notes:

o You can use the scroll wheel or pinch-to-zoom option on the Schema Canvas page to view the
structural view of all schemas and relationships.

> When you rename or delete any schema or item types that are imported to the Schema Canvas
page, the relationships are altered and this alteration results in the failure of a generation of

test data.

5. Verify the relationships among the selected schemas.
6. Select schemas based on the following criteria:

- If a schema does not have a relationship with any other schema on the Schema Canvas page, then you
must select that schema manually. Otherwise, select Select All to select all schemas to generate the
test data.

- If a schema has a relationship with other schemas and if it is selected, then all the related schemas

are selected automatically.

Notes:

> You cannot select schemas that belong to different JDBC connections.

> You can use Modify canvas to add or remove the selected schemas.

> You must not select schemas with nested group types for the generation of DDL statements.
o If any of the selected schemas is deleted from the workspace, then the view of the Schema

Canvas page changes because the deleted schema is removed from the Schema Canvas

page.

Results
You have selected multiple schemas.

What to do next

You can perform any one of the following tasks:

» Generate DDL statements for the selected schemas. See Generating DDL statements on page 222.
« Generate the test data. See Generating test data for selected schemas on page 215.

Modifying the selection of imported schemas

After you import schemas into the Schema Canvas page, if you want to modify or remove the selected schemas, then

you can modify the Schema Canvas page.
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Before you begin

You must have completed the following tasks:

* Created a project.
- Fabricated the schemas in HCL® OneTest™ Data. See Schema fabrication on page 147.
« Defined the properties of schemas. See Schema design overview on page 156.

« Imported the schemas. See Importing schemas into the Schema Canvas page on page 207.

About this task

After you import the JDBC-supported or non-JDBC schemas from the Canvas Settings dialog box into the Schema
Canvas page, if you want to modify the selection of group types of a schema or number of schemas, then you must
use the Modify canvas button. You can use the Canvas Settings dialog box to reselect or clear the selection of

schemas and the group types.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.

. Open your project.

Result

The Overview page is displayed.

. Click Author > Data Fabrication.

Result
The Data Fabrication page is displayed.

. Click Schema Canvas to select the schemas.

Result

The Schema Canvas page is displayed.

. Click the Modify canvas button.

Result

The Canvas Settings dialog box is displayed.

6. Modify the selection of schemas or group types.
. Click Set Canvas.

Result

The modified Schema Canvas page is displayed.

Results

You have modified the Schema Canvas page.

What to do next

You must select schemas from the Schema Canvas before generating the DDL statements or the test data. See

You can also establish a new parent-child relationship among non-JDBC schemas. See Establishing a parent-child
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Generating test data for selected schemas

After you select multiple schemas on the Schema Canvas page, you can generate the test data of all the selected

schemas simultaneously.
Before you begin

You must have completed the following tasks:

1. Created a project.

2. Fabricated the schemas in HCL® OneTest™ Data. See Schema creation on page 151.

3. Defined properties for the fabricated schemas. See Defining properties of schemas on page 205.

4. Imported schemas from the Schema Canvas page. Importing schemas into the Schema Canvas page on
page 207.

5. Established relationships among non-JDBC schemas. Establishing a parent-child relationship among
schemas.

6. Selected the schemas. See Selecting schemas on page 212.

About this task
You can generate the test data for multiple schemas simultaneously. To generate the test data, you can either use
only JDBC-supported schemas or non-JDBC schemas.

When you select multiple schemas from the Schema Canvas page, and one or more schemas among the selected
schemas are enabled with the pairwise property, then the following number of records are generated for those

schemas:

« If the selected schema is enabled with the pairwise property and is not referenced to any other schema, then
the number of records generated are auto calculated based on the algorithm of the pairwise data generation.

« If the selected schema is enabled with the pairwise property and is referenced to at least one parent schema,
then the number of records generated are among the least of the following values:

> The number of records of each referenced parent schema.
> The auto calculated number of records of the schema with the pairwise property as enabled.

« If the selected schema is enabled with the pairwise property and is referenced by a child schema, which is
not a pairwise enabled schema, then the number of records generated are among the least of the following
values:

> The number of records of each parent schema.

o The value of the number of records that you enter.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result
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The Data Fabrication page is displayed.

4. Click Generate data to generate the test data for the selected schemas on the Schema Canvas page.
Result
The Generate data dialog box is displayed.

5. Select the Connections option for the output location to generate the test data for the JDBC-supported
schemas.

Note: When you want to generate the test data for non-JDBC schemas, the options to select the

output location are not displayed because the File option is considered as the default option.

6. Enter the number of records that you want to generate in the Number of records field.
7. Enter a seed value in the Numeric Seed Value field.

The seed value acts as an instance of random data that can generate the same set of data multiple times. The
default seed value is blank.

Note: The following table lists the maximum values for numeric seed value and number of records:

Description Maximum values
Numeric seed value 8 digits (99,999,999)
Number of records 9 digits (999,999,999)

8. Choose the output file format of the test data that you want to generate from the Output File Format list.
9. Click Analyze to validate the selected schemas.

If the selected schemas are validated successfully, then you can view the order of schemas execution for

generating the test data. All the parent schemas are executed first followed by the child schemas.
Note: If the validation fails, it might be because of one of the following reasons:

> The parent schemas of all the selected schemas are missing.

> The connection and actions of selected schemas do not exist in the project.

> Any one of the following properties of all item types of the selected schemas are not set:
= Min size (digits) and Max size (digits) properties for each integer item type.

= Set Required property.

You must resolve the cause of failure for the successful validation of the schemas.

10. Click OK.
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Results

You have generated the test data by using multiple schemas simultaneously.
HCL® OneTest™ Data first generates the test data of the parent schema followed by the child schemas.

What to do next
You can view and download the generated test data of all the selected jobs on the Jobs page. See Status of

generated test data on page 223.

Related information

Inserting the generated test data in a database on page 183
Item properties on page 725

Setting a range on page 171

Generating DDL statements for schemas

When you want to know the Structured Query Language (SQL) statements to create a table from non-JDBC schemas
that you created in HCL® OneTest™ Data, you can generate the Data Definition Language (DDL) statements for those

selected schemas.
Before you begin

You must have completed the following tasks:

» Logged into HCL OneTest™ Server.
- Created a project.
« Created schemas in HCL® OneTest™ Data. See Schema fabrication on page 147.

About this task

You can generate the SQL file with DDL statements to non-JDBC schemas only. You can also generate the DDL
statements for multiple schemas simultaneously. To generate the DDL statements for any schema, you must create a
schema in HCL® OneTest™ Data, define the properties of the schema, and then import all the non-JDBC schemas for
which you want to generate the DDL statements on the Schema Canvas page. After you import the schemas into the
Schema Canvas page, you must select the schemas, and then generate the DDL statements.

You can find the generated SQL file with DDL statements for the selected schemas on the Jobs page.

Notes:
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- You cannot generate the DDL statements for schemas with nested groups.
- The DDL statements for all the selected schemas that are available on the Schema Canvas page are
generated in a single SQL file.

1. Create schemas on page 151.

2. Define properties of schemas on page 205.

3. Import non-JDBC-supported schemas on page 207.
4. Select schemas on page 212.

5. Generate DDL statements on page 222.

Results
You have generated the DDL statements for the selected non-JDBC schemas.

What to do next
You can download the generated DDL statements for each schema from the Jobs page. See Status of generated test
data on page 223.

Importing schemas into the Schema Canvas page

When you want to generate the test data or the Data Definition Language (DDL) statements by using single or
multiple schemas, you must import schemas into the Schema Canvas page. You can import multiple schemas

simultaneously.

Before you begin

You must have fabricated schemas in HCL® OneTest™ Data.
About this task

To import the schemas, you must select the type of schemas that you want to import. You can import either the
JDBC-supported schemas or non-JDBC schemas into the Schema Canvas page. You can view the list of schemas
under the Schemas tab of the Canvas Settings dialog box. Under the Groups tab, you can view the list of all the group
types of the schemas. You can also enter the text in the Search field to find the schemas or the group types that

match with the characters of the search text.

The schemas or the group types that you select to import are listed under the Selected Schemas panel.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result

The Data Fabrication page is displayed.
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4. Click Schema Canvas to select the schemas.
Result
The Canvas Settings dialog box is displayed.
5. Select any one of the following options in the Canvas Settings dialog box to display the list of schemas:
> JDBC: When you select JDBC, you can view only the list of JDBC-supported schemas. To import the
JDBC schemas, go to Step 4.
> Non-JDBC: When you select Non-JDBC, you can view only the list of non-JDBC schemas. To import
the non-JDBC schemas, go to Step 5.
6. For JDBC schemas: Select a schema by using any one of the following methods:
Choose from:
> Use the Database tab:
a. Click the Database tab.

b. Select a schema.

The group types within the selected schemas are selected.

Notes:

= You can also search for the schema by entering the name of the schema in the
Search field.
= Each JDBC schema includes only one group type.

= The group types are selected automatically with the selection of schemas.

o Use the Table tab:
a. Click the Table tab.
b. Select the group type.

The group types along with their schemas are selected.
Note: You can find only one group type in JDBC schemas.

Result
The selected schemas are displayed in the Selected Schemas panel.

Notes:

o If you select a child schema, then the parent schema is selected automatically.
o If you select a child group, then the parent group of parent schema is selected automatically.
> If you clear the selection of any group type of schema, then you can view the updated list of

the selected schemas in the Selected Schemas panel.

7. For Non-JDBC schemas: Select a schema by using any one of the following methods:

Choose from:
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o Use the Schema tab:
a. Click the Schema tab.
b. Select a schema.

The group types within the selected schema are displayed.

Note: You can also search for the schema by entering the name of the schema in the
Search field.

c. Select the group types of the selected schema that you want to import.
Note: You can select multiple group types from a single schema.

> Use the Group tab:
a. Click the Group tab.
b. Select the group types that you want to import.

The group types along with their schemas are selected.

Result
The selected schemas are displayed in the Selected Schemas panel.

Notes:

o If you select a child schema, then the parent schema is selected automatically.
> If you select a child group, then the parent group of the parent schema is selected

automatically.
o If you clear the selection of any group type of schema, then you can view the updated list of

the selected schemas in the Selected Schemas panel.

8. Click Set Canvas.
Result
The selected schemas are imported into the Schema Canvas page.

Note: If you select multiple group types from the same schema and import that schema into the
Schema Canvas page, then the structure of each group is represented separately on the Schema

Canvas page.
Results
You have imported the non-JDBC schemas into the Schema Canvas page.

What to do next
You must select schemas from the Schema Canvas page before generating the DDL statements or the test data. See

Selecting schemas on page 212.
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You can also establish a new parent-child relationship among non-JDBC schemas. See Establishing a parent-child

relationship among schemas.

After you import schemas into the Schema Canvas page, if you want to modify or remove the selection of schemas,
then you must click the Modify canvas button on the Schema Canvas page. See Modifying the selection of imported

schemas on page 213.

Selecting schemas

After you import schemas into Schema Canvas, you must select schemas to view the relationships among
them, generate the Data Definition Language (DDL) statements, or generate the test data for multiple schemas

simultaneously.
Before you begin

You must have completed the following tasks:

1. Created a project.
2. Fabricated the JDBC-supported or non-JDBC schemas in HCL® OneTest™ Data:
o For JDBC-supported schemas, see Generating a schema in HCL OneTest Data on page 1871.
> For non-JDBC schemas in HCL® OneTest™ Data, see Schema creation on page 151.
3. Defined properties for the generated schemas. See Defining properties of schemas on page 205.
4. Imported schemas into the Schema Canvas page. See Importing schemas into the Schema Canvas page on

page 207.

About this task

You can view all the imported schemas on the Schema Canvas page. When you select a schema on the Schema
Canvas page, the other schemas are also selected if they are related to each other based on referential integrity.
Otherwise, you can select Select All to select all the schemas that are imported on the Schema Canvas.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Schema Canvas.
Result

The Schema Canvas page is displayed.

You can view the structural view of all the imported schemas with their relationships with each other.

Notes:
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o You can use the scroll wheel or pinch-to-zoom option on the Schema Canvas page to view the
4 structural view of all schemas and relationships.
> When you rename or delete any schema or item types that are imported to the Schema Canvas
page, the relationships are altered and this alteration results in the failure of a generation of

test data.

5. Verify the relationships among the selected schemas.
6. Select schemas based on the following criteria:

- If a schema does not have a relationship with any other schema on the Schema Canvas page, then you
must select that schema manually. Otherwise, select Select All to select all schemas to generate the
test data.

o If a schema has a relationship with other schemas and if it is selected, then all the related schemas

are selected automatically.

Notes:

> You cannot select schemas that belong to different JDBC connections.

> You can use Modify canvas to add or remove the selected schemas.

> You must not select schemas with nested group types for the generation of DDL statements.
o If any of the selected schemas is deleted from the workspace, then the view of the Schema

Canvas page changes because the deleted schema is removed from the Schema Canvas

page.
Results
You have selected multiple schemas.

What to do next
You can perform any one of the following tasks:

» Generate DDL statements for the selected schemas. See Generating DDL statements on page 222.

 Generate the test data. See Generating test data for selected schemas on page 215.

Generating DDL statements

After you select non-JDBC schemas on the Schema Canvas page, you can generate the Data Definition Language

(DDL) statements for all the selected schemas.
Before you begin

You must have selected non-JDBC schemas on the Schema Canvas page.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.

Result

The Overview page is displayed.
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3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Schema Canvas.
Result
The Schema Canvas page is displayed.
5. Verify the selected schemas.
6. Click Generate DDL.
Result
A notification is displayed that the DDL statements for the selected schemas are successfully generated.

Results

You have generated the DDL statements of the selected schemas.
What to do next

You can view and download the generated DDL statements of the selected schemas on the Jobs page. See Status of
generated test data on page 223.

Status of generated test data
You can view the status of all the test data generated jobs and Data Definition Language (DDL) statements generated

jobs performed in your project, on the Jobs page.

You can view the status of test data generated jobs in the Status column on the Jobs page. When the test data
generation of any schema initiates, the status of that job is shown as Started. As the test data generation progresses,
the status of that job changes to In Progress. After the test data generation completes successfully, the status

changes to Complete. If the generation of test data fails, you can view the status of that particular job as Failed.

Related information

Usage of test data generation job on page 223

Usage of test data generation job

The generation of test data or Data Definition Language (DDL) statements for single or multiple schemas in HCL®

OneTest™ Data is considered a job. You can view the list of all jobs on the Jobs page.

When the job to generate the test data or DDL statements is complete, you can download the following generated
jobs files from the Jobs page:

» Generated test data file
« Structured Query Language (SQL) file

You can use the job details to troubleshoot the failed jobs and to regenerate the successful jobs.
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When you generate the DDL statements, each job includes one SQL file and each SQL file includes the DDL
statements generated for all the selected schemas.

You can access the API history for each generation job of the test data or DDL statements. If you want to reuse any

schema to generate the test data, then you can regenerate the test data.
Note: The Regenerate Job option is disabled for the Schema canvas jobs and DDL job.

You can find different methods of using the generated test data jobs.

Downloading jobs

When you want to test any application by using the generated test data or to reuse the data of any specific schema
definition for some other project, you can download the test data from the job into your local file system. You can
also download the Structured Query Language (SQL) file from the job that includes the generated Data Definition

Language (DDL) statements of multiple non-JDBC schemas.
Before you begin

You must have completed the following tasks:

« Created a project.
« Generated the test data. See Generating test data for selected schemas on page 215.

 Generated the DDL statements. See Generating DDL statements on page 222.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Jobs.
Result
The Jobs page is displayed. You can view the list of all the jobs that include the generated test data or DDL
statements.

Notes:

> If you want to view only the jobs related to referential integrity, then select Schema canvas
jobs from the menu.
o If you want to view only the jobs related to DDL statements, then select DDL job from the

menu.

5. Select a job for which you want to download the generated test data.
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Notes:

o You can select multiple jobs at a time to download the test data.

> You can download the test data only for the jobs that are completed successfully.

> The download option is disabled for the jobs that are set to insert the generated test data into
the database.

> The download option is disabled for multiple DDL jobs.

6. Click the Download job(s) button or i. icon.

Results
You have downloaded any one of the following files:

- The generated test data in the compressed format in your local file system. When you download multiple jobs,

then the compressed file of the jobs is organized by time.

Note: You can also download the generated test data file from the following location of the HCL®
OneTest™ Data pod:

[opt/hcl/hip-rest/

out put/ <account | d>/ <user | D>/ <pr oj ect | d>/ <schenal d>/ <genMapPat h>

- An SQL file that includes the generated DDL statements of all the selected schemas.

Note: You can also download the DDL statements from the following location of the HCL® OneTest™
Data pod:

[ opt / dat a/ hi pfil es/ <account | d>/ <proj ect|d>/yyyy: MM dd- HH: mm ss. sql

Regenerating test data

When you want to generate another set of test data by using an existing schema, then instead of defining a schema

again, you can regenerate test data from the Jobs page.

Before you begin

* You must have a project.

« You must have generated test data.

About this task

225



HCL OneTest™ Server

On the Jobs page, you can view the list of all test data generated jobs. If you want to use the existing data model or
schema to generate different values of test data, you must regenerate with an empty seed value. However, if the seed
value is not empty, then the same test data is generated as it was generated earlier for that schema.

Note: You cannot regenerate the test data for the jobs that are generated for multiple schemas by using
referential integrity and Data Definition Language (DDL) statements.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Jobs.
Result
You can view the list of data generated jobs.
5. Select a job for which you want to regenerate the test data.

You can select multiple jobs at a time to regenerate the test data.

6. Click Regenerate data from the menu or click the Regenerate data icon @

Results
The test data for the required schema is regenerated and is listed on the Jobs page.

What to do next
You can download the regenerated test data. See, Downloading test data on page 224.

Configuring job settings

HCL® OneTest™ Data periodically deletes all the generated test data and the jobs of test data generation with API
history to clear the memory. However, if you want to change the default number of days to retain the generated test

data jobs in memory, you must configure the job settings.

Before you begin

« You must have cluster-admin permissions.
 You must have the IP address of the computer where HCL OneTest™ Server is installed.

About this task

As a default configuration, HCL® OneTest™ Data retains the jobs with their generated test data and API history for five
days after the jobs are completed. All the jobs that are created before five days are deleted. If you want to retain the
jobs with their generated data for more number of days in HCL® OneTest™ Data, then you must modify the value of

the data_rotation_time property to the number of days you want to retain the jobs in the confi gmap file.
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Note: If you modify the value of the data_rotation_time property to zero, then you can disable the deletion of
generated test data jobs and API history.

1. Log in to the SSH console of HCL OneTest Server.
2. Run the following command to edit the configuration file:

kubect| edit configmap -n test-system {ny-ots}-data-config -o yanl

3. Search for the data_rotation_time property in the configuration file, and then set the value to the number of

days you want the jobs to retain in the server.
Note: The default value of data_rotation_time is 5.

For example, if you want to retain the jobs for 10 days, set the value of data_rotation_time property as 70.

4. Save your changes, and then exit from the configuration file.

5. Run the following command to delete and restart the <onetest data> pod:

kubect| del ete pod {ny-ots}-data-app-0

Results
You have successfully configured the setting to retain the jobs with generated test data and API history in HCL®
OneTest™ Data.

Jobs management

When you run a job to generate the test data, you can view the job details on the Jobs page. The Jobs page helps you
to view and to manage the list of all the jobs that you execute.

You can perform a quick search for the test data generated jobs based on the name of the schema or the date range
by selecting the From and To dates. If the To field is blank, you can view the results till the most recent date. After you
perform the search, if you want to continue to search for any schema or specific date, you must clear the Search field

by using the Clear Filter button.

You can delete and cancel the generated test data jobs.

Deleting a test data generated job

When any of the generated test data is of no further usage, you can delete that specific test data from your project.

Before you begin

 You must have a project.

» You must have generated test data.

About this task
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On the Jobs page, you can view the list of all the projects for which you have generated the test data. You can remove

the reference of any specific test data.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.
Result
The Overview page is displayed.
3. Click Author > Data Fabrication.
Result
The Data Fabrication page is displayed.
4. Click Jobs.
Result
You can view the list of data generated jobs.
5. Select a job for which you want to delete the test data.

You can select multiple jobs at a time to delete.

6. Click Delete Job from the menu or click the Delete icon ['1].

Results
The selected test data is deleted from your project.

Canceling a test data generation job

After initiating a test data generation job, if you want to modify the schema or terminate the job before the job
completes, then you can cancel the running test data generation job.

Before you begin
You must have a test data generation job in the in Progress status.
About this task

You can cancel only one test data generation job at a time. You can view the details of API endpoints of the canceled
job on the API History page. Later, if you want to reuse the same schema to generate the test data, you must select

Regenerate Job to regenerate the test data. However, you cannot download the test data of the canceled job.

Note: You can hover the cursor over the job to view the details of the member who canceled the job along

with the timestamp.

1. Log in to HCL OneTest™ Server and open the team space that contains your project.
2. Open your project.

Result

The Overview page is displayed.
3. Click Author > Data Fabrication.

Result
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The Data Fabrication page is displayed.
4. Go to the Jobs page and select the test data generation job that you want to cancel.
5. Click Cancel Job from the menu of the selected job.

A notification is displayed that the selected job is canceled.
Results
You successfully canceled the running job. The canceled job appears on the Jobs page with the status as cancel ed.
What to do next

You can modify the schema by using the schema designer and generate the test data.
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This guide describes tasks that you must complete before you can configure and run tests in HCL OneTest™
Server. You can find information about configuring runs for the different test types that are supported. You can also
find information about other tasks that you can perform on the Resource Monitoring Service, Virtualization, and
Integrations with third-party applications. This guide is intended for testers or test execution specialists.

System modeling

In this topic, you can find information about using the system model feature. You can also find the tasks that you can
perform to create a system model. You must configure a repository to save the system model that you created for the

application under test.

Introduction to system model

A system model is a logical presentation of the components contained in a system under test and the relationships
between components. You can create a system model when you want to visualize the different components and their
relationships as a diagrammatic representation.

You can create only one system model within a team space on HCL OneTest™ Server. A team space repository is
required to contain the system model that you create. Before you can create a system model, you must add a team
space repository. The system model that is created or edited is stored in the team space repository. All projects within
a team space share the same system model. All members of a team space can create, edit, and view the system
model.

After you log in to HCL OneTest™ Server, you can go to the System Model page to create a system model for your
team space. Alternatively, you can go to any of the projects in your team space and create a system model from
the System Model page within a project. The system model is accessible from all the projects of your team space

repository.
Components in a system model
Components are the basic building blocks which are used to represent a piece of software in an application.

You can model a system by using components. You can create components that represent the type of asset or

resource used by the system or application under test and can be of the following types:

Component type | Description

Database The component type represents the database resource. You can select this component type

when you want to represent a database asset or resource in the system model.

Service The component type represents the virtual service resource. You can select this component
type in the system model to represent a virtual service in the team space repository or associate

a virtual service resource that is in the project repository.
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Component type

Description

ul

The component type represents the User Interface (Ul) resource. You can select this component

type when you want to represent the User Interface resource in the system model.

You can create multiple components to depict the different resources in the system or application under test. You

can also associate virtual service resources with the components. The components in the system model can then be

associated with the virtual services stored in the repositories that are configured for each of the projects.

You can create the following types of relationships between the components:

- Components can be related as child components to parent components.

« Components can be related as dependent components. The dependency is displayed by a line-arrow with the

arrow-head pointing to the dependent component. For example, if Component A depends on Component B,

then the relationship is displayed with a line-arrow from Component A to Component B and the arrow points

to Component B. If Component B is also dependent on Component A, then the relationship is displayed with a

line-arrow from Component B to Component A and the arrow points to Component A.

Using the system model Ul

The following table lists the icons used in a system model and the icons that are displayed on the System Model

page:

Icon

Description

Represents a system model.

Represents Suites and Tests in a repository.

= Represents a database resource. The component name is prefixed with this icon when you se-
lect the component type as database.
@ Represents a service resource. The component name is prefixed with this icon when you select

the component type as service.

Represents a User Interface (Ul) resource. The component name is prefixed with this icon when
you select the component type as User Interface.

Used to add components, child components, and dependent components.

Used to search for components in the system model.

Represents the virtual services.

Used to publish the system model to the team space repository.

Represents the dependency between the components.
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Icon Description

Represents the inherited dependencies.

You can perform the following operations when you view the model displayed on the System Model page:

Operation

Action

Pan the view of the model

1. Click the Pan icon 'iml
2. Click on the area of the model that you want
to pan and move the area keeping the mouse

pressed.

Note: You must click the Pan icon to exit

from the pan mode.

Zoom-in the view of the model

1. Click the Zoom-in icon @\

The view is enlarged or zoomed-in.

Note: You can repeatedly click the Zoom-
in icon to further enlarge the view.

Zoom-out the view of the model

1. Click the Zoom-out icon a.

The view is diminished or zoomed-out.

Note: You can repeatedly click the Zoom-
out icon to further diminish the view.

Reset the view

1. Click the Menu icon £ on the System Model page.
2. Select Reset Zoom.

The view is reset to the default view without
any zoom applied. If the view was zoomed-in or
zoomed-out, the view is reset to 100% of the size.
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Operation Action

Position the model view
1. Click the Menu icon £ on the System Model page.
2. Select from the following options:
> Center: Select this option to align the
view of the model to the center of the
page.
> Fit to View: Select this option to fit the
view of the model in the window on the

System Model page.

Tasks in system modeling

When you want to model the system under test for the first time after you install the server software and you are a
licensed user in the team space, you must first add the team space repository. See Adding a repository to a team

space on page 234.

After a repository is configured as the team space repository, you can work with the system model. See Tasks for

working with a system model on page 233.

When you want to change, update or delete the repository, you can work with the team space repository. See Tasks

for working with the team space repository on page 234.

Task flows for working with a system model

You can find information about the tasks that you can perform when you want to create a system model, create
components, associate the components, create linkages among the components, and then publish the system model
to the team space repository. Also, you can find information about the tasks that you must perform when you want to
modify an existing system model.

Tasks for working with a system model

You can find the tasks when you want to create a system model for the application under test in your team space.

Tasks More information

Add a repository to the team space. | Adding a repository to a team space on page 234

Create a system model. Creating a system model on page 237

Create components in a system mod- | Creating components on page 238

el.

Create child components to existing | Creating child components on page 239

components in a system model.
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Tasks

More information

Define the relationship between the

components in a system model.

Creating linkages between components on page 242

Delete the relationship between the

components in a system model.

Deleting linkages between components on page 243

Modify components in a system
model.

Modifying components on page 245

Delete components in a system mod-
el.

Deleting components on page 247

Associate resources with compo-

nents in a system model.

Associating resources with components on page 248

View resources associated with com-

ponents in a system model.

Viewing resources associated with components on page 249

Remove resources that are associ-
ated with components in a system
model.

Removing resources associated with components on page 253

Publish changes made to the system

model.

Publishing changes to the system model on page 247

Publish changes of associating re-
sources in a project with compo-
nents in the system model.

Publishing changes of associating resources with components on

page 254

View system model.

Viewing the system model on page 255

Delete system model.

Deleting a system model on page 256

Tasks for working with the team space repository

You can find the tasks that you can perform when you want to work with the team space repository.

Tasks

More information

Add a repository to the team space.

Adding a repository to a team space on page 234

Delete a team space repository.

Deleting a repository that is added to a team space on page 256

Adding a repository to a team space

You must add a repository to the team space when you want to create, modify, or store a system model.

Before you begin
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You must have completed the following tasks:

- Ensured that you are assigned a role as a Team Space Owner or an Architect in the team space. See Managing
members and their roles in a team space on page 653.

« Been provided valid credentials to access the Git repository that you want to add.

About this task

As a Team Space Owner or an Architect, you can add a repository to the team space. You can add a repository to the

team space in any of the following methods:

- Add an existing repository that can contain test assets, which are created in the desktop products.
» Add a bare repository.

Attention: The repository that you want to add must not contain any projects or . pr oj ect files under the

root directory.

When you add a repository, the Git repository is cloned to the team space. While adding a repository, you must provide
the necessary authentication credentials that are set for the Git repository. For example, if the authentication type is
SSH, then you must provide the Git URL, a deploy key, and a passphrase.

Important: You can add only one repository to the team space. After you add a repository to the team space,
the option to add another repository is not available. You must delete an existing repository before you can
add a different repository.

1. Log in to HCL OneTest™ Server.
2. Open the team space to which you want a team space repository.
The Active projects page is displayed.
3. Click the Settings icon @] from the left navigation pane, and then select Manage team space.

The Details page is displayed.

4. Click Repository on the left navigation pane.

The Repository page is displayed.
5. Click Add repository.

The Add repository dialog is displayed.

6. Enter the URL of the Git repository, which you want to add to the team space, in the Git Repository field.

The required fields are displayed based on the type of Git URL that you entered.
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7. Enter the required credentials based on any of the following authentication methods configured in the

repository.

To gain access to the repository, you must use any one of the authentication methods:

Authentication method

Credentials required

SSH

o Deploy key
o Passphrase

HTTPS

o User name

> Password

HTTP

o User name

> Password

Notes:

> You must have defined the authentication type and set the authentication credentials in the Git

repository.

> If you use SSH to connect to your remote repository and HCL OneTest™ Server displays an Aut h

Fai | exception while using the deliver changes option, you can resolve this exception error by

regenerating your SSH keys by using the -m PEM option.

8. Click Add.

The Git repository is added to the team space on HCL OneTest™ Server.

Note: Depending on the size of the repository you are cloning, it can take a few to several minutes to

clone the repository.

What to do next

You can perform the following actions on the repository that you added:

« Update the authentication credentials if they are changed in the Git repository configuration. See Updating the

authentication credentials of the repository on page 676.

- Refresh a repository to fetch and synchronize changes from the remote repository. See Refreshing

repositories manually on page 677.

« Configure a webhook to notify the server if there is a push event in the remote repository. See Creating

webhooks on page 679.

» Add a system model to the repository. See Creating a system model on page 237.

« Delete a repository that is added to the team space, if it is no longer required. See .
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Related information

Managing repositories on page 672

Creating a system model

Before you can create components in a system model, you must create an empty system model and publish the

system model to the team space repository.
Before you begin

You must have completed the following tasks:

« Ensured that you are assigned a role as an Architect in the team space, a Project Owner or a Tester in the
project. See Managing members and their roles in a team space on page 653 or Managing access to server
projects on page 667.

« Added a repository to the team space. See Adding a repository to a team space on page 234.

1. Log in to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.

The Active projects page is displayed.

3. Select an option to create a system model based on your role in the team space or in a project in the team

space:

o If you are a Team space owner or an Architect, go to Step 4 on page 237.
o If you are not a Team space owner or an Architect but a project Owner or Tester, go to Step 5 on
page 237.
4. Perform the following steps, if you are a Team space owner or an Architect:

a. Click System Model on the left navigation pane.

The System Model page is displayed.

b. Click the Add system model icon @
An empty system model is created.
c. Go to Step 6 on page 238.
5. Perform the following steps, if you are not a Team space owner or an Architect but a Project owner:
a. Open your project that is displayed under My projects on the Active projects page.
The Overview page is displayed.

b. Click System Model on the left navigation pane.
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The System Model page is displayed.

c. Click the Add system model icon @
An empty system model is created.

d. Go to Step 6 on page 238.

6. Click the See unpublished commits icon @ and then select the Publish changes option.

Note: If you do not want to commit the changes that you made to the system model, you can select

the Discard changes option.

7. Enter a commit message in the Description of change field, and then click Publish.

The empty system model is committed and published to the team space repository. When the system model
is published to the team space repository, other members of the team space can work with the same system
model from any of their projects in the team space.

Results
You have created an empty system model and published it to the team space repository.
What to do next

You can perform any of the following tasks:

« Create components in the system model. See Creating components on page 238.
- Create child components for the components that you added to the system model. See Creating child

components on page 239.

Creating components

The first step in building a system model is to create components. The components serve as the building blocks for

the system model.
Before you begin

You must have completed the following tasks:
« Created and published the system model. See Creating a system model on page 237.

1. Log in to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.

The Active projects page is displayed.
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3. Click System Model on the left navigation pane.

The System Model page is displayed.

4. Perform the following steps to add a component to the system model:

a. Click the Add component icon ':l:' in the Components row on the right pane.
The Add a component dialog is displayed.
b. Enter a name for the component in the Name field.

c. Select the type of component that you want to add from the following options displayed in the Type
field.

. @ Service

=
= = Database

L
d. Click Add.

The component is displayed as a circular block on the system model pane with the icon and name of
the component below the block. The added component is also displayed under the Components list in
the right pane.

You create components of other types or the same type in the system model following the preceding
steps.

Results

You have created components in the system model.
What to do next

You can perform any of the following tasks:

« Publish the changes that you made to the system model. See Publishing changes to the system model on
page 247.

« Create child components for the components that you added to the system model. See Creating child
components on page 239.

- Create linkages between components in the system model. See Creating linkages between components on
page 242.

Creating child components

You can create components as children of existing components in the system model.

Before you begin
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You must have completed the following tasks:

- Created and published the system model. See Creating a system model on page 237.
« Created components in the system model. See Creating components on page 238.

About this task

You can create multiple components in your system model and multiple child components under any component in
the system model. After you create a child for a component, the child is represented as a circular block within the

circular component block in the system model.

1. Log in to HCL OneTest™ Server.

2. Open the team space to which a team space repository is added.

The Active projects page is displayed.

3. Click System Model on the left navigation pane.

The System Model page is displayed with the existing components.

4. Create child components in any of the following methods:

> To create child components from the left pane on the System Model page, go to Step 5 on page 240.
o To create child components from the right pane on the System Model page, go to Step 6 on
page 241.

5. Perform the following steps to create child components from the left pane:
a. Click the component under which you want to create child components in the left pane.

The details of the component are displayed in the right pane.

b. Click the Add child icon @ in the Children row on the right pane.
The Add a child to... dialog is displayed.
c. Enter a name for the component in the Name field.

d. Select the type of component that you want to add from the following options displayed in the Type
field.

. @ Service

S
= = Database

- ul

e. Click Add.
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The child component is displayed as a circular block within the circular block of the parent component
on the system model pane. The added child component is also displayed under the Children list under

the component in the right pane.

You create child components of other types or the same type for the same or other components in the
system model following the preceding steps.

6. Perform the following steps to create child components from the right pane of the stem model page:

a. Click the component name listed under the Components in the right pane.

b. Click the Add child icon @ in the Children row on the right pane.
The Add a child to... dialog is displayed.
c. Enter a name for the component in the Name field.

d. Select the type of component that you want to add from the following options displayed in the Type
field.

. @ Service

g
=l Database
- ul

e. Click Add.

The child component is displayed as a circular block within the circular block of the parent component
on the system model pane. The added child component is also displayed under the Children list under

the component in the right pane.

You create child components of other types or the same type for the same or other components in the
system model following the preceding steps.

Results

A component is created and it is associated as a child with the selected component and the name of the child is
displayed under the Children section in the right pane.

What to do next

You can perform any of the following tasks:

« Publish the changes that you made to the system model. See Publishing changes to the system model on
page 247.
« Create linkages between components in the system model. See Creating linkages between components on

page 242.
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Creating linkages between components

You can create linkages between components that display the relationship between them. The linkages can be

between components or between child components of the same or different parent components.
Before you begin

You must have completed the following tasks:

« Created and published the system model. See Creating a system model on page 237.
« Created components in the system model. See Creating components on page 238.
« Created child components. See Creating child components on page 239.

About this task

You can create multiple components in your system model and multiple child components under any component in

the system model. You can specify the dependency among the components.

1. Login to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.

The Active projects page is displayed.

3. Click System Model on the left navigation pane.

The System Model page is displayed.

4. Perform the following steps to create a relationship between the components in the system model:
a. Click the component that you want.
The details of the component are displayed in the right pane.

b. Select from the following types of relationships that you want to create:

Option Action

Depends on
Perform the following steps, if the component you selected is dependent

on another component:
i. Click the Add dependency icon @ in the row of the Depends on in
the right pane.

The Add dependency dialog is displayed.

ii. Select the component from the list of components displayed under
Depends on.
iii. Click Add.
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Option

Action

The components linked are listed under Depends on in the right pane. The
linkage between the first to the second component you select is shown
with an arrow that starts from the first and ends in the second component.

Is a dependency of

Perform the following steps, if the component you selected has a depen-

dency of another component:

i. Click the Add dependent icon @ in the row of the Is a dependency
of in the right pane.

The Add dependent dialog is displayed.

ii. Select the component from the list of components displayed under
Is a dependency of.
iii. Click Add.

The components linked are listed under Is a dependency of in the right
pane. The linkage between the first to the second component you select is
shown with an arrow that starts from the second and ends in the first com-

ponent.

Results

You have created linkages between components in the system model.

What to do next

You can publish the changes that you made to the system model. See Publishing changes to the system model on

page 247.

Deleting linkages between components

When you do not want to retain the linkages between components that you created in the system model, you can

delete the linkages.

Before you begin

You must have completed the following tasks:

« Created and published the system model. See Creating a system model on page 237.

« Created components in the system model. See Creating components on page 238.

« Created child components. See Creating child components on page 239.

- Created linkages between components in the system model. See Creating linkages between components on

page 242.
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1. Log in to HCL OneTest™ Server.

2. Open the team space to which a team space repository is added.

The Active projects page is displayed.

3. Click System Model on the left navigation pane.

The System Model page is displayed.

4. Perform the following steps to delete a relationship between the components in the system model:

a. Click the component that you want.

The details of the component are displayed in the right pane.

b. Select from the following types of relationships that you want to delete:

When...

Action

The component de-
pends on another com-

ponent.

Perform the following steps, if the component you selected is dependent
on another component:
i. Select the component from the list of components displayed under
the Depends on section in the right pane.

ii. Click the Delete selected icon ' inline with Depends on section.

The Delete relationship dialog is displayed with the details of the

component and the dependent component.

iii. Click Delete.

The component linkage is removed from the system model pane.

The component has a
dependency by another

component.

Perform the following steps, if the component you selected has a depen-
dency of another component:
i. Select the component from the list of components displayed under
the Is a dependency of section in the right pane.

ii. Click the Delete selected icon " inline with Is a dependency of

section.

The Delete relationship dialog is displayed with the details of the

component and the component dependency.

iii. Click Delete.

The component linkage is removed from the system model pane.

Results
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You have created linkages between components in the system model.
What to do next

You can publish the changes that you made to the system model. See Publishing changes to the system model on
page 247.

Modifying components

At any point in time, after you create a component, you can modify and update the details of the components such as
the component type, and the relationships with other components.

Before you begin

You must have completed the following tasks:

« Created and published the system model. See Creating a system model on page 237.
« Created components in the system model. See Creating components on page 238.

« Created child components. See Creating child components on page 239.

1. Log in to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.

The Active projects page is displayed.
3. Click System Model on the left navigation pane.

The System Model page is displayed.

4. Click the component that you want to edit.

The component details are displayed in the right pane.

5. Perform the actions for the task to modify components as listed in the following table:

Task Action

Change the component type. Perform the following steps:
a. Identify the component that you want to modify from the com-
ponents listed under Components in the right pane.

b. Click the component checkbox.

P
The Edit selected icon ©_ is enabled.

P
c. Click the Edit icon &

The Edit component dialog box is displayed.

d. Select the component type.
e. Click Modify
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Task

Action

The type of the component is modified.

Change the name of a component.

Perform the following steps:

a

Identify the component that you want to modify from the com-

ponents listed under Components in the right pane.

. Click the component checkbox.

A
The Edit selected icon & is enabled.

. . v
. Click the Editicon &_.

The Edit component dialog box is displayed.

. Edit the component name in the Name field.
. Click Modify.

The name of the component is modified.

Change the parent of a compo-

nent.

Perform the following steps:

a.

Identify the component that you want to modify from the com-
ponents listed under Components in the right pane.

. Click the component checkbox.

The Change parent icon ’33 is enabled.

|

. Click the Change parent icon .

The Change parent dialog box is displayed.

. Select another parent for the selected components that are list-

ed under the Parent list.

. Click Change.

The parent of the component is changed.

Results

You have edited components and updated the details successfully.

What to do next

You can publish the changes that you made to the system model. See Publishing changes to the system model on

page 247.
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Deleting components

When you do not require a component, you can delete the component.
Before you begin

You must have completed the following tasks:

« Created and published the system model. See Creating a system model on page 237.

« Created components in the system model. See Creating components on page 238.

1. Log in to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.

The Active projects page is displayed.

3. Click System Model on the left navigation pane.

The System Model page is displayed.

4. Click the component that you want to delete.
The component details are displayed in the right pane.
5. Click the Delete component icon U inline with the component name.

The Delete component dialog is displayed.

6. Click Delete.

Results
You have deleted a component from the system model.
What to do next

You can perform any of the following tasks:

« Publish the changes that you made to the system model. See Publishing changes to the system model on
page 247.
- Create components in the system model. See Creating components on page 238.

Publishing changes to the system model

When you create, delete, or modify components in a system model, the changes are saved locally and are not visible
to the other project members or team space members. You must publish the system model changes to the team
space repository to make your changes visible for all users of the team space.

Before you begin

You must have completed the following tasks:
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« Created and published the system model. See Creating a system model on page 237.

- Performed actions to add or modify the system model that you want to publish.

1. Log in to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.
The Active projects page is displayed.

3. Click System Model on the left navigation pane.

The System Model page is displayed.

4. Perform any of the following actions:
o Create a system model.
> Delete a system model.

> Modify a system model.

5. Click the See unpublished commits icon @ and then select the Publish changes option.

Note: If you do not want to commit the changes that you made to the system model, you can select
the Discard changes option.

6. Enter a commit message in the Description of change field, and then click Publish.

Results

You have published the changes that you made in the system model to the team space repository. Other members of

the team space can now view and use the system model.

Associating resources with components

After creating components in the system model, you can navigate to a project in the team space to associate the
Suites and Tests or virtual services resources in the project repositories with the components in the system model.

Before you begin

* You must have created components.

- You must be a member of the project that contains the Suites and Tests or virtual service resources.

1. Click Projects.

The Projects page is displayed.

2. Click the project that contains the Suites and Tests or virtual service resources that you want to associate
with components.

3. Click System Model.

4. Click the component that you want to associate with the Suites and Tests or virtual services resources.

The component details are displayed in the right pane.
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5. Click the Associate tab.

P
The associated resources are displayed. To associate more resources, click the Add association icon "/ next

to the resource type.
Note: Click the Add button to associate resources with the component for the first time.

To associate a resource with a component for the first time, you must perform the following steps:
a. Click Add.

A drop-down list is displayed.

b. Select one of the following resource types:
= Suites and Tests: Click this option if you want to associate your component with the different
types of test suites.
= Virtual Services: Click this option if you want to associate your component with the virtual

service resources.

The Associate Assets page is displayed.

Notes:

= You can view all the available resources of Suites and Tests or virtual services by
selecting the Suites and Tests and Virtual Resources check boxes.
= You can use the Search field to search for virtual service resources by entering the

name of the Suites and tests or virtual service resources.
c. Select one or more resources that you want to associate, and then click Add.
The added resources are displayed in the Associate and Overview tabs of the component.

o
6. Optional: Associate more resources by clicking the Add association icon "/ next to the resource type.

Results
You have associated components with the Suites and Tests or virtual service resources.

Viewing resources associated with components

After you associate Suites and Tests or virtual services resources with components in the system model, you can
view the associated resources from the System Model page. You can opt to start an instance of the associated

resource or stop a running instance of the associated resource.
Before you begin

You must have completed the following tasks:
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« Ensured that you are assigned a role as a Project Owner or Tester in the project. See Managing access to
server projects on page 667.

« Created and published the system model. See Creating a system model on page 237.

« Created components in the system model. See Creating components on page 238.

« Associated resources in a project with components in the system model. See Associating resources with

components on page 248.

1. Log in to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.
The Active projects page is displayed.

3. Click Active projects > My projects > project_name to open the project that contains the test assets.

The Overview page of the project is displayed.

4. Click System Model on the left navigation pane.

The System Model page is displayed.

5. Click the component that you associated with the resources in the project repository.

The resources associated with the component are displayed under the resource type in the Associate tab.
6. Click the Overview tab, if it is not already displayed.
The resources that are associated with the component are displayed under the Suites and Tests or Virtual
Services sections.
7. View and perform the actions for the resource type that you want from the following options:
> For Suites and Tests resources, go to 8 on page 250.
o For Virtual Services resources, go to 9 on page 257.

8. Identify the test resource that are listed under the Suites and Tests section, and perform the action that you

want described in the following table:

Task Description Action

Collapse You can collapse the resource Click the icon to toggle between the collapsed and expand-
icon sections by clicking the Collapse | ed display of the Suites and Tests section.
icon ",

Note: When the section
is collapsed, you can
view the number that

is displayed of the re-
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Task Description Action
sources that are associ-
/
ated.
Type You can view the type of the Hover over the Suites and Tests icon under the Type col-
Suite or test. umn to view the type of Suite or test.
Name You can view the name of the There is no action to perform.
associated Suite or test and the
path in the repository.
Status You can view the details of the Click each of the squares to view the details of the specific
test runs. test run. For example, if the status of a test run is represent-
ed as shown in the image u ', then it indicates
that the Suite or test has run only two times. After you click
any colored square, the Results page is displayed.
: ra
Action ) Click the Show in execution page icon L to view the Suite
You can start the execution of
. or test on the Execution page.
the Suite or test from the Exe- pag
cution page when you clickthe | The Suite or test is displayed on the Execution page.
ra
Show in execution page icon LJ.

9. Identify the virtual service resource that are listed under the Virtual Services section, and perform the action

that you want described in the following table:

Field

Description

Action

Collapse
icon "

You can collapse the resource
sections by clicking the Collapse
icon .

Note: When the section
is collapsed, you can
view the number that
is displayed of the re-
sources that are associ-
ated.

Click the icon to toggle between the collapsed and expand-

ed display of the Virtual Services section.

Show all
rA

icon L

You can opt to view the virtual
services that are associated with
the component either on the Re-

sources or Instances page.

Perform the following steps:

a. Click the Show all icon E.ll

b. Select any of the following actions:
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Field Description Action
You can start an instance of = To start an instance of the virtual service:
the virtual service from the Re- i. Select Show all in resources page to
sources page while you can stop go to the Resources page.
arunning instance from the In- ii. Click the Execute icon & in the row
stances page. of the virtual service.

iii. Configure the settings for the run
of the virtual service, if you want to
change any of the settings, else click
Execute.

The virtual service starts to run.
= To stop a running instance of the virtual ser-
vice:

i. Select Show all in instances page to
go to the Instances page.

ii. Identify the instance that you want to
stop and click the Stop icon O in
the Actions column of the selected
virtual service instance.

iii. Click Ok in the Stop virtual service
instance dialog that is displayed.

The running virtual service instance is
stopped.
Name You can view the name of the as- | There is no action to perform.
sociated virtual service and the
path in the repository.
Instances | You can view the state of the run- | There is no action to perform.
ning instance of the virtual ser-
vice resource. The state is dis-
played as Runni ng only if the in-
stance is running.
: ra
Action You can go to the Resources Click the Show resource icon LI to view the virtual service
page to view the virtual service | on the Resources page.
resource when you click the
. A The virtual service resource is displayed on the Resources
Show resource icon L.
page.
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icon }

Field Description Action
You can start an instance of
the virtual service from the Re-
sources page.
Expand You can expand the virtual ser- Perform the following steps:

vice card only if the virtual ser-

vice is a running instance.

In the expanded card, you can
view the details such as the En-
vironment, the total number of
requests received by the virtu-
al service, and the relative time
from when the virtual service

was started.

You can stop a running instance
of the virtual service from the In-

stances page.

a. Expand the virtual service card for a running in-

stance.

You can view the details of the instance.

A
b. Click the Show instance icon L to go to the In-
stances page to view the running instance of the vir-

tual service.

The running instance of the virtual service is dis-

played on the Instances page.

Results

You have viewed the resources that are associated with a component from the System Model page.

Removing resources associated with components

When you do not want to retain the resource that you associated with a component, you can delete the resource in the

system model.

Before you begin

You must have completed the following tasks:

- Ensured that you are assigned a role as a Project Owner or Tester in the project. See Managing access to

server projects on page 667.

« Created and published the system model. See Creating a system model on page 237.

« Created components in the system model. See Creating components on page 238.

- Associated resources in a project with components in the system model. See Associating resources with

components on page 248.

1. Log in to HCL OneTest™ Server.

2. Open the team space to which a team space repository is added.

The Active projects page is displayed.
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3. Click Active projects > My projects > project_name to open the project that contains the test assets.

The Overview page of the project is displayed.

4. Click System Model on the left navigation pane.

The System Model page is displayed.

5. Click the component that you associated with the resources in the project repository.

The resources associated with the component are displayed under the resource type in the Associate tab.

6. Select the resource that you want to remove from the component by clicking the checkbox of the resource.
You can select any or all resources for removal.

7. Click the Delete selected icon ! inline with the resource type.
The Disassociate... dialog is displayed for the type of resource that you selected. For example, the
Disassociate Suites and Tests dialog is displayed when you selected the test assets.

8. Click Delete.
For the changes to be reflected in the system model for all members of the project, you must publish the
changes to the project repository.

9. Open the Changes page by clicking Author > Changes.
10. Verify the changes listed and then click Publish changes.
11. Enter a commit message in the Description of change field, and then click Publish.

Results

You have removed resources that were associated with components in the system model.

Publishing changes of associating resources with components

After you associate resources in a project with a component in the system model, you must publish the changes
made to the branch in the project repository, if you want the associations to be visible to the other members in the
project.

Before you begin

You must have completed the following tasks:

- Created and published the system model. See Creating a system model on page 237.
« Created components in the system model. See Creating components on page 238.
« Associated resources in a project with components in the system model. See Associating resources with

components on page 248.

1. Login to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.
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The Active projects page is displayed.

3. Click Active projects > My projects > project_name to open the project that contains the test assets.

The Overview page of the project is displayed.

4. Open the Changes page by clicking Author > Changes.

The Changes page is displayed. You can find the following information about the changes that you made to
the system model when you associated resources with components:
o The resources that you associated with components are listed under the Asset name column.
> The type of change is listed under the Changes column.
> The name of the member who made the change is displayed under the Last changed by column.
> The relative time when the change was made is displayed under the Last updated column.
> The number of changes that the Edit branch is ahead of from the project repository branch is indicated
by the commits ahead option. You can view the details by clicking the commits ahead option.
> The number of changes that the Edit branch is behind from the project repository branch is indicated
by the commits behind option. The Edit branch can be behind the project repository branch if another
member has published or committed other changes in the system model to the same project
repository branch. You can view the details by clicking the commits behind option.
5. Click the Publish changes option.

Note: If you do now want to commit the changes you made to the system model, you can select the

Discard changes option.

6. Enter a commit message in the Description of change field, and then click Publish.

Results
You have published the changes that you made in the system model to the repository in the project. Other members

of the team space can now view and use the system model.

Viewing the system model

You can view an existing system model or you can create a system model if a system model does not exist on the

System Model page.

Before you begin

You must be a licensed user.

1. Log in to HCL OneTest™ Server.
2. Click System Model.

The System Model page is displayed.

3. Perform any of the following actions:
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> Add a team space repository, if no repository is configured as the team space repository.
- Create a system model, if no model is created or exists.

> View the system model that exists.

> Modify the existing system model.

Results
You have viewed an existing system model from the System Model page.

Deleting a system model

When you want to remove an existing system model to create a new system model, you can delete the existing

system model.

Before you begin
You must have ensured that a system model exists in the Initial Team Space.

1. Log in to HCL OneTest™ Server.
2. Click System Model.

The System Model page is displayed.

3. Click the Open action menu icon E in the right-pane.
4. Click the Delete icon '/
The Delete System Model dialog is displayed.

5. Click Delete.

Results
You have deleted the system model from the team space repository.

What to do next
You must publish the changes to the team space repository. See Publishing changes to the system model on
page 247.

Deleting a repository that is added to a team space
You can delete a repository that you added to the team space when you do not want to use a team space repository.
Before you begin

You must have completed the following tasks:

« Ensured that you are assigned a role as a Team Space Owner or an Architect in the team space. See Managing
members and their roles in a team space on page 653.

» Added a repository to the team space. See Adding a repository to a team space on page 234.
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1. Log in to HCL OneTest™ Server.
2. Open the team space to which a team space repository is added.

The Active projects page is displayed.

fol

3. Click the Settings icon k¥4 from the left navigation pane, and then select Manage team space.

The Details page is displayed.

4. Click Repository on the left navigation pane.
The Repository page is displayed.

5. Click the Open action menu icon E

6. Click Delete in the action menu list.

The Delete repository dialog is displayed.

7. Select the I understand... checkbox, and then click Delete.

Results

You have deleted the ream space repository.

® Restriction: When you delete the team space repository, the system model if created is also deleted, and you
or other members of the team space cannot add a system model.

Prerequisites to running tests

Before you can run a test asset in a project on HCL OneTest™ Server, you must read the information about the
different tests assets. You can add a remote static agent, Docker host, or Kubernetes cluster to the project and then
select it as an alternate location to run the test assets.

You can find the following information about the prerequisite tasks:

« Test run considerations for AFT Suites or Functional tests on page 258
« Test run considerations for API Suites or API tests on page 259
« Test run considerations for schedules on page 262
« Considerations for using Jaeger traces in reports on page 263
« Test run considerations for JMeter tests on page 264
« Test run considerations for JUnit tests on page 266
« Test run considerations for Postman tests on page 267
- Management of agents on page 268
o Test run considerations for running tests on remote agents on page 270
« Management of Docker hosts on page 277

o Test run considerations for running tests on remote Docker hosts on page 277
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- Management of remote Kubernetes clusters on page 293

» Considerations for using a remote Kubernetes cluster on page 294

Related information

Tests configurations and test runs

Test run considerations for AFT Suites or Functional tests

Before you configure an AFT Suite or a Functional test run, you must first read the considerations that you need to

take into account.

When you want to run an AFT Suite or Functional test in a project on HCL OneTest™ Server, you can check if the AFT
Suite or Functional test meets any of the following conditions:

If... Then...

The AFT Suite or Functional test uses the settings con-

) . You must ensure that you have configured the location
figured in an AFT XM file for a remote agent y g

element in the AFT XM to point to a remote agent.

For more information about setting the location element,
refer to Using an XML file to run multiple Web Ul tests

and compound tests simultaneously.

You want to run an AFT Suite or Functional test on a re-
You must run the test on the remote agent before you

mote agent
commit the test asset to the remote repository.
When you run the test on the remote agent, the following

events occur:

» The agent is added as the location in the AFT
XML file, on which the test is to be run.

 The agent is displayed as the agent on which the
test is to be run, under the Host column within
the Location tab in the Execute test asset dialog
box.

You commit the test asset to the remote repository with-

. The agent is not displayed under the Host column within
out running the test on the remote agent

the Location tab in the Execute test asset dialog box.

Before you configure the run for an AFT Suite or a Functional test, you must complete the following tasks, if they are

applicable:
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» Add the remote agents, on which the test is to be run, to the project on HCL OneTest™ Server. See Adding a
performance agent to a project on page 272.

- After you add the agent, you can select the agent configured in the AFT XM file as the location for the test
run or select the remote agents that you add to the project, when you configure a run for an AFT Suite.

The remote agents are shown as the agents available for selection under the Override column within the
Location tab in the Execute test asset dialog box.

You can then select the remote agent as the location to run the AFT Suite or Functional test
when you are configuring the test run. Alternatively, you can enter the argument - swapl ocat i on
<confi gured_agent _| ocati on>: <overri di ng_agent _| ocat i on> in the Program Arguments field in the Advanced

Setting dialog box when you are configuring the test run.

For running an AFT Suite, see Configuring an AFT Suite run on page 313.

Related information

Tests configurations and test runs

Test run considerations for API Suites or API tests

Before you configure an API Suite or API test run, you must first read the considerations that you need to take into

account.

You can find the following information about API Suites:

 Important information about API Suites or tests on page 259

« Important information about report configuration in API Suites or tests on page 262

Important information about API Suites or tests

When you want to run an API Suite or test from a project on HCL OneTest™ Server and the test asset in HCL OneTest™

API meets any of the following conditions:

« The Suite or test refers to local stubs that use a transport other than HTTP or MQ.

 The Suite or test refers to local stubs that use the HTTP transport.

« The transport used in the tests or Suite is configured with the host name set to localhost for the HTTP/TCP
proxy.

« The Suite or test has tests that use a transport and the transport requires third-party application Jar files for a

successful run.

You must then refer to the following table for the next steps:
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Then...

The test asset refers to local stubs that use a transport
other than HTTP or MQ.

You must perform any of the following actions before
you commit the test asset to the remote repository:

» Remove the reference to the local stub from the
test asset.
« Publish the stubs to HCL® Quality Server.

To publish and edit stubs, see Publishing stubs.

The tests refer to local stubs that use the HTTP trans-
port.

You must perform the following actions before you com-

mit the test asset to the remote repository:

1. Create a test or test Suite that contains the stub
and tests that run on the stub.

2. Configure the physical HTTP transport with the
following parameters in the Client tab in the
Physical View:

o Set the Host name or 1P address of the
HTTP Proxy server in the Proxy Host field.

o Set 3728 as the proxy server port in the
Proxy Port field.

3. Set the reference to the stub for the tests in the
test suite scenario from the Scenario Editor dia-
log box from the Test Factory view by selecting
the Live system option in the Satisfied by column
to run the stubs on the HTTP proxy registered
with HCL OneTest™ Server.

4. Save the project.

The transport used in the Suite or tests is configured
with the host name set to localhost for the HTTP/TCP

proxy.

You must replace the host name with fully-qualified-do-
main-name or IPAddress of the proxy host in the tests be-

fore you commit the test asset to the remote repository.

You plan to run the API Suite or test on the computer
where HCL OneTest™ Server is installed and the API

You must complete the following tasks:
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If...

Then...

Suite or test that use a transport from any of the follow-

ing third-party applications:

« Camel

« CentraSite

« CICS

« Coherence

« Database

- IMS

* Integra

« JMS

* SAP RFC

- Software AG Universal Messaging

» TIBCO EMS

« TIBCO Rendezvous

 TIBCO SmartSockets

» WebSphere Application Server Service Integra-
tion Bus (SiBus)

« WebLogic

« Software AG webMethods

» WebSphere MQ

1. Identify the location of the third-party application
JARfiles. You can use Library Manager to know
the location where the third-party application JAR
files are saved.

2. Copy the third-party application JARfiles to the
computer where HCL OneTest™ Server is in-
stalled.

See Copying third-party application Jars to Kubernetes
on page 94.

You plan to run the API Suite or test on a remote Dock-
er host and the API Suite or test contains tests that use
a transport from any of the following third-party applica-

tions:

» Camel

* CentraSite

« CICS

» Coherence
 Database

« IMS

* Integra

- JMS

« SAP RFC

- Software AG Universal Messaging
« TIBCO EMS

» TIBCO Rendezvous

» TIBCO SmartSockets

You must complete the following tasks:

1. Identify the location of the third-party application
JARfiles. You can use Library Manager to know
the location where the third-party application JAR
files are saved.

2. Copy the third-party application JARfiles to the
computer where the remote Docker host is in-

stalled.

See Copying third-party application Jars to a remote
Docker host on page 282.
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If... Then...

» WebSphere Application Server Service Integra-
tion Bus (SiBus)

» WebLogic

« Software AG webMethods

» WebSphere MQ

Important information about report configuration in API Suites or tests

You must configure test Suites or tests in HCL OneTest™ API to use a results database so that the details of the test
results can be captured and displayed in the HCL OneTest™ Server API results reports. See Configuring the project

results database.

If your server projects use either a Microsoft SQL Server, MYSQL, or both as a project results database, you must
copy the Microsoft SQL Server and MySQL database JAR files to the JDBC folder in the path / dat a/ JDBC on HCL
OneTest™ Server. See Copying third-party application Jars to Kubernetes on page 94.

The database JAR files that you need are based on the version of Microsoft SQL Server or MQSQL that you use with
HCL OneTest™ API. See Adding Microsoft SQL Server and MySQL drivers.

To run an API Suite, see Configuring an API Suite or an API test run on page 323.

Related information

Scenario reference setting

Tests configurations and test runs

Test run considerations for schedules
Before you configure a Rate Schedule or VU Schedule run, you must first read the considerations that you need to take

into account.

Important information about JMeter tests in schedules

When you want to run JMeter tests as part of the VU Schedule or Rate Schedule on HCL OneTest™ Server, you must
have completed the following tasks:

* Installed the HCL OneTest™ Performance Agent on a computer.

- Installed the JMeter application on the computer where you have installed the HCL OneTest™ Performance
Agent.

« Set the environment variable JMETER_HOME that points to the JMeter installation directory.
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Important information about Resource Monitoring sources in schedules

When you want to run schedules on HCL OneTest™ Server, you must have completed the following tasks in HCL

OneTest™ Performance:

- Created a performance schedule of Rate or VU type.
- Added Resource Monitoring sources, or the labels of Resource Monitoring sources to a schedule. Refer to

Adding resource monitoring sources to a performance schedule by using labels.
Before you configure a run of a Schedule, you must complete the following tasks in HCL OneTest™ Server:

« Add Resource Monitoring sources to your project in HCL OneTest™ Server. See Monitoring an NGINX server on
page 510.

- Enable HCL OneTest™ Server as Resource Monitoring service only if you want to replace Resource Monitoring
labels set in HCL OneTest™ Performance with the labels that you created in HCL OneTest™ Server. See
Controlling resource monitoring sources in a schedule on page 542.

« Perform the following steps when you want to override the Resource Monitoring labels in the test asset with
the Resource Monitoring labels that you create in HCL OneTest™ Server:

1. Click the Resource Monitoring tab.

Note:

The Resource Monitoring tab displays only if you enabled the Resource Monitoring from

Service option in HCL OneTest™ Performance when you created the test asset.

2. Click © ,and press the arl + space bar keys, or enter the initial letter of a label to select a label in
the list.

Note:

You can select or add labels only if you added the labels in the Resource Monitoring Sources
page in HCL OneTest™ Server.

For running a Rate Schedule or VU Schedule, see Configuring a run of a Rate Schedule or VU Schedule on page 406.

Related information

Tests configurations and test runs

Considerations for using Jaeger traces in reports

Before you can use Jaeger to report the test results in the supported tests, you must read the considerations that you

must take into account.
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When you want to enable Suites, Tests, or Schedules that are run from HCL OneTest™ Server to use Jaeger traces for

reporting the test results, you must have completed the following tasks:

« Installed Jaeger at the time of installation of the server software. See Prerequisites for installing the server
software on Azure Kubernetes Service on page 50 or Prerequisites for installing the server software on Ubuntu
on page 37.

« Verified that Jeager is enabled and working.

After you install and verify that Jaeger is enabled, and when you want Jaeger to report the test results for the tests

that you configure for a run, you must perform the following steps:

1. Click Advanced.
2. Enter - hi story j aeger in the Program Arguments field.

Related information

Tests configurations and test runs

Test run considerations for JMeter tests

Before you can run JMeter tests on HCL OneTest™ Server, you must read the considerations that you must take into

account and complete the tasks indicated.

When you want to run JMeter tests that you create in JMeter, you must have completed the following tasks:

« You must ensure that the JMeter extension on HCL OneTest™ Server is enabled at the time of installation
of the server software or is running before you add the repository that contains JMeter tests to the server
project. See Prerequisites for installing the server software on Azure Kubernetes Service on page 50 or
Prerequisites for installing the server software on Ubuntu on page 37.

« You must have committed the following JMeter assets or resources as a JMeter project to the remote
repository:

Note: You must have created a project directory and added the associated tests or assets in sub

directories, that might be required for the JMeter tests to run successfully.

> Thej nmet er Root . j prj project file in the project directory.

o The JMeter tests in a sub directory with a name you provide within the project directory.

> Optionally, the Java Key Store that is required at test run time in the cer t s sub directory.

> Optionally, the JMeter properties files that are required at test run time in the pr operti es sub
directory.

o Optionally, the library jar files that are required at test run time in the | i b sub directory.

> Optionally, the test dependencies that are required at test run time in the deps sub directory.
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For example, the project directory can be myproject that contains the j net er Root . j prj project file. In the
project directory, you can create the following sub directories:

> The nyt est s sub directory that contains the JMeter tests.

> Optionally, the cer t s sub directory that contains the Java Key Store.

For example, the path to the key store can be specified in the syst em properti es file as follows:

javax.net.ssl.trustStore=$(deploy.home) /certs/simpleStore.jks

Where <simpleStore.jks> is the Java Key Store and the <deploy.home> is the keyword to access the key
store at the test run time.
> Optionally, the pr oper t i es sub directory that contains properties files such as
system properties,jnmeter. properties,reportGenerator.properties,or
user. properties.
o Optionally, the | i b sub directory that contains the lib and lib/ext content to be used at test run time.
For example, the amq client and the plugins required to parse the jmx that contains amqp calls.
> Optionally, the deps sub directory that contains the test dependencies.
The resulting project directory can be as follows:
myproject (that contains the jmeterRoot.jprj)
myproject/mytests
myproject/certs
myproject/properties
myproject/1lib
myproject/deps
 You must ensure that you use a relative path when JMeter tests refer to other test assets. For example, if the
JMeter test that is in the mypr oj ect/ myt est s folder refers to a mycsv. csv file that is in the mypr oj ect /
deps folder, then the nycsv. csv is referred as follows: . . / deps/ nycsv. csv in the JMeter test.

- You can create the JMeter project file named as j net er Root . j prj .

The project file is a java properties file. The JMeter project file is required so that HCL OneTest™ Server
can identify the asset as a JMeter project. You can specify additional information in the project file. You
can specify the names of the sub directories created and through keywords you can specify the path in the
properties files whether they are relative to the root directory or to the tests sub directory.

For example, if you have created the following sub directories in the project directory called myproject that
contains the j met er Root . j prj project file:

o myproj ect/ mytests

°myproj ect/properties
If the JMeter tests are contained in the following path: nypr oj ect / myt est s/ t est pl an/ t est 1. j nx,
and some dependencies that are also required to be deployed at test run time exists in the following path:
nmypr oj ect / nyt est s/t est pl an/ | ocal di r. You must specify these file paths in the project file as
follows:
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testDir.localtest.sub.dir=1localdir
aSecondRootDir.sub.dir=dir2
athirdRootDir.sub.dir=dir3

® Restriction: You cannot run the test assets on a remote Docker host.

Related reference
Troubleshooting issues on page 1069
Related information

Configuring a run of a JMeter test on page 386

Test run considerations for JUnit tests

Before you can run JUnit tests on HCL OneTest™ Server, you must read the considerations that you must take into

account and complete the tasks indicated.

When you want to run JUnit tests, you must have completed the following tasks:

« You must ensure that the JUnit extension on HCL OneTest™ Server is enabled at the time of installation of the
server software or is running before you add the repository that contains the JUnit tests to the server project.
See Prerequisites for installing the server software on Azure Kubernetes Service on page 50 or Prerequisites
for installing the server software on Ubuntu on page 37.

« You must have created the JUnit tests that use JDK 8, as part of a Maven V3.6.3 project. The Maven project
must contain the Maven Surefire plugin, which is required to run the JUnit tests contained in the Maven
project. The Maven project as a pom xm must be committed to the remote repository.

Note: If you create the JUnit tests on other versions of JDK, you must copy the JDK version to the
user | i bs pod under the dat a/ j uni t - ext/ j dks directory. See Copying third-party application Jars

to Kubernetes on page 94.
® Restriction: You cannot run the test assets on a remote Docker host.

Related reference
Troubleshooting issues on page 1069
Related information

Configuring a run of a JUnit test on page 392
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Test run considerations for Postman tests

Before you can run Postman tests on HCL OneTest™ Server, you must read the considerations that you must take into

account and complete the tasks indicated.

When you want to run Postman tests that you create in Postman, you must have completed the following tasks:

 You must ensure that the Postman extension on HCL OneTest™ Server is enabled at the time of installation
of the server software or is running before you add the repository that contains Postman collections to the
server project. See Prerequisites for installing the server software on Azure Kubernetes Service on page 50 or

Prerequisites for installing the server software on Ubuntu on page 37.

® Restriction: If you add the repository with Postman collections to a server project before you enable
the Postman microservice, the Postman collections might not be displayed in the Execution page for

you.

 You must have exported the following resources from Postman and saved the resources on your computer:
> Collections and their associated variables and environments from Postman in which all collections are

exported as a single file.
Note: You can export as many collections as you want.

For more information, refer to Exporting a collection from Postman and Exporting data dumps.

= Environments configured in Postman, if you are exporting only the environments as separate JSON

files.

For more information, refer to Exporting environments from Postman.

 You must have committed the following Postman assets or resources to the remote repository:
o Collections and their associated variables and environments that you exported. You can export all
resources that are in your workspace in Postman. You can also export the collections along with the

variables as a single file and the environments separately as another file.

For example, you can save the exported file as MyCol | ect i onsVar Env. j son that contains the
collections, variables, and environments or you can export only the collections and variables as
MyCol | ecti onsVar. json.

> Environments that you exported, if you are exporting only the environments as separate JSON files.
For example, you can save the exported file as MyEnv. j son.

o An empty text file with the . post man extension that is contained in the same directory as the other
Postman resources, so that the contents in the directory are attributed as Postman resources. For

example, you can create MyPr oj ect . post man.
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Note: The . post man file enables HCL OneTest™ Server to identify the test resources as

Postman resources.

For example, if you have saved the Postman resources that you downloaded from Postman as follows:
= MyCol | ecti onsVar Env. j son or MyCol | ecti onsVar . j son that contains the Postman
collections.
= MyEnv. j son that contains the environments associated with the Postman collection.
The project directory can be as follows:
/Project

/Project/M/Proj ect . post man
/Project/MyCol | ecti onsVar Env. j son

Alternatively, the directory can be as follows:

/Project

/Project/M/Proj ect . post man
/Project/MyCol | ecti onsVar.j son
/Project/M/Env. j son

® Restriction: You cannot run the test assets on a remote Docker host.

Related reference
Troubleshooting issues on page 1069
Related information

Configuring a run of a Postman test on page 399

Management of agents

You can find information about managing the agents that you must install on remote computers and configure the
agents to register with HCL OneTest™ Server. After the agents are registered, you can add them to your projects and

then select them as locations to run tests.

When you plan to run any of the tests on a remote agent from a project on HCL OneTest™ Server, you must have

completed the following tasks:

« Installed the agent of the same version as the version of HCL OneTest™ Server.
- Configured the agent with your offline user token so that the agent can connect and also register with HCL

OneTest™ Server.
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Note: When you configure the agent to connect to the server by using the offline user token that you

generated on HCL OneTest™ Server, you become the owner of the agent.

« Verified that you have write permissions to the maj or dono. conf i g file so that certain transactions can be

written by HCL OneTest™ Server to the maj or dono. confi g file.

Note: You can verify if you have the Read and Write permissions by checking the properties of the

maj or dono. confi g file.

« Viewed the agents that are registered with HCL OneTest™ Server. See Viewing agents that are registered with
HCL OneTest Server on page 271.

» Added the remote agents that are registered with HCL OneTest™ Server to your project on HCL OneTest™
Server. See Viewing agents that are registered with HCL OneTest Server on page 271.

Note: After you add the remote agents to your project, HCL OneTest™ Server determines the
capabilities that are provided by the remote agent and displays the details and capabilities of the
agent on the Infrastructure page. You can also define the capabilities that you want to add, and then
view, edit, or delete the capabilities that you defined for the agents in your project. See Working with

agent capabilities on page 274.

Related information

Agent installation

Management of agents

You can find information about managing the agents that you must install on remote computers and configure the
agents to register with HCL OneTest™ Server. After the agents are registered, you can add them to your projects and

then select them as locations to run tests.

When you plan to run any of the tests on a remote agent from a project on HCL OneTest™ Server, you must have

completed the following tasks:

- Installed the agent of the same version as the version of HCL OneTest™ Server.
- Configured the agent with your offline user token so that the agent can connect and also register with HCL

OneTest™ Server.
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Note: When you configure the agent to connect to the server by using the offline user token that you

generated on HCL OneTest™ Server, you become the owner of the agent.

« Verified that you have write permissions to the maj or dono. conf i g file so that certain transactions can be

written by HCL OneTest™ Server to the maj or dono. confi g file.

Note: You can verify if you have the Read and Write permissions by checking the properties of the

maj or dono. confi g file.

« Viewed the agents that are registered with HCL OneTest™ Server. See Viewing agents that are registered with
HCL OneTest Server on page 271.

» Added the remote agents that are registered with HCL OneTest™ Server to your project on HCL OneTest™

Server. See Adding a performance agent to a project on page 272.

Note: After you add the remote agents to your project, HCL OneTest™ Server determines the
capabilities that are provided by the remote agent and displays the details and capabilities of the
agent on the Infrastructure page. You can also define the capabilities that you want to add, and then
view, edit, or delete the capabilities that you defined for the agents in your project. See Working with

agent capabilities on page 274.

Related information

Agent installation

Test run considerations for running tests on remote agents

Before you configure a test to run on a remote agent from HCL OneTest™ Server, you must read the considerations

that you must take into account.

Supported tests

You can run the following tests that are supported to be run on a remote agent:

* AFT Suite

« Compound Tests that contains performance tests

« Compound Tests that contains Web Ul tests

« Compound Tests that contains traditional HTML tests
« Rate Schedule

* VU Schedule
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Prerequisite tasks

Before you can run any of the supported tests on a remote agent from a project on HCL OneTest™ Server, you must
have completed the following tasks:

« Installed the agent on the remote computer. See Management of agents on page 268.
- Configured the agent with your offline user token so that the agent can connect to HCL OneTest™ Server.
» Added the remote agents to your project on HCL OneTest™ Server. See Adding a performance agent to a

project on page 272.

Note: If you want to run an AFT Suite (that contains Web Ul tests) on an agent, you must start the agent as a
non-admin user so that certain browsers that are configured start correctly during the test run time.

Before you add the tests to the remote repository, you must have completed the following tasks:

« Associated the agents with the performance schedule in HCL OneTest™ Performance.
« Specified the host name of the remote workstation in the AFT XML file.

You can continue to configure a run for any of the following supported test types:

« Configuring an AFT Suite run on page 313

« Configuring a run of a Compound Test that contains performance tests or a Performance test on page 376
« Configuring a run of a Compound Test that contains Web Ul tests or a Functional Web Ul test on page 343
« Configuring a run of a Compound Test that contains HTML tests on page 334

« Configuring a run of a Rate Schedule or VU Schedule on page 406

Viewing agents that are registered with HCL OneTest™ Server

After you install the remote agents and configure them with your offline user token, the agents register with HCL
OneTest™ Server and you can view the registered agents on the Agents and Intercepts page.

Before you begin

You must have completed the following tasks:

« Installed the agent of the same version as the version of HCL OneTest™ Server.
« Configured the agent with your offline user token so that the agent can register with HCL OneTest™ Server.

Note: When you configure the agent to connect to the server, you must specify the offline user token
that you generated on HCL OneTest™ Server. This token defines your ownership over the agent.

1. Log in to HCL OneTest™ Server.

2. Click Infrastructure > Agents and Intercepts in the navigation pane.

The Agents and Intercepts page is displayed.
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You can view the agents, intercepts or Dockers that are registered with HCL OneTest™ Server.

3. You can view the agents that you own in any of the following ways:

- Search for the agent by entering the name of the agent in the Search field.

Note: You can enter either the full name or any text that is in the name. The search is enabled

for case sensitive text that you can enter.

> Sort the Type column to sort the items and display the agents in the rows at the top of the table.

- Sort the Agents column and identify the agents by their names or by their owner.

You can view the following details about the agents that are registered with HCL OneTest™ Server:
> The projects to which the agent is added, are displayed in the Projects column.

> The status of the agent is displayed in the Status column.

Note: You can add agents that are in the rReady state to your project, and then use them as

locations to run tests.

Results
You have viewed the registered agents from the Agents and Intercepts page.

What to do next
You can add the agents that you own to your project. See Adding a performance agent to a project on page 272.

Adding a performance agent to a project

If you have performance tests that distribute workload across different workstations or Accelerated Functional
Testing (AFT) Suites that need to run on different platforms and browsers, you can add HCL OneTest™ Performance

Agents to your projects to run tests on remote workstations.
Before you begin

You must have completed the following tasks:

» Read and completed the tasks mentioned in Test run considerations for running tests on remote agents on
page 270, if you want to use a remote agent as the location to run the test.

- Ensured that you are assigned a role as a Member or Project Creator in the team space. See Managing
members and their roles in a team space on page 653.

« Ensured that you are assigned a role as a Project Owner or Tester in the project. See Managing access to
server projects on page 667.

- Installed the agent by using your offline user token that makes you the owner of the agent or you are assigned

the role of a Team Space Owner.

About this task
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Only you can add or remove a performance agent that you own from the project. However, any member of
your project with the permission to run the tests can initiate the run of test assets that are associated with the
performance agent.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Open your project, and then click Infrastructure > Agents and Intercepts.

The Agents and Intercepts page is displayed.
3. Click Add > Add agent.

The performance agents that you configured with your user token are displayed.

Note: You can add the performance agents that you own and that are in the Ready state. You can add
any number of performance agents to your project.

4. Select the performance agents that you want to use in the project, and then click Add.

The performance agents that you added to the project are displayed.

5. Perform the following steps to view details and capabilities of the performance agents:
a. Expand the performance agent to view the details panel.

You can find the following details of the performance agent displayed:

Parameter Description

Version The version of the installed performance agent.

Address The IP address of the computer on which the performance agent is in-
stalled.

License type The license type that is enabled for you to use the performance agent.

Load generation service | The status of the performance agent whether it can be used for load gener-

ation service.

Last contact The time of the last contact with the performance agent by HCL OneTest™

Server.

b. Expand the capabilities panel to view the system and application capabilities.

You can find the following capabilities of the performance agent displayed:
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Capabilities

Description

System capabilities

Architecture

The architecture of the CPU processor of the computer

on which the performance agent is installed.

MAC Address

The MAC address of the computer on which the perfor-

mance agent is installed.

Operating system

The operating system of the computer on which the per-
formance agent is installed.

bilities

RAM The memory that is allotted to RAM in the computer on
which the performance agent is installed.
Application capabil- | Browser The browsers along with their version that are installed
ities on the computer on which the agent is installed.
User Defined capa- | User Defined The capabilities that you add for a performance agent.

You can also tag a performance agent so that you can
identify the performance agent to select as a location.

c. Check for the status of the performance agent from the Status column.

Note: You can add performance agents that are in any state to the project.

Results

You have added remote performance agents to your project and viewed the performance agent capabilities that is
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displayed for each agent that you own.

What to do next

You can perform any of the following tasks:

« Run the tests on the performance agent that is added to the project from the Execution page. See Test run

configurations on page 308.

« Define the capabilities that you want to add, and then view, edit, or delete the capabilities that you defined for

the performance agents in your project. See Working with agent capabilities on page 274.

Working with agent capabilities

When you installed static agents V10.1.2 or later, and added them to your project, you can view capabilities of the

agents from the Infrastructure page. When you installed static agents V10.2.0 or later, you can add, view, edit, or

delete properties and capabilities of agents from the User Defined panel of that agent.

Before you begin

You must have completed the following tasks:
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» Been assigned a Member or Project Creator role in a team space.

» Been assigned the Owner or Tester role in the project to which you want to add the agent.

« Owned at least one agent that is not added to the project.

« Installed the agent. See Test run considerations for running tests on remote agents on page 270.

» Added agents to your project. See Adding a performance agent to a project on page 272.

1. Log in to HCL OneTest™ Server and open the team space.

. Open your project, and then click Manage > Infrastructure.

The agents that you added to your project are displayed on the Infrastructure page.

3. Expand the agent.

The Details and Capabilities tabs are displayed.

5. Click User Defined.

. Click Capabilities to view the capabilities of the agent.

The User Defined Capabilities dialog box is displayed.

. Complete the steps for the task that you want to perform as listed in the following table:

Task

Action

Adding capabilities

Perform the following actions:
a. Click Add new.
b. Enter the name of the capability in the Capability Name field.
c. Perform any of the following actions in the User Defined Category field:
= Select an existing category from the list.
= Enter a name of the category for the capability, if the category does

not exist.
Note: You can also click Add new to add a category.

The category for the capability is either selected or created and the fields for
the property name and value are displayed.

Note: The property for a capability is a name-value pair.

d. Enter a name for the property in the Property Name field and its correspond-

ing value in the Property Value field for the capability.
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Task

Action

Note: You can add multiple properties for the same capability under
the same category or under different categories by clicking Add new

property, and then by entering the name and value for the property.

e. Click Save.
The capabilities that you added are displayed.

Viewing capabilities
that you added

The User Defined Capabilities panel displays the capabilities that you added to the
agent.

Editing capabilities
that you added

Perform the following actions:

a. Click the Edit icon 4 in the row of the capability that you want to edit.

The user-defined capability is enabled for editing. You can edit the name of
the capability, or the property name or property value.

b. Edit any of the items that you want for the user-defined capability.
c. Click Update.
The updated capability of the agent is displayed.

Deleting capabilities
that you added

a. Click the Delete icon ['] in the row of the capability that you want to delete.
b. Click Delete.
The capability that you selected is deleted along with all the properties that you
added for the capability.

Deleting a property de-
fined for a capability

5

a. Click the Edit icon 4 in the row of the capability that you want to edit and

remove a defined property.

The user-defined capability is enabled for editing.

b. Select and delete the contents in the Property Name field and its corre-
sponding Property Value field.
c. Click Update.
The property is removed for the capability.

Results

You have added, viewed, edited, or deleted a property or the user-defined capability of an agent.

What to do next

You can run the tests on the agent from the Execution page. See Test run configurations on page 308.
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Management of Docker hosts

You can find information about the tasks that you can perform on remote Docker hosts. After you set up a remote
Docker host, you can register the Docker host with HCL OneTest™ Server. You must then add the registered remote

Docker host to your project before you can run tests on the remote Docker host location.

You can find the following information about managing Dockers:

« Test run considerations for running tests on remote Docker hosts on page 277

« Setting up a remote Docker host computer on page 279

« Setting up a secure remote Docker host computer on page 280

« Copying third-party application Jars to a remote Docker host on page 282

* Registering a remote Docker host on page 284

« Viewing remote Docker hosts that are registered with HCL OneTest Server on page 286
« Adding a remote Docker host to the project for running tests on page 287

« Editing configurations of a remote Docker host on page 288

* Removing a remote Docker host from a project on page 291

 Unregistering a remote Docker host from HCL OneTest Server on page 292

Test run considerations for running tests on remote Docker hosts

Before you can configure a test to run on a remote Docker host, you must read the considerations that you must take

into account.

You can run all the tests that are supported on HCL OneTest™ Server on remote Docker hosts.

! Important: You can run virtual services only in the Default Cluster location of HCL OneTest™ Server. You

cannot run virtual services on a remote Docker host.

When you plan to run any of the tests on a remote Docker host from a project on HCL OneTest™ Server, you must

complete the following tasks:

Tasks More information...

1.1 Set up non-secure remote Docker hosts. Setting up a remote Docker host computer on
page 279

1.2 Set up secure remote Docker hosts. Setting up a secure remote Docker host computer
on page 280

2 Register the remote Docker host on HCL OneTest™ Registering a remote Docker host on page 284

Server.

3 View the registered Docker hosts. Viewing remote Docker hosts that are registered

with HCL OneTest Server on page 286
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Tasks More information...

4 Add a remote Docker host to the HCL OneTest™ Serv- | Adding a remote Docker host to the project for run-

er project. ning tests on page 287
5 Configure a run for your test that you want to run on

the remote Docker host by performing the following 1. Test run configurations on page 308

actions: 2. Prerequisites to running tests on

page 257
1. Go to Test run configurations on page 308. 3. Test run configurations on page 308

2. Check for the prerequisite tasks that you must
perform before you configure a test run for the
test.

3. Select the task for the test that you want to
configure for a run, and then follow the steps

to run the test.

If you plan to run API Suites that use a transport and the transport requires third-party application Jar files for a

successful run on a remote Docker host, then you must perform the following task:

« You must copy the third-party application Jar files to the third-party application folder on the computer where
the remote Docker host is installed. See Copying third-party application Jars to a remote Docker host on

page 282.

After you set up and register the remote Docker host with HCL OneTest™ Server, you can add the remote Docker
hosts to your project on HCL OneTest™ Server. See Adding a remote Docker host to the project for running tests on

page 287.

You can find information about the tasks that you can perform when you use remote Docker hosts that are set up and

registered with HCL OneTest™ Server.

« When you configure a test run and in the step in which you select the remote Docker, if you encounter any of
the following conditions because these were changed on the remote Docker host:
> The host name or port of the remote Docker is not displayed correctly.

> You want to change the mode of authentication with the remote Docker host.

You must edit the configuration settings for the remote Docker host. See Editing configurations of a remote

Docker host on page 288.

» When you want to delete a remote Docker host from your HCL OneTest™ Server project, see Removing a
remote Docker host from a project on page 291.

» When you want to remove or unregister a remote Docker host from HCL OneTest™ Server, see Unregistering a
remote Docker host from HCL OneTest Server on page 292.
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Related information

Tests configurations and test runs

Management of Docker hosts on page 277

Setting up a remote Docker host computer

You must set up a computer to host the remote Docker host. You can set up the remote host with a non-secure mode
of connection with HCL OneTest™ Server.

Before you begin

You must have identified a remote computer or VM that has a minimum of 16 GB RAM. You must have installed

Ubuntu V18.04 or later, on the remote computer.

You must have installed Docker Enterprise Edition for a non-secure mode of connection with HCL OneTest™ Server on

the remote Docker host computer. Refer to Get Docker Engine.

You must have the entitlement key that is required for you to connect to the Harbor repository to be able to pull in the

software image to the remote Docker host.
About this task

You must set up a remote computer or a Virtual Machine (VM) on which you want to set up the remote Docker host.
You must be a system administrator or get the remote Docker host set up by a system administrator. You must

ensure that the system administrator completes the following actions:

« Enables SSH.
« Creates user credentials for you with root permissions.
- Provides the name of the Docker container.

« Provides the IP address of the remote Docker host computer.

1. As a system administrator of the remote system, specify a port to access the Docker daemon in the
docker . servi ce file located in the directory / | i b/ syst end/ syst em You must add the configured port at

the line in the file:
ExecStart=/usr/bin/dockerd -H fd:// -H tcp://0.0.0.0: PORT
For example, if the port configured is 4342, then the line must read as:

ExecStart=/usr/bin/dockerd -H fd:// -H tcp://0.0.0.0: 4342

2. Restart the Docker service by using the following commands:
$ sudo systemctl daemon-reload

$ sudo systemctl restart docker
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3. Perform the following steps as a user with root permissions or ask the system administrator to complete the

following steps:

a. Open a terminal and connect to the remote Docker host by using an SSH tool by running the following

command:
ssh root@<IP_address_of_remote_host>
b. Log in to HCL Software’'s Harbor container registry by running the following command:

sudo docker login hclcr.io -u <username> -p <password>

Note: You must provide the following username and password in the command to log in to the
registry:
= Username as email address registered with HCL

= Password as Harbor CLI secret

c. Run the following commands to pull the product images from the registry on to the remote Docker
host computer:

Note: You must pull in the images with the version which is the same as the version of HCL
OneTest™ Server that you use to run the tests.

= sudo docker pull cp.hclcr.io/ot/hcl-onetest/studio<image_identifier>
= sudo docker pull hcler.io/ot/hcl-onetest/virtualization<image_identifier>

Results
You have set up the remote Docker host computer that can be accessed in a non-secure mode.
What to do next

You can set up a secure remote Docker host computer optionally, that enables a secure connection with HCL

OneTest™ Server. See Setting up a secure remote Docker host computer on page 280.

You can register the remote Docker host on HCL OneTest™ Server. See Registering a remote Docker host on

page 284.

Setting up a secure remote Docker host computer

You must set up a computer to host the remote Docker host. You can set up the remote host with a secure mode of
connection with HCL OneTest™ Server by using certificates issued by the remote host computer that authenticate the

connection.

Before you begin
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You must have identified a remote computer or VM that has a minimum of 16 GB RAM. You must have installed

Ubuntu V18.04 or later, on the remote computer.
You must have installed Docker Community Edition V18.09 or later. For instructions, refer to Get Docker Engine.
Note: For the remote Docker host to be reached in a safe manner through the network, you can enable TLS

by specifying the tlsverify flag and by pointing the tlscacert flag of the remote Docker host to a trusted CA

certificate. Refer to Protect the Docker daemon socket.
You must have the entitlement key that is required for you to connect to the Harbor repository to be able to pull in the
software image to the remote Docker host.
About this task

You must set up a remote computer or a Virtual Machine (VM) on which you want to set up the remote Docker host.
You must be a system administrator or get the remote Docker host set up by a system administrator. You must

ensure that the system administrator completes the following actions:

* Enables SSH.
« Creates user credentials for you with root permissions.
« Provides the name of the Docker container.

« Provides the IP address of the remote Docker host computer.

Perform the following steps as a user with root permissions or ask the system administrator to complete the
following steps:

a. Open a terminal and connect to the remote Docker host by using an SSH tool by running the following

command:
ssh root@<IP_address_of_remote_host>
b. Log in to HCL Software’s Harbor container registry by running the following command:

sudo docker login hclcr.io -u <username> -p <password>
Note: You must provide the following username and password in the command to log in to the
registry:

> Username as email address registered with HCL

o Password as Harbor CLI secret

c. Run the following commands to pull the product images from the registry on to the remote Docker host
computer:
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Note: You must pull in the images with the version which is the same as the version of HCL OneTest™

Server that you use to run the tests.

> sudo docker pull cp.hclcr.io/ot/hcl-onetest/studio<image_identifier>

> sudo docker pull hclcr.io/ot/hcl-onetest/virtualization<image_identifier>

Results
You have set up the remote Docker host computer that can be accessed in a secure mode.
What to do next

You can optionally, set up a non-secure remote Docker host. See Setting up a remote Docker host computer on

page 279.

You can register the remote Docker host on HCL OneTest™ Server. See Registering a remote Docker host on
page 284.

Copying third-party application Jars to a remote Docker host

You can run API Suites in a project on HCL OneTest™ Server on a remote Docker host. If the API Suites use a transport
and the transport requires third-party Jar files for a successful run, you must ensure that the third-party application
Jar files are available at the test run time. To achieve this, you must copy the third-party application Jar files to the

computer where you have set up the remote Docker host.
Before you begin

If you want to copy the third-party application Jar files to the to the computer where HCL OneTest™ Server is installed

on Kubernetes, see Copying third-party application Jars to Kubernetes on page 94.
You must have server administrator privileges.

You must have completed the following tasks:

« Set up and configured the remote Docker host. See Management of Docker hosts on page 277.

- Identified the third-party application Jar files that are required and copied the Jar files. See Test run
considerations for API Suites or API tests on page 259.

« Copied the Jar files of the third-party application jars to the directory or folder on the remote Docker host

from where you can run the docker commands.

About this task

You can copy the required third-party application Jar files to the folder that is specific for the application under the /

nyFi | es/ Userl i bs/ <appl i cati on_nane> folder. You need not extract the files.
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You can perform this task any time after you have configured the remote Docker host and you plan to run an API Suite
on the remote Docker host. The API Suite uses transports and the transports require third-party application JAR files
to be available at the test run time.

You can get help on the docker commands by running the command: $ docker help from the docker command line.
For more information about the docker commands, refer to the Docker command line documentation.

1. Use the following table to find the name of the folder that corresponds to the specific third-party application

for the transport used in the API Suite.

Note: You must provide the name of the folder listed for the third-party application as the

<appl i cati on_nane> in the docker command.

Table 4. Name of the folder for the application

Application Name of the folder to use
Camel Camel
CentraSite CentraSite
CICcs CICcs
Coherence Coherence
Database JDBC
IMS IMS
Integra Integra
JMS JMS
SAP RFC SAP
Software AG Universal Messaging SoftwareAGUM
TIBCO EMS TIBCO
TIBCO Rendezvous
TIBCO SmartSockets
WebSphere Application Server Service Integration WAS
Bus (SiBus)
WebLogic WebLogicJMX
Software AG webMethods webMethods

2. Run the following docker command to create or update the volume that contains the application Jar files:
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docker run -rm -v /<anyFolder>/UserLibs/<application_name>:/ulsrc -v userlibs/<application_name>:/uldest

alpine:latest cp -r /ulsrc/. /uldest/UserLibs/<application_name>

H ention: You must run the docker command when no other tests are running in the Docker host to

! Attention: Y t run the dock d wh ther test ing in the Docker host t
prevent concurrent access problems.

Results

You have successfully copied the third-party application Jar files to the folder in the remote Docker host.

What to do next

- You can register the remote Docker host, if you have not already done so. See Registering a remote Docker
host on page 284.
* You can configure the API Suite run. See Configuring an API Suite or an API test run on page 323.

Registering a remote Docker host

You must register the remote Docker host with HCL OneTest™ Server before you add the remote Docker host to your
project in a team space, which contains the test assets that you want to run on the remote Docker host.

Before you begin

Depending on the mode of connection with HCL OneTest™ Server, you must have set up the remote Docker host
computer either for a secured mode or for an unsecured mode of connection.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Click Infrastructure > Agents and Intercepts in the navigation pane.
The Agents and Intercepts page is displayed.

You can view the agents, intercepts or Dockers that are registered with HCL OneTest™ Server.

3. Click Add new > Add new docker host.

The New docker host dialog box is displayed.

4. Enter the host name and the port of the remote Docker host in the format <host name or IP_address>:<port> in
the Remote Docker Host field.

If you do not provide the port that you configured for the remote Docker host, then the default port that is used
is as follows:

> Port 2375 for the unsecured mode

> Port 2376 for the secured mode
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5. Choose from any of the following authentication modes to establish the connection between HCL OneTest™

Server and the remote Docker host computer:

- For the secured mode, which is the default mode and the checkbox is displayed as selected.

Perform the following steps:
a. Select Secure mode, if it is not selected.
b. Click the action labels to browse and select the . pemfiles that correspond to
ca_certificate.pemclient_certificate. pemandclient_key. pem

Note: You must have generated the . pemfiles on the remote Docker host computer and

copied the files to your local drive.

o For the unsecured mode, the Secure mode checkbox must not be selected.

Perform the following step:
a. Clear the Secure mode checkboy, if selected.
6. Click Test connection to test if a connection is established between HCL OneTest™ Server and the remote

host computer.
Any of the following events occur when Test connection is clicked:

> On a successful connection, a message is displayed.
> On a failure to connect to the remote host computer, an error message is displayed. You must resolve

the error and reattempt to establish a successful connection.

! Important: The remote Docker host computer must be connected successfully before you register the

remote Docker host with HCL OneTest™ Server.

7. Click Register.

The remote Docker host that you registered is displayed.

! Important: The remote Docker host must be registered successfully with HCL OneTest™ Server in the

team space before you add the remote Docker host to your project in that team space.

8. Click Close to exit.

Results
You have registered the remote Docker host in your team space with HCL OneTest™ Server.
What to do next

You can view the Docker hosts in your team space that are registered with HCL OneTest™ Server. See Viewing remote

Docker hosts that are registered with HCL OneTest Server on page 286.
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You must add the registered remote Docker host to your project in your team space before you use the remote Docker
host as a location to run tests in your project. See Adding a remote Docker host to the project for running tests on

page 287.

Viewing remote Docker hosts that are registered with HCL OneTest™ Server

You must register the remote Docker host in your team space with HCL OneTest™ Server before you add the remote
Docker host to your project in that team space, which contains the test assets that you want to run on the remote
Docker host.

Before you begin

Depending on the mode of connection with HCL OneTest™ Server, you must have set up the remote Docker host
computer either for a secured mode or for an unsecured mode of connection. See Setting up a remote Docker host

computer on page 279 or Setting up a secure remote Docker host computer on page 280.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Click Infrastructure > Agents and Intercepts in the navigation pane.
The Agents and Intercepts page is displayed.

You can view the agents, intercepts or Dockers that are registered with HCL OneTest™ Server in your team

space.

3. You can view the Dockers that you own in any of the following ways:

- Search for the Docker by entering the name of the Docker host in the Search field.

Note: You can enter either the full name or any text that is in the name. The search is enabled

for case sensitive text that you can enter.

o Sort the Type column to sort the items and then identify the Docker by the name displayed.

- Sort the Agents column to sort the items and identify the Docker by the owner.

You can view the following details about the Dockers that are registered with HCL OneTest™ Server in the

team space:
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> The projects in the team space to which the Docker host is added, are displayed in the Projects
column.
> The status of the Docker host is displayed in the Status column.

Note: You can add Docker hosts that are in the Ready state to your project, and then use them
as locations to run tests.

Results
You have viewed the remote Docker hosts that are registered with HCL OneTest™ Server in your team space.
What to do next

You must add the registered remote Docker host to your project in your team space before you use the remote Docker
host as a location to run tests in your project. See Adding a remote Docker host to the project for running tests on

page 287.

Adding a remote Docker host to the project for running tests

You can choose to run tests on Docker hosts that you have set up on remote host computers. You must register the
Docker host with HCL OneTest™ Server and then add them to your project before you run tests on the remote Docker
hosts.

Before you begin

You must have completed the following tasks:

- Read about the considerations you must take into account before you configure a test run to run on a remote
Docker host. See Test run considerations for running tests on remote Docker hosts on page 277.

« Set up the remote Docker host system. See Setting up a remote Docker host computer on page 279 or
Setting up a secure remote Docker host computer on page 280.

« Registered the remote Docker host with HCL OneTest™ Server. See Registering a remote Docker host on
page 284.

1. Log in to HCL OneTest™ Server.
2. Open your project.
The Overview page is displayed.

3. Click Infrastructure > Agents and Intercepts.

The Agents and Intercepts page is displayed.

4. Click Add > Add docker.
5. Select the Docker host that you want to add to the project from the list of Docker hosts, and then click Add.
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Note: You can add the Docker hosts that you registered. You can add any number of Docker hosts to

your project.

The Docker hosts that you added to the project are displayed.

You can view the details of the Docker host by clicking the Expand icon .

proj1 - Agents

Ype AgEnts

i‘; i ‘.ZZ':"-'(\-.T.Z-ZRH:Z

I Server Dacker Engine - Community
Secure Mo
Version 19032
Address 10121104 38
Farl B
Operating system linu
Architecture amd&d
Apd version 140 {ménEmum version 1.12)
G version go1.12.8
Git commit Ga30dfc
Built Thursday, August 29, 2019 527 AM
Experimenta false

What to do next

You can select any of the remote Docker hosts as an alternate location to run the test asset in your project while

configuring a test run from the Execution page.

Related information

Tests configurations and test runs

Editing configurations of a remote Docker host

You can edit the host name or the port of the registered Docker host computer instead of registering it as a new
remote host if any of the parameters are changed on the remote host computer. You can also change the mode of
authentication of a registered remote Docker host.

Before you begin

You must have completed the following tasks:
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« Set up the remote Docker host computer. See Setting up a remote Docker host computer on page 279 or
Setting up a secure remote Docker host computer on page 280.
« Registered the remote Docker host with HCL OneTest™ Server in your team space. See Registering a remote

Docker host on page 284.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Click Infrastructure > Agents and Intercepts in the navigation pane.
The Agents and Intercepts page is displayed.
You can view the agents, intercepts, Dockers, or clusters that are registered with HCL OneTest™ Server in your

team space.

3. You can view the Dockers that you own in any of the following ways:

o Search for the Docker by entering the name of the Docker host in the Search field.

Note: You can enter either the full name or any text that is in the name. The search is enabled

for case sensitive text that you can enter.

> Sort the Type column to sort the items and then identify the Docker by the name displayed.

- Sort the Agents column to sort the items and identify the Docker by the owner.

You can view the following details about the Dockers that are registered with HCL OneTest™ Server in your
team space:
> The projects in the team space to which the Docker host is added, are displayed in the Projects
column.
o The status of the Docker host is displayed in the Status column.

4. ldentify the Docker host that you want to modify the configuration, and then click the Edit icon 78

Note: The 4 icon is displayed in the Actions column in the row of the Docker only if you own the

remote Docker host.

The Update docker host dialog box is displayed.

5. Change any of the configurations.

To change... Do this...
Change the host name or the port of the remote Enter the changed value of the host name or the port
Docker host. in the Remote hostname field.
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To change...

Do this...

Change the mode of authentication from a non-se-

a. Select the Secure mode option.

cure mode to a secure mode. b. Click the action labels to browse and se-
lect the . pemfiles that correspond to ca_ -
certificate.pemclient_certifi-

cate. pemandclient _key. pem

Note: You must have generated the
. pemfiles on the remote host com-
puter and copied the files to your lo-

cal drive.

Change the mode of authentication from a secure Clear the Secure mode option that is selected.

mode to a non-secure mode.

6. Click Test connection to test whether a connection is established between HCL OneTest™ Server and the

remote host computer:

> On a successful connection, a message is displayed.
> On a failure to connect to the remote host computer, an error message is displayed. You must resolve
the error and reattempt to establish a successful connection.
7. Click Update.

The remote Docker host with the updated details is displayed.

Results
You have updated the registered remote Docker host with the changed parameters.
What to do next

You can now add the updated Docker host to your project. See Adding a remote Docker host to the project for running

tests on page 287.

Related information

Setting up a remote Docker host computer on page 279
Registering a remote Docker host on page 284
Removing a remote Docker host from a project on page 291

Unregistering a remote Docker host from HCL OneTest Server on page 292
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Removing a remote Docker host from a project

You can delete a remote Docker host that you added to your project in HCL OneTest™ Server when you no longer need

it to run tests.
Before you begin

You must have completed the following tasks:

—_

. Set up the remote Docker host computer. See Setting up a remote Docker host computer on page 279 or

Setting up a secure remote Docker host computer on page 280.

N

. Registered the remote Docker host with HCL OneTest™ Server in your team space. See Registering a remote
Docker host on page 284.
3. Added the registered Docker host to a project in your team space. See Adding a remote Docker host to the

project for running tests on page 287.

—_

. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

N

. Open the project in your team space from the My Projects page.

The Overview page is displayed.

3. Click Infrastructure > Agents and Intercepts in the navigation pane.
The Agents and Intercepts page is displayed.

You can view the agents, intercepts or Dockers that are added to your project.

4. You can view the Dockers that you own in any of the following ways:

- Search for the Docker by entering the name of the Docker host in the Search field.

Note: You can enter either the full name or any text that is in the name. The search is enabled

for case sensitive text that you can enter.

o Sort the Type column to sort the items and then identify the Docker by the name displayed.
o Sort the Agents column to sort the items and identify the Docker by the owner.

You can view the following details about the Dockers that are registered with HCL OneTest™ Server:
> The projects to which the Docker host is added, are displayed in the Projects column.

> The status of the Docker host is displayed in the Status column.
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5. Identify the Docker host that you want to remove from the project, and then click the Remove docker host icon

[T,

Note: The [ icon is displayed in the Actions column in the row of the Docker only if you own the

remote Docker host.

A message is displayed that the Docker host is removed from the project successfully.

Results

You have removed the remote Docker host from your project. The remote Docker host is no longer available as a

location while configuring a test run in your project.
What to do next

You might have to add a remote Docker host to your project to use the remote Docker host as a location to run tests.

Related information

Unregistering a remote Docker host from HCL OneTest Server on page 292

Editing configurations of a remote Docker host on page 288

Unregistering a remote Docker host from HCL OneTest™ Server

You can unregister a remote Docker host that is registered with HCL OneTest™ Server in a team space when you no

longer require it.
Before you begin

You must have completed the following tasks:

1. Set up the remote Docker host computer. See Setting up a remote Docker host computer on page 279 or
Setting up a secure remote Docker host computer on page 280.

2. Registered the remote Docker host with HCL OneTest™ Server in a team space. See Registering a remote
Docker host on page 284.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Click Infrastructure > Agents and Intercepts in the navigation pane.
The Agents and Intercepts page is displayed.

You can view the agents, intercepts, Dockers, or clusters that are registered with HCL OneTest™ Server in your

team space.
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3. Identify the Docker host that you want to unregister.

Note: The '4 and [T icons are displayed in the Actions column in the row of the Docker only if you

own the remote Docker host.

4. Unregister the Docker host by completing the following steps:

a. Click the Unregister docker host icon [,
b. Click Unregister in the Unregister docker host dialog box.

A message is displayed that the Docker host is unregistered successfully.

Results

You have unregistered the remote Docker host in a team space on HCL OneTest™ Server. You cannot run tests on this
remote Docker host if it is added to your project. You might have to register it again with HCL OneTest™ Server, if you

want to use the remote Docker host in your projects.

Related information

Editing configurations of a remote Docker host on page 288
Adding a remote Docker host to the project for running tests on page 287

Removing a remote Docker host from a project on page 291

Management of remote Kubernetes clusters

You can find information about the tasks that you can perform on remote Kubernetes clusters. After you set up a
remote Kubernetes cluster, you can register the external cluster with a team space on HCL OneTest™ Server. You
must then add the remote cluster to a project before you run test assets or resources on the remote Kubernetes

cluster.

You can find the following information about managing the external Kubernetes cluster:

« Considerations for using a remote Kubernetes cluster on page 294
* Registering a remote Kubernetes cluster on page 296

« Viewing remote Kubernetes clusters on page 299

« Adding a remote Kubernetes cluster to a project on page 301

« Editing configurations of a remote Kubernetes cluster on page 303
« Removing a remote Kubernetes cluster from a project on page 305

« Unregistering a remote Kubernetes cluster from a team space on page 306
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Considerations for using a remote Kubernetes cluster

When you want to use a remote Kubernetes cluster as a location to run the supported tests or test resources, you

must read the considerations first.

Before you want to run any of the supported tests or test resources on HCL OneTest™ Server that are configured to

run on a remote Kubernetes cluster, you must have completed the following tasks:

- Verified that the Kubernetes cluster that you want to use is a supported one by referring to the OS, platform,
and containers that are specified for HCL OneTest™ Server in System Requirements on page 13.
- Kept a suitable kubeconf i g file with access to the remote Kubernetes cluster in a folder on the computer

that you want to use to access an instance of HCL OneTest™ Server.

You must be familiar with the administration of a Kubernetes cluster. When you as the cluster administrator, set up

the remote Kubernetes cluster must consider the following requirements:

« You must have a kubeconf i g file with access to the remote Kubernetes cluster in a folder on the computer
that you want to use to access an instance of HCL OneTest™ Server.

Note: If the kubeconf i g file references certificate files by using filepaths then the certificate
data must be embedded in the kubeconf i g file to make it usable by HCL OneTest™ Server. If the
kubeconf i g file contains multiple contexts, then only the current context is required.

You can use the following kubectl command to create a suitable kubeconf i g file called por t abl e- confi g
in the current folder. The por t abl e- confi g file contains embedded certificate data and the information

used by the current context:
kubectl config view --flatten --minify > portable-config

« You must ensure that the remote Kubernetes cluster is able to access the HCL OneTest™ Server image
registry which is the same registry that you used to install HCL OneTest™ Server. There is no need to copy the
HCL OneTest™ Server image to the remote Kubernetes cluster but the remote cluster must be able to access

the image registry at test runtime.

If the remote cluster that you want to use is a Lightweight Kubernetes (k3s) cluster, it might require a Secret to

pull the HCL OneTest™ Server image. You must run the following command on the remote k3s cluster:

kubectl create secret docker-registry hclcr.io \
-n {remote-namespace} \

--docker-server=hclcr.io \
--docker-username={okta-email-address} \
--docker-password={harbor-cli-secret} \
--docker-email={example@abc.com}

Notes:
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> You must replace {remote-namespace} with the value of the namespace that you have used for
4 the remote cluster.
> You must replace {okta-email-address} with the user name of the Harbor repository and
replace {harbor-cli-secret} with the secret key that you copied from the Harbor repository.
o If the user name contains any special characters, such as $, you must enclose it within single
quotation-marks.
> You can replace {example@abc.com} with the email address of the administrator, if required.

- You need not configure separate licenses for running on the remote cluster because the licenses are
consumed from the pool of available licenses that are configured for the team space on HCL OneTest™
Server. The licenses are returned to the pool when the test run is completed on the remote cluster.

You must ensure that the HCL OneTest™ Server domain is accessible from the remote cluster so that the pod

in the cluster is able to communicate with HCL OneTest™ Server.

You must ensure that the appropriate PriorityClass exists on the remote cluster if you want to control the
priority given to the remote execution pod by the scheduler. The same PriorityClass that is used by the HCL
OneTest™ Server execution pod is used by the remote execution pod. If the named PriorityClass does not

exist in the remote cluster, then no PriorityClass is specified by the remote execution pod.

You must provide the Ingress details such as Ingress type, Ingress host pattern, and Ingress secret when you
register a remote cluster with your team space on HCL OneTest™ Server. These configurations are required
when you want to run virtual services on the remote cluster and run tests from the remote cluster that use

static agents.

You can enter the code snippets for nodeSelectors and tolerations in ayam format, if you want to use
nodeSelectors and tolerations on the remote cluster. You can enter these in the fields provided in the
Advanced configuration dialog box when you register a remote cluster with your team space on HCL

OneTest™ Server.
For more information about nodeSelector, see nodeSelector and for tolerations, see Tolerations.

Restrictions: The following restrictions apply when you want to run the supported tests on a remote

Kubernetes cluster:

« Using the UserLibs that are required for running certain API Suites are not supported on the remote
cluster.

- Running of Compound Tests that contain performance tests, which require the NodePort access to
connect to static agents, are not supported on the remote cluster.

When you plan to run any of the test assets or resources on a remote Kubernetes cluster from a project on HCL

OneTest™ Server, you must complete the following tasks:

295


https://kubernetes.io/docs/concepts/scheduling-eviction/assign-pod-node/#nodeselector
https://kubernetes.io/docs/concepts/scheduling-eviction/taint-and-toleration/

HCL OneTest™ Server

Tasks

More information...

1 Register a remote Kubernetes cluster with a team

space on HCL OneTest™ Server.

Registering a remote Kubernetes cluster on

page 296

the remote Kubernetes cluster by performing the fol-

lowing actions:

1. Check for the prerequisite tasks that you must
perform before you configure a test run for the
test.

2. Select the task for the test that you want to
configure for a run, and then follow the steps
to run the test.

2 View remote Kubernetes clusters added to a team Viewing remote Kubernetes clusters on
space. page 299

3 Add a remote Kubernetes cluster to a project in a Adding a remote Kubernetes cluster to a project on
team space. page 301

4.1 Configure a run for your test that you want to run on

1. Test run configurations on page 308
2. Prerequisites to running tests on
page 257

3. Test run configurations on page 308

4.2 Configure a run of the virtual service resources that
you want to run on the remote Kubernetes cluster by
performing the following actions:

1. Check for the prerequisite tasks that you must
perform before you configure a run of the virtu-
al services.

2. Select the virtual service resources in your
project that you want to configure for a run,

and then follow the steps to run them.
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1. Prerequisites for running virtual services on
page 441
2. Configuring a run of a virtual service on

page 451

Related information

Tests configurations and test runs

Management of remote Kubernetes clusters on page 293

Registering a remote Kubernetes cluster

You must register a remote Kubernetes cluster to your team space on HCL OneTest™ Server before you add the

remote cluster to your project.

Before you begin
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You must have completed the following tasks:

- Verified that the Kubernetes cluster that you want to use is a supported one by referring to the OS, platform,
and containers that are specified for HCL OneTest™ Server in System Requirements on page 13.

« Kept a suitable kubeconf i g file with access to the remote Kubernetes cluster in a folder on the computer
that you want to use to access an instance of HCL OneTest™ Server.

- Ensured that you are assigned a role as a Member or Project Creator in the team space. See Managing
members and their roles in a team space on page 653.

« Ensured that you are assigned a role as a Project Owner or Tester in the project. See Managing access to

server projects on page 667.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Click Infrastructure > Agents and Intercepts in the navigation pane of the team space.

The Agents and Intercepts page is displayed.

3. Click Add new > Add new cluster.

The New cluster dialog box is displayed.

4. Perform the following steps to add the kubeconf i g file:
a. Click Browse, and locate the kubeconf i g file of the Kubernetes cluster that you want to add.
b. Select the kubeconfi g file, and then click Open.

The name of the kubeconf i g file that you selected is displayed along with the address of the
Kubernetes cluster that is specified in the file.

c. Click Next.

The address of the Kubernetes cluster that is configured in the kubeconf i g file is displayed in the Address
field.

Note: You can change the address of the Kubernetes cluster if it is different from the address in the
kubeconfi g file.

5. Perform the following steps to add a namespace and name for the cluster:
a. Enter the namespace of the cluster in the Namespace field.
b. Enter a name for the cluster in the Name field.
The name helps you to identify the cluster.

c. Click Next.
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6. Perform the following steps to add the ingress details of the cluster:
a. Select the ingress type of the cluster from the Ingress type list.

You can select the ingress type from the following options that are displayed:

Option Description Result
None When selected specifies that no You can run any of the supported tests
ingress type is configured for the re- on the remote cluster but not on the re-
mote Kubernetes cluster. mote agents.
NGINX When selected specifies that NGINX is | You can run any of the supported tests
configured as the ingress type for the | on the remote cluster or on any of the
remote Kubernetes cluster. remote agents.

b. Enter the ingress host pattern of the cluster in the Ingress host pattern field.

The DNS used by a computer that runs a client application (such as a static agent) or the HTTP proxy
that routes traffic to the virtual service needs to resolve such host names to the IP address of the

ingress domain.

For example, if the IP of the remote cluster is 12.12.12.123, then you must enter the ingress host
pattern as *.12.12.12.123.nip.io

The Unique ID of the virtual service is prefixed to the ingress host name when virtual services are

routed from the HCL OneTest™ Server cluster.
c. Enter the name of the secret in the remote namespace, which contains the certificate information.

You must have created the secret and named it following the naming conventions per the Kubernetes
guidelines. The certificate that you create is a wildcard certificate which contains the Ingress host
pattern of the Kubernetes cluster. This wildcard certificate ensures that the client applications can

trust the virtual services.

Note: If a secret name is not provided then the default certificate that is provided by NGINX is

used, which might cause issues to authenticate the virtual service by the client applications.

d. Click Next.

7. Optionally, perform the following steps to enter the code snippets for nodeSelectors and tolerations, if
applicable for the remote cluster:

a. Enter the code snippet for nodeSelectors in ayam format in the Node selectors field.
b. Enter the code snippet for tolerations in ayan format in the Tolerations field.

c. Select the Copy pull secret to the cluster checkbox, if it is not already selected.



Chapter 6. Test Execution Specialist Guide

Note: The remote Kubernetes cluster pulls the secret to access the HCL OneTest™ Server
image registry which is the same registry that you used to install HCL OneTest™ Server. The

remote Kubernetes cluster must be able to access the image registry at test runtime.

d. Click Register.

The remote cluster is added to the team space and is displayed with the “-+ icon in the Type column on the
Agents and Intercepts page. You can identify the cluster with its name in the Agents column.

Note: The Projects column does not display any projects that are associated with the cluster yet.

Results
You have registered a remote Kubernetes cluster with your team space on HCL OneTest™ Server.
What to do next

You must add the remote cluster to your project in your team space before you use the remote cluster as a location to

run test assets or resources in your project. See Adding a remote Kubernetes cluster to a project on page 301.

Related information

Management of remote Kubernetes clusters on page 293

Viewing remote Kubernetes clusters

You can view the clusters that you have registered with a team space on HCL OneTest™ Server to view their details or

edit their configurations.
Before you begin

You must have completed the following tasks:

» Read and completed the tasks mentioned in Considerations for using a remote Kubernetes cluster on
page 294, if you want to use a remote Kubernetes cluster as a location to run the test.

- Registered a remote Kubernetes cluster with your team space on HCL OneTest™ Server. See Registering a
remote Kubernetes cluster on page 296.

« Ensured that you are assigned a role as a Member or Project Creator in the team space. See Managing
members and their roles in a team space on page 653.

« Ensured that you are assigned a role as a Project Owner or Tester in the project. See Managing access to
server projects on page 667.
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1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Click Infrastructure > Agents and Intercepts in the navigation pane of the team space.
The Agents and Intercepts page is displayed.

You can view the agents, intercepts, Dockers, or clusters that are registered with the team space on HCL

OneTest™ Server.

3. You can view the clusters that you own in any of the following ways:

- Search for the cluster by entering the name of the cluster in the Search field.

Note: You can enter either the full name or any text that is in the name. The search is enabled

for case-sensitive text that you can enter.

> Sort the Type column to sort the items, and then identify the cluster by the name or owner.

- Sort the Agents column to sort the items, and then identify the cluster by the name or owner.

You can view the following details about the clusters that are in the team space:
> The projects in the team space to which the cluster is added are displayed in the Projects column.

> The status of the cluster is displayed in the Status column.

Note: You can add clusters that are in the rReady state to your project, and then use them as

locations to run tests.

You can view the details of the cluster by clicking the Expand icon ..

mycluster EESTR SR S O
Owned by me :

Name Value

Address https: /@08 © T @5d  nScmisahi
Namespace default

Nodes 1

Version 1.22

The following table describes the details about the cluster:

Name Description
Address Specifies the address of the remote Kubernetes API.
Namespace Specifies the namespace of the remote Kubernetes cluster in which the test runs oc-
cur.
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Name Description
Nodes Specifies the number of nodes in the remote Kubernetes cluster.
Version Specifies the Kubernetes version of the remote Kubernetes cluster.

Results
You have viewed details of the remote clusters that are registered with a team space on HCL OneTest™ Server.
What to do next

You must add the remote cluster to your project in your team space before you can use the remote cluster as a
location to run test assets or resources that are in your project. See Adding a remote Kubernetes cluster to a project

on page 301.

Related information

Management of remote Kubernetes clusters on page 293

Adding a remote Kubernetes cluster to a project

You must add a remote Kubernetes cluster to your project after you register the cluster with your team space on HCL
OneTest™ Server.

Before you begin

You must have completed the following tasks:

» Read and completed the tasks mentioned in Considerations for using a remote Kubernetes cluster on
page 294, if you want to use a remote Kubernetes cluster as a location to run the test.

* Registered a remote Kubernetes cluster with your team space on HCL OneTest™ Server. See Registering a
remote Kubernetes cluster on page 296.

- Ensured that you are assigned a role as a Member or Project Creator in the team space. See Managing
members and their roles in a team space on page 653.

 Been assigned a role as an Owner in the project.

* Created a project.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Open your project.
The Overview page is displayed.

3. Click Infrastructure > Agents and Intercepts in the navigation pane of the team space.

The Agents and Intercepts page is displayed.
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4. Click Add > Add cluster.

The Add cluster dialog box is displayed.

5. Select the cluster that you want to add to the project from the list of clusters that are registered with the team

space, and then click Add.

Note: You can add the clusters that are registered with the team space. You can add any number of

clusters to your project.

The clusters that you added to the project are displayed.

You can view the details of the cluster by clicking the Expand icon ..

mycluster EESTR SR S O
Owned by me :

Name Value

Address https: /@08 © T @5d  nScmisahi
Namespace default

Nodes 1

Version 1.22

The following table describes the details about the cluster:

Name Description
Address Specifies the address of the remote Kubernetes API.
Namespace Specifies the namespace of the remote Kubernetes cluster in which the test runs oc-
cur.
Nodes Specifies the number of nodes in the remote Kubernetes cluster.
Version Specifies the Kubernetes version of the remote Kubernetes cluster.
What to do next

You can select any of the remote clusters as an alternate location to run the test assets or resources that are in your

project while you configure a run from the Execution page.

Related information

Tests configurations and test runs

Management of remote Kubernetes clusters on page 293

302



Chapter 6. Test Execution Specialist Guide

Editing configurations of a remote Kubernetes cluster

You can edit the kubeconf i g file, address, namespace, name, or ingress details of the remote Kubernetes cluster

that you added to a team space on HCL OneTest™ Server.

Before you begin
You must have completed the following tasks:

» Read and completed the tasks mentioned in Considerations for using a remote Kubernetes cluster on
page 294, if you want to use a remote Kubernetes cluster as a location to run the test.

* Registered a remote Kubernetes cluster with your team space on HCL OneTest™ Server. See Registering a
remote Kubernetes cluster on page 296.

« Ensured that you are assigned a role as a Member or Project Creator in the team space. See Managing
members and their roles in a team space on page 653.

« Ensured that you are assigned a role as a Project Owner or Tester in the project. See Managing access to

server projects on page 667.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Click Infrastructure > Agents and Intercepts in the navigation pane of the team space.
The Agents and Intercepts page is displayed.

You can view the agents, intercepts, Dockers, or clusters that are registered with the team space on HCL

OneTest™ Server.

3. You can view the clusters that you own in any of the following ways:

- Search for the cluster by entering the name of the cluster in the Search field.

Note: You can enter either the full name or any text that is in the name. The search is enabled

for case-sensitive text that you can enter.

> Sort the Type column to sort the items, and then identify the cluster by the name or owner.
> Sort the Agents column to sort the items, and then identify the cluster by the name or owner.

You can view the following details about the clusters that are in the team space:
> The projects in the team space to which the cluster is added, are displayed in the Projects column.

> The status of the cluster is displayed in the Status column.

Note: You can add clusters that are in the rReady state to your project, and then use them as

locations to run tests.

4. Identify the cluster that you want to modify the configurations, and then click the Edit icon &,
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.Q 5,
Note: The s icon is displayed in the Actions column in the row of the cluster only if you own the

cluster.

The Update cluster dialog box is displayed.

5. Perform the following steps to change the kubeconf i g file:
a. Click Browse, and locate the kubeconf i g file of the Kubernetes cluster that you want to use.
b. Select the kubeconfi g file, and then click Open.

The name of the kubeconf i g file that you selected is displayed along with the address of the
Kubernetes cluster that is specified in the file.

c. Click Next.

6. Perform the following steps to change the namespace or name of the cluster:
a. Edit or change the namespace of the cluster that you want to use, in the Namespace field.
b. Edit or change the name of the cluster in the Name field.
c. Click Next.

7. Perform the following steps to change the ingress details of the cluster:

a. Select the ingress type of the cluster from the Ingress type list, if you want to use a different cluster.

b. Enter or change the ingress host pattern of the cluster in the Ingress host pattern field, if you did not

provide it when setting up the remote cluster or change it to match the cluster you want to use.

c. Enter the secret if you did not provide it when setting up the remote cluster.
The secret is used to authenticate the remote cluster to use the licenses from the Team space License

Server so that the inbound traffic is allowed into the ingress domain.
Note: The secret to use must be available with your HCL OneTest™ Server server administrator.

d. Click Next.

8. Optionally, perform the following steps to edit or change the code snippets for nodeSelectors and tolerations,
if applicable for the remote cluster:
a. Enter the code snippet for nodeSelectors in ayam format in the Node selectors field.
b. Enter the code snippet for tolerations in ayam format in the Tolerations field.
9. Click Update.
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The remote cluster is displayed with the updated configurations.

Note: The projects that are associated with the cluster are displayed in the Projects column and you
need not add the cluster to the same project again.
Results
You have updated an existing remote cluster with the changed configurations.
What to do next

You can select the updated cluster as an alternate location to run the test assets or resources that are in your project
while you configure a run from the Execution page.

Related information

Management of remote Kubernetes clusters on page 293

Removing a remote Kubernetes cluster from a project

You can remove a remote Kubernetes cluster from a project in a team space on HCL OneTest™ Server when you no
longer need the cluster to run tests.

Before you begin

You must have completed the following tasks:

1. Registered a remote Kubernetes cluster with your team space on HCL OneTest™ Server. See Registering a
remote Kubernetes cluster on page 296.
2. Added the Kubernetes cluster to a project in your team space. See Adding a remote Kubernetes cluster to a

project on page 301.
Note: You can remove remote Kubernetes clusters that only you added to the project.

3. Ensured that you are assigned a role as a Member or Project Creator in the team space. See Managing
members and their roles in a team space on page 653.

4. Been assigned a role as an Owner in the project.

1. Log in to HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Open the project in your team space.

The Overview page is displayed.
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3. Click Infrastructure > Agents and Intercepts in the navigation pane of your team space.
The Agents and Intercepts page is displayed.

You can view the agents, intercepts, Dockers, or clusters that are added to your project.

4. You can view the clusters that you own in any of the following ways:
> Search for the cluster by entering the name of the cluster in the Search field.

Note: You can enter either the full name or any text that is in the name. The search is enabled

for case-sensitive text that you can enter.

- Sort the Type column to sort the items, and then identify the cluster by the name or owner.
> Sort the Agents column to sort the items, and then identify the cluster by the name or owner.

5. Identify the cluster that you want to remove from the project, and then click the Remove cluster icon [,

Note: The [ icon is displayed in the Actions column in the row of the cluster only if you own the

remote cluster.

A message is displayed that the remote cluster is removed from the project successfully.

Results

You have removed the remote cluster from your project. The remote cluster is no longer available as a location when

you configure a run of the test assets or resources that are in your project.

What to do next

You might have to add a remote cluster to your project to use the remote cluster as a location to run test assets or

resources.

Related information

Management of remote Kubernetes clusters on page 293
Unregistering a remote Kubernetes cluster from a team space on page 306

Editing configurations of a remote Kubernetes cluster on page 303

Unregistering a remote Kubernetes cluster from a team space

You can unregister a remote Kubernetes cluster from a team space when you no longer require it.
Before you begin

You must have completed the following tasks:
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. Registered a remote Kubernetes cluster with your team space on HCL OneTest™ Server. See Registering a
remote Kubernetes cluster on page 296.
2. Ensured that you are assigned a role as a Member or Project Creator in the team space. See Managing
members and their roles in a team space on page 653.
3. Ensured that you are assigned a role as a Project Owner or Tester in the project. See Managing access to

server projects on page 667.

—_

. Log into HCL OneTest™ Server.

The team space that contains your project is displayed.

2. Click Infrastructure > Agents and Intercepts in the navigation pane of the team space.
The Agents and Intercepts page is displayed.

You can view the agents, intercepts, Dockers, or clusters that are registered with the team space on HCL
OneTest™ Server.

3. You can view the clusters that you own in any of the following ways:

> Search for the cluster by entering the name of the cluster in the Search field.

Note: You can enter either the full name or any text that is in the name. The search is enabled

for case-sensitive text that you can enter.

- Sort the Type column to sort the items, and then identify the cluster by the name or owner.
> Sort the Agents column to sort the items, and then identify the cluster by the name or owner.

4. ldentify the cluster that you want to remove.

Note: The 4 and [l icons are displayed in the Actions column in the row of the cluster only if you

own the remote cluster.

5. Unregister the cluster by completing the following steps:

a. Click the Unregister cluster icon [].

b. Click Unregister in the Unregister cluster dialog box.

A message is displayed that the remote cluster is unregistered successfully.

Results

You have unregistered the remote cluster from a team space on HCL OneTest™ Server. You cannot run test assets or
resources on this remote cluster if it is added to your project. You might have to add it again to your team space, if
you want to use the remote cluster in your projects.

307



HCL OneTest™ Server

Related information

Management of remote Kubernetes clusters 